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Introduction
This guide provides information necessary to implement, configure, and administer 
Siebel Territory Assignment Manager, MidMarket Edition. Chapters are organized in 
a way that allows users to move throughout the guide for various tasks. 
Introductory material, territory assignment manager concepts, and potential 
strategies for product use are explained in Chapter 1, “Assignment Concepts,” and 
Chapter 2, “Assignment Strategy.” Chapter 4, “Territory Assignment Rules,” and 
Chapter 5, “Running Territory Assignment Manager,” are important to those 
interested in applying the introductory knowledge to actual implementations of 
Territory Assignment Manager. Chapter 3, “Territory Assignment Manager 
Configuration,” and Chapter 6, “Advanced Configuration,” provide detailed 
instructions for those users who require specific configurations to Territory 
Assignment Manager functionality. Concluding this guide is an appendix 
(Appendix A, “Assignment Object Parameters”) that describes properties of 
assignment objects.

Several other server processes, not fully documented in this guide, play an integral 
role in Territory Assignment Manager functionality. The Siebel System 
Administration documentation, especially Siebel Business Process Designer 
Administration Guide, MidMarket Edition, should be used as an additional 
reference when using Territory Assignment Manager with these processes.

NOTE: All Siebel MidMarket product names include the phrase MidMarket Edition 
to distinguish this product from other Siebel eBusiness Applications. However, in 
the interest of brevity, after the first mention of a MidMarket product in this 
document, the product name is given in abbreviated form. For example, after Siebel 
Call Center, MidMarket Edition, has been mentioned once, it is referred to simply 
as Siebel Call Center. Such reference to a product using an abbreviated form should 
be understood as a specific reference to the associated Siebel MidMarket Edition 
product, and not any other Siebel Systems offering. When contacting Siebel Systems 
for technical support, sales, or other issues, note the full name of the product to 
ensure its proper identification and handling.
Version 7.5 Siebel Territory Assignment Manager Administration Guide MidMarket Edition 7



Introduction

Who Should Use This Guide
Who Should Use This Guide
As part of the System Administration documentation set, this guide provides 
information necessary to implement, configure, and administer Siebel Territory 
Assignment Manager. 

This book is useful primarily to people whose title or job description matches one 
of the following:

The user should possess skills in SQL, RDBMS, and network connectivity using 
TCP/IP. Previous experience with application and database software is helpful.

Database 
Administrators

Persons who administer the database system, including data 
loading; system monitoring, backup, and recovery; space 
allocation and sizing; and user account management.

Marketing 
Administrators

Persons responsible for setting up and maintaining a marketing 
department. Duties include designing and managing campaigns, 
product marketing information, and product distribution lists.

Sales and Service 
Administrators

Persons responsible for setting up and maintaining a sales or 
service department. Duties include designing the business 
requirements necessary for service and sales deployments.

Siebel Application 
Administrators

Persons responsible for planning, setting up, and maintaining 
Siebel applications.

Siebel Application 
Developers 

Persons who plan, implement, and configure Siebel applications, 
possibly adding new functionality.

Siebel System 
Administrators

Persons responsible for the whole system, including installing, 
maintaining, and upgrading Siebel applications. 
8 Siebel Territory Assignment Manager Administration Guide MidMarket Edition Version 7.5



Introduction

What’s New in This Release
What’s New in This Release
Table 1 provides a brief overview of the new Territory Assignment Manager features 
for version 7.5 and where to find additional information about these features. In 
addition to the features that follow, many additional performance enhancements 
were incorporated for this release.

NOTE: Your Siebel implementation may not have all the features described in this 
guide, depending on which software modules you have purchased.

Table 1. New Territory Assignment Manager Features for Version 7.5

Feature Description For More Information

Date range criteria This feature allows you to specify 
criteria so that Territory Assignment 
Manager searches for only items that 
are created within a specified period 
of time, providing another solution 
for finding the best possible match 
for a given item.

Note: You configure the Date criteria 
as you would any other criteria.

See “Assignment Criteria 
Configuration” on page 63

New AsgnSrvr task 
parameter

This feature allows you to specify a 
WHERE clause for AsgnSrvr when 
starting a server task and is now 
available for Interactive Assignment.

See “Running Interactive 
Assignment Using the 
Command-Line 
SRVRMGR Utility” on 
page 129

New assignment 
objects

■ Campaign Contact

■ Order

See Appendix A, 
“Assignment Object 
Parameters” 
Version 7.5 Siebel Territory Assignment Manager Administration Guide MidMarket Edition 9



Introduction

Revision History
Revision History
Siebel Territory Assignment Manager Administration Guide, MidMarket Edition, 
Version 7.5
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Assignment Concepts 1
Siebel Territory Assignment Manager allows sales and service organizations to 
assign the most qualified people to specific tasks. Assignment Manager 
accomplishes this function by matching candidates to predefined and user-
configurable assignment objects. To assign the most qualified candidate to each 
object, Territory Assignment Manager applies assignment rules that you define. For 
you to define assignment rules, you select:

■ Objects to which each assignment rule applies

■ Criteria for each assignment rule

■ Values for each assignment criteria

■ Candidates that are selected using the assignment rule

For example, in a sales organization, you can create an assignment rule that assigns 
positions (candidates) based on territory definitions (criteria) for an opportunity 
(object). In a service organization, you can create an assignment rule that assigns 
employees (candidates) based on product expertise (criteria) for a service request 
or product defect (object).
Version 7.5 Siebel Territory Assignment Manager Administration Guide MidMarket Edition 11



Assignment Concepts
You can also customize the way Territory Assignment Manager makes assignments 
by:

■ Defining how attributes are matched by using:

■ Inclusion and exclusion methods

■ Wildcard values

■ Creating and configuring your own components, including:

■ Objects

■ Assignment criteria

■ Criteria values

■ Assignment attributes

■ Running Territory Assignment Manager in different operation modes to process 
assignments:

■ Interactively in real time

■ Dynamically when database changes are made by connected or mobile users

■ Periodically assigning objects in batches

This chapter explains how Territory Assignment Manager works and how it can be 
configured to meet your organization’s needs.
12 Siebel Territory Assignment Manager Administration Guide MidMarket Edition Version 7.5



Assignment Concepts

Territory Assignment Manager Components
Territory Assignment Manager Components
This section defines the components used by Territory Assignment Manager. The 
components are:

■ “Assignment Objects”

■ “Candidates” on page 14

■ “Assignment Rules” on page 17

■ “Assignment Criteria” on page 18

■ “Activity-Based Assignment” on page 19

■ “Multitiered Assignment” on page 20

Assignment Objects
In Siebel Territory Assignment Manager, objects represent assignment entities to 
which candidates are matched based on assignment rules. A number of predefined 
assignment objects are available for use by Territory Assignment Manager for the 
most commonly used business entities in Siebel eBusiness Applications MidMarket 
Edition. The predefined assignment objects are:

■ Account

■ Activity

■ Campaign

■ Campaign Contact

■ Contact

■ Opportunity

■ Order (Sales Credit Assignment)

■ Product Defect

■ Project
Version 7.5 Siebel Territory Assignment Manager Administration Guide MidMarket Edition 13



Assignment Concepts

Territory Assignment Manager Components
■ Project Team

■ Service Request

If your deployment requires other objects, or if you need to modify predefined 
objects, you can create new objects and configure existing objects using Siebel 
Tools. For more information, see “Assignment Object Configuration” on page 50.

Candidates
In Siebel Territory Assignment Manager, candidates represent the people who are 
evaluated as potential assignees for objects. Depending on the assignment rule you 
use, and the object to which a candidate is assigned, candidates can be positions, 
employees, or organizations, and can be assigned as individuals or as members of 
a team. For information about the predefined assignment objects and recommended 
candidate assignments, see Table 2 on page 16.

Positions
Positions represent candidates distinguished by their job functions, and are 
typically used as candidates in sales organizations. For example, a sales 
organization would want to assign positions to objects, because these positions are 
responsible for a region or territory.

By assigning objects to positions, you can have one sales representative inherit the 
opportunities, accounts, and contacts from another representative by reassigning 
the employee responsible for a specific position.

Employees
Employees represent candidates distinguished by their skills and product expertise, 
and are typically used as candidates in service organizations. For example, a service 
organization would want to assign employees with the proper skills and expertise 
to objects, because these employees possess specific skills that are related to the 
service request or activity.
14 Siebel Territory Assignment Manager Administration Guide MidMarket Edition Version 7.5



Assignment Concepts

Territory Assignment Manager Components
Organizations
An organization represents a group of positions that has limited visibility to 
particular application data. For example, your company can create separate and 
distinct organizations to distribute specific information to organizational groups 
both inside and outside of your enterprise. Both internal and external users are 
granted access only to the information that they should see (such as accounts, 
opportunities, and contacts) and data they need to see (such as price lists, products, 
and literature).

By assigning objects to organizations, you can maintain better security and promote 
proper business practices by controlling data access and visibility between different 
organizations. For example, you can limit your distributors’ data access by giving 
them visibility to product information, but restrict their visibility to price lists for 
the products. To do this, you can create a separate organization for your distributors 
that does not have access to the price list data. In this case, the price lists are not 
available to your distributors even if they are assigned to the products.

Some objects allow the assignment of a single organization, whereas other objects 
allow the assignment of multiple organizations to the same object. For more 
information, see Table 2 on page 16.

For more information on organizations, see Applications Administration Guide, 
MidMarket Edition.

Teams
A team represents a group of employees or positions. Assigning a team allows you 
to assign a group of individuals that possess various skills or job functions to a 
particular object.

In sales organizations, teams are typically assigned to objects. For example, you can 
assign a sales representative and a sales consultant to an opportunity. Or you can 
can assign a team of sales professionals—two district representatives, a regional 
manager, and a sales engineer—to work a single, large sales opportunity.
Version 7.5 Siebel Territory Assignment Manager Administration Guide MidMarket Edition 15



Assignment Concepts

Territory Assignment Manager Components
Individuals
An individual represents a single employee or a position. Assigning individuals 
allows you to assign exclusive ownership to an individual who possesses a specific 
skill or expertise for a particular object.

In service organizations, individuals are typically assigned to objects. For example, 
you can assign a customer service representative with expertise in disk drives to all 
service requests that are marked for this area.

Table 2 shows which candidates can be assigned to each of the predefined 
assignment objects. This table also shows which assignment objects are restricted 
to a single assignee, and assignment objects that are capable of incorporating a team 
of assignees. S indicates the ability to allow only a single owner or assignment; M 
indicates the ability to allow multiple owners or team assignments.

If you need to modify the default properties—for example, if you want to assign 
Accounts to Employees—you can do so by configuring the assignment object 
properties using Siebel Tools. For more details, see “Assignment Object 
Configuration” on page 50.

Table 2. Summary of Predefined Assignment Objects

Candidate

Assignment Object Position Employee Organization

Account M M

Activity S

Campaign M

Campaign Contact S S

Contact M S

Opportunity M M

Product Defect S

Project M

Project Team M

Service Request S S
16 Siebel Territory Assignment Manager Administration Guide MidMarket Edition Version 7.5
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Territory Assignment Manager Components
Primaries
A primary on an assignment rule represents the candidate (employee, position, or 
organization) that is assigned as the primary owner of the assignment object if the 
candidate passes the criteria for that object. The primary is the main or first owner 
of an assignment object. For assignments that allow only single assignees, the single 
assignee becomes the primary assignee as well.

Assignment Rules
Siebel Territory Assignment Manager uses assignment rules to match assignment 
objects to candidates. Multiple assignment rules can be active for each assignment 
object. An assignment rule can also apply to multiple objects because the 
assignment object field supports multiple selections.

Territory Assignment Manager supports only one type of assignment rule—All, 
Above Minimum. This rule assigns all objects that meet the specified criteria. 
Figure 1 shows an example of an assignment rule.

For information about creating, defining, and configuring assignment rules, see 
Chapter 4, “Territory Assignment Rules.”

Figure 1. Sample Assignment Rule
Version 7.5 Siebel Territory Assignment Manager Administration Guide MidMarket Edition 17
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Territory Assignment Manager Components
Assignment Criteria
Assignment rules use criteria to determine which candidates qualify as potential 
assignees. Criteria also determine which assignment rule should be evaluated in 
assigning an object. An assignment rule can include none, one, or many criteria. 
Criteria are sets of conditions describing the attributes of objects or candidates, or 
both, that are evaluated to determine optimal assignment. 

Each criteria uses a Compare to Object comparison method to determine if 
candidates meet the criteria. This comparison method compares criteria values to 
object attributes. Objects with the required criteria values qualify for this criteria.

NOTE: Assignment rules can be created with no criteria. A rule of this nature 
functions to make sure all data items of a particular object type are assigned, that 
is, all objects of the defined type pass. Use these rules carefully as a rule defined 
with no criteria can make assignments that are not required. Assignment rules with 
no criteria and no assignment object specified are ignored by Assignment Manager.
You should be especially careful creating rules with no criteria using Batch 
Assignment. This mode can produce a very large number of assignments, because 
all objects in the database that have rules with no criteria pass and are assigned in 
this mode. This can result in a backlog of requests that may cause the whole 
environment to stop working if the database or file system runs out of space. 
Therefore, assignment rules with no criteria should be used sparingly with Batch 
Assignment.

Criteria also use an inclusion method to define how candidates are selected.

Table 3 shows the types of inclusion methods for assignment criteria.

Table 3. Assignment Criteria Inclusion Methods

Inclusion Method Comments

Include The object attribute must match at least one listed criteria value.

Include All The object attribute must match all listed criteria values.

Include All Matching Not used in the Siebel MidMarket product.

Exclude The object attribute must not match any of the listed criteria 
values.
18 Siebel Territory Assignment Manager Administration Guide MidMarket Edition Version 7.5
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Siebel Territory Assignment Manager provides predefined criteria that are related to 
sales and service organizations. If your organization requires other criteria, you can 
create new criteria using Siebel Tools. For more details, see “Assignment Criteria 
Configuration” on page 63.

Assignment criteria can be enabled for multilingual list of values (MLOV) 
capabilities. MLOV allows assignment criteria to be stored in a form that can be 
retrieved and displayed in a variety of supported client languages. For more details 
on this feature, see Siebel Tools Reference, MidMarket Edition. For configuration 
details, see “Configuring MLOV for Assignment Attributes” on page 70.

Criteria Values
Criteria values are details associated with criteria that are compared to an object or 
candidate. Criteria values can be defined as constants or can use wildcard 
characters to include a wider selection of potential matches between assignment 
rule and object. For more information, see “Creating Criteria Values” on page 106.

Activity-Based Assignment
Territory Assignment Manager can assign emails as email activities created during 
inbound and outbound email processing. Communications Server 
(Communications Inbound Manager server component) works in conjunction with 
Siebel eMail Response and Siebel Workflow to create activities for inbound emails. 
Communications Server (Communications Outbound Manager server component) 
creates activities for outbound emails. For more information, see Siebel eMail 
Response Administration Guide, MidMarket Edition (Workflow section) and Siebel 
Communications Server Administration Guide, MidMarket Edition.

NOTE: Setting up assignment rules to assign email activities requires customization 
in Siebel Tools for Applets, Workflow Policy Object Column, and Assignment 
Attribute. For related implementation information, see Siebel Business Process 
Designer Administration Guide, MidMarket Edition, Siebel Communications Server 
Administration Guide, MidMarket Edition, and Siebel Tools Reference, MidMarket 
Edition. 
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Multitiered Assignment
By default, Territory Assignment Manager independently matches people and 
organizations to assignment objects. Activating Territory Assignment Manager to 
use multitiered assignment, however, allows assignments based on the relationship 
between a person and their organization or an organization and its people. Without 
multitiered assignment—or appropriate assignment rules—it is possible for 
Territory Assignment Manager to assign an unrelated organization or person to an 
assignment object. Multitiered assignment has the following modes of assignment 
operation: 

■ Independent—Assigns people and organizations that qualify, regardless of 
whether they are related or not.

■ Person-Oriented—Assigns people that qualify, then assigns only qualified 
organizations that the assigned people belong to. 

■ Organization-Oriented—Assigns organizations that qualify, then assigns 
qualified people from those organizations. 

■ Organization and Person-Oriented—Identifies all qualified people and 
organizations, then assigns only those that have both a qualified person and 
related qualified organization.

This logical assignment feature is well-suited to Sales organizations. Assignment 
objects must be configured to activate multitiered assignment. For more 
information, see “Configuring Assignment Objects for Multitiered Assignment” on 
page 61. For more information and examples of multitiered assignment, see, “Using 
Multitiered Assignment with Sales Assignment Rules” on page 35.
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Assignment Operation Modes
This section explains the assignment modes available for running Territory 
Assignment Manager:

■ Interactive

■ Dynamic

■ Batch

■ Mobile

■ Contact Denormalization (available for Dynamic and Batch Assignments only)

■ Product Denormalization (available for Dynamic and Batch Assignments only)

Interactive Assignment
Running Territory Assignment Manager in interactive mode allows users to make 
real-time assignments.

NOTE: Mobile users running Territory Assignment Manager in interactive mode do 
not make real-time assignments, because interactive assignments made by mobile 
users are not applied to the server until they resynchronize.

By clicking the Menu button on any selected object and choosing Assign, Interactive 
Assignment allows you to view the list of assignees generated by Territory 
Assignment Manager. You can then override the assignment and select another 
assignee from the list in real time.
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Dynamic Assignment
Dynamic Assignment allows users to create assignments as other users and server 
programs change assignment object attributes. For example, if a user changes the 
revenue amount or address of an Opportunity, Dynamic Assignment detects the 
change and automatically invokes Territory Assignment Manager to reassign the 
Opportunity to a different territory or sales team as necessary.

The dynamic assignment process is as follows: a user makes a change that requires 
assignment; a database trigger fires (triggers are setup by the Generate Triggers 
server component); the Workflow Monitor Agent recognizes this trigger and assigns 
the object (internally invoking Territory Assignment Manager). By default, the 
Server Request Broker and the Assignment Manager server components are not 
explicitly used in Dynamic Assignment. 

Workflow Monitor
To run Dynamic Assignment, a Workflow Monitor Agent must be active. A 
Workflow Monitor Agent detects when a user changes data related to objects. For 
more information about Workflow Monitor Agent, see Siebel Business Process 
Designer Administration Guide, MidMarket Edition.

Generate Triggers
The Generate Triggers server component generates the database triggers used by 
Workflow Manager to detect changes. Generate Triggers reads the Workflow Policy 
Object and Assignment Object definitions in the Siebel repository and generates the 
appropriate database triggers to monitor changes.
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Batch Assignment
You can use Batch Assignment to assign multiple records of an object in a single 
batch. For example, after changing assignment rule definitions, you can use Batch 
Assignment to reassign objects using the new assignment rules. Batch Assignment 
is optimized to process a large number of items efficiently. You should monitor the 
performance of Batch Assignment and increase or decrease the number of running 
tasks to obtain the optimal performance.

You can set up Batch Assignment to run Territory Assignment Manager in Contact 
Denormalization mode. For more information on Contact Denormalization, see 
“Contact Denormalization” on page 23.

Mobile Assignment
Mobile Assignment allows mobile users to make interactive and dynamic 
assignments. Changes to the mobile client’s database are queued and are applied to 
the server the next time the client synchronizes.

Territory Assignment Manager automatically performs interactive assignments 
made by the mobile user after synchronization. Changes to assignment rules and 
objects are updated, and affected objects are reassigned dynamically.

NOTE: Mobile users running Territory Assignment Manager in interactive mode do 
not make real-time assignments, because interactive assignments made by mobile 
users are not applied to the server until they resynchronize.

Contact Denormalization
In Contact Denormalization mode, Territory Assignment Manager denormalizes 
positions from the Accounts and Opportunities team tables by copying these 
positions to the associated contacts in the Contact team table, even if the assignees 
are not assigned to the contacts:

■ Positions from the Accounts team table are copied to the Account Contact access 
list.

■ Positions from the Opportunity team table are copied to the Opportunity Contact 
access list.
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If you want the Contact access list to reflect the positions in both the Account and 
Opportunity team tables, you must associate the contact with an account and then 
associate the contact with an opportunity. If a team member is removed from the 
Account or Opportunity’s team table, then the position on the associated Contact’s 
access list can also be removed by Contact Denormalization (dependent on the 
properties of the Contact Denormalization assignment object. For more 
information, see “Contact Denormalization Object Parameters” on page 208.) 
Similarly, if the Account Team has manually assigned team members and you want 
the same team members on both the access list and Account team, you must run 
Contact Denormalization after the account assignment. This process can be run in 
dynamic and batch assignment modes. 

NOTE: Positions marked Indirect by Contact Denormalization in Contact Access list 
are not dropped by contact assignment, that is, contact assignment does not drop 
the positions that were added by Contact Denormalization. 

Contact Denormalization checks the Lock Assignment column on assignment 
objects before denormalizing. If this flag is checked, Contact Denormalization does 
not denormalize the contact record. 

NOTE: Both Account and Contact and Contact and Opportunity have a many-to-
many relationship. The Account and Contact many-to-many relationship is a new 
feature as of the version 7.0 release.

Territory Assignment Manager also assigns a primary position to the contact when 
running in Contact Denormalization mode using the following methodology:

1 If the Set Primary Position flag is checked and a primary position is not currently 
selected, then Territory Assignment Manager sets the creator’s primary position 
as the new primary position.

2 If a primary position is not selected for the creator, then Territory Assignment 
Manager sets the default position as the new primary position.

3 If a default position is not defined, then Territory Assignment Manager does not 
set a primary position.
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However, Contact Denormalization does not remove positions marked as the 
Primary, even if the positions no longer exist on an associated account or 
opportunity (with the Denorm Flag set).

The Contact Denormalization object is reserved to run Territory Assignment 
Manager in Contact Denormalization mode. Territory Assignment Manager does not 
evaluate the Contact object against any assignment rules in Contact 
Denormalization mode, and therefore does not assign candidates to objects. For this 
reason, do not create assignment rules for the Contact Denormalization object. By 
default, Territory Assignment Manager runs Dynamic Assignment in Contact 
Denormalization mode. You can also configure Territory Assignment Manager to 
run Batch Assignment in this mode.

Product Denormalization
In Product Denormalization mode, Territory Assignment Manager denormalizes 
organizations from the Price List table into the Product table by copying these 
organizations to the products associated with the price lists.

NOTE: Product to Price List is a many-to-many relationship.

Territory Assignment Manager also assigns a primary organization to the product 
when running in denormalization mode using the following methodology:

1 If the Set Primary Organization flag is checked and a primary organization is not 
currently selected, then Territory Assignment Manager sets the creator’s primary 
organization as the new primary organization.

2 If a primary organization is not selected for the creator, then Territory 
Assignment Manager sets the default organization as the new primary 
organization.

3 If a default organization is not defined, then Territory Assignment Manager does 
not set a primary organization.

The Product Denormalization object is reserved to run Territory Assignment 
Manager in Product Denormalization mode. Territory Assignment Manager does not 
evaluate the Product object against any assignment rules in Product 
Denormalization mode, and therefore does not assign organizations to objects. For 
this reason, do not create assignment rules for the Product Denormalization object. 
You can also configure Territory Assignment Manager to run Batch Assignment in 
this mode.
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To use Territory Assignment Manager for your organization, you must develop and 
document a clear set of strategies that can be consistently applied by Territory 
Assignment Manager or system administrators.

For each assignment object, you should consider how to develop assignment rules 
that:

■ Optimally match the attributes of assignment objects to criteria values of the 
assignment rules. This is commonly used for traditional territory assignment 
where territories are managed exclusively through assignment administration. 
Employees, positions, or organizations associated with these rules are potential 
assignees. Sales organizations typically use this method.

■ Optimally match the attributes of assignment objects to employees. Expertise is 
managed using employees, positions, or organizations. Service organizations 
typically use this method.

■ Reflect a blend of the attributes outlined in the two methods described above.

This chapter discusses common strategies that you can use to develop effective 
assignment rules in sales and service organizations. 
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Assignment in Sales Organizations
Sales organizations typically need to distribute opportunities and accounts to the 
proper people within the organization. Assignment of sales opportunities must take 
place quickly so that sales representatives can respond to potential revenue-
generating opportunities. Information must also be readily available to salespeople 
to close the maximum number of sales possible.

Assignments in sales organizations are commonly made to positions responsible for 
a territory. Mobile salespeople who are not connected to a network can share 
information and work as a collaborative sales force on sales opportunities. Sales 
organizations can therefore use the talents of their salespeople within their entire 
organization.

Siebel Territory Assignment Manager allows you to create territories for positions 
using a wide variety of criteria. By assigning objects to positions, you can have one 
sales representative inherit the opportunities, accounts, and contacts from another 
sales representative by reassigning the employee responsible for a specific position.

After you have created the territories, a major territory realignment can negatively 
affect your system resources. If the realignment is large, Territory Assignment 
Manager may create a volume of transactions for mobile clients, which increases 
synchronization time drastically. To avoid this, you can run Database Extract again 
and have the mobile clients initialize their databases. Because the time required to 
run Database Extract for multiple clients may be significant, try to coordinate 
territory realignments with Database Extracts to occur during a time of low system 
utilization.

To use Territory Assignment Manager for your sales organization, use the following 
views in the Assignment Administration screen:

■ Territory Assignment List view

■ Territory Assignment Detail view

NOTE: Do not use the Marketing Administration screen to create new territories.
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Because sales organizations typically distribute their accounts and opportunities 
based on territories, these views create assignment rules based on territories. For 
this reason, the terms assignment rules and territories are used interchangeably in 
this section.

The Territory List view has been simplified to allow users to define their sales 
territories. To illustrate how Territory Assignment Manager can be used in a sales 
organization, this section uses two related examples to show how you can 
strategically distribute salespeople by using assignment rules based on territories. 

Creating Sales Assignment Rules Based on Territories
This section uses an example to demonstrate how a sales organization can 
strategically assign salespeople based on territories. This example assumes that 
your sales organization wants to create four territories based on geographic 
location. In this case, you may want to create four assignment rules: US NW, US NE, 
US SE, and US SW, as shown in Figure 2. Territory Assignment Manager then 
assigns your salespeople depending on the geographic location of the sales 
opportunity.

Figure 2. Example of Creating Sales Territories
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To develop assignment rules based on territories

1 Create assignment rules as sales territories.

In this example, in the Territory List view, you create four assignment rules, one 
for each territory as shown in Figure 2.

2 Determine the assignment criteria.

In this example, in the Criteria list in the Territory Details view, you define 
Account State as the criteria for each assignment rule, because the assignment 
rules are based on territories.

3 Define the criteria values.

In this example, in the Values list in the Territory Detail view, you use the states 
that make up each territory as criteria values.

The following figure shows an example of defining a sales territory using 
assignment criteria and values as described in Step 2 and Step 3.
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4 Add the Positions.

In the Positions list in the Territory Details view, add the sales positions 
responsible for each territory. In this example, you add Division Manager - West 
and Field Sales Representative to the US NW assignment rule.

NOTE: To specify a primary position, you must set the primary at the rule level 
(in the Primary Position field in the Assignment Rule view) and also assign a 
specific position within that rule (Assignment Rules > Positions). For more 
information on the primary position, see “Creating Territory Assignment Rules” 
on page 100. For more information about assigning positions, see “Assigning 
Positions” on page 110.

5 Release the assignment rules.

In the Territory List view, click the Release button. You can then run Batch 
Assignment to assign objects affected by the assignment rules. For more 
information about running Batch Assignment, see “Running Territory 
Assignment Manager in Batch Mode” on page 146.

After these assignment rules are released, Territory Assignment Manager assigns 
salespeople based on the geographic location of the sales opportunity. For example, 
a sales opportunity in Washington is assigned to a Western Field Sales 
Representative. 

NOTE: After an Account or Opportunity has been assigned to a Sales Team, the list 
of Territory definitions used by Territory Assignment Manager for this item is added 
to the item record in the Territories field. This list is not modifiable in the standard 
user Account or Opportunity detail views. If manual changes are made to the Sales 
Team over time and the Territory list needs to be updated to match the changes, 
then use the Accounts view under the Data Administration screen to make the 
updates.
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Creating Sales Assignment Rules That Combine Criteria
The example in this section assumes that your sales organization now wants to 
further distribute its salespeople in the same geographic location based on revenue 
potential. In this case, you can create territories that use the same geographic 
location but different revenue potentials. In this example, you may want to create 
two assignment rules: US SW High Revenue and US SW Low Revenue as shown in 
Figure 3. Territory Assignment Manager then assigns your salespeople, depending 
on both the geographic location and the revenue potential of the sales opportunity.

To develop assignment rules that combine criteria

1 Create assignment rules.

In this example, create two assignment rules, one for each territory, as shown in 
Figure 3.

2 Determine the assignment criteria.

In this example, select Account State and Revenue as the criteria.

Figure 3. Example of Creating Sales Territories with Combined Criteria
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3 Define the criteria values.

In this example, use the states that make up each territory as the Account States 
criteria values. For the Revenue criteria values, select different assignment 
attributes for each assignment rule:

■ For the US SW High Revenue Assignment Rule, type 100,001 in the Revenue 
Low assignment attribute.

■ For the US SW Low Revenue Assignment Rule, type 100,000 in the Revenue 
High assignment attribute.

NOTE: The columns that appear in the Values list applet change dynamically 
depending on the criteria selected in the Criteria list applet.

The following figure shows an example of defining the US SW High Revenue 
assignment rule as described.
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4 Add the positions for this assignment rule.

In this example, you add a different sales position for each assignment rule:

■ For the US SW High Revenue assignment rule, add Division Manager - West.

■ For the US SW Low Revenue assignment rule, add Field Sales Representative.

The figure shown in Step 3 on page 33 shows an example of defining the US SW 
High Revenue assignment rule as described.

5 Release the assignment rules. 

In the Territory List view, click the Release button. You may then run Batch 
Assignment to assign objects affected by the assignment rules. For more 
information about running Batch Assignment, see “Running Territory 
Assignment Manager in Batch Mode” on page 146.

After these assignment rules are released, Territory Assignment Manager assigns 
salespeople based on the geographic location and revenue potential of the sales 
opportunity. For example, a sales opportunity in Nevada with a revenue 
potential of over $100,000 is assigned to the western division manager. However, 
a sales opportunity in New Mexico with a revenue potential of $100,000 or lower 
is assigned to a western field sales representative.
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Using Multitiered Assignment with Sales Assignment Rules
Multitiered assignment is a logical assignment feature that considers the 
relationships between people and organizations before assigning an object. 
Multitiered assignment functions in various modes; see “Multitiered Assignment” 
on page 20 for more information on multitiered assignment and its assignment 
modes. Multitiered assignment must also be configured for assignment objects. For 
more information on this process, see “Configuring Assignment Objects for 
Multitiered Assignment” on page 61. The following scenarios show how multitiered 
assignment functions in various modes. Each scenario is based on the same sales 
opportunity and the same assignment rules.

Independent Assignment. If multitiered assignment is disabled, Territory Assignment 
Manager assigns the object independently, resulting in the following scenario:

■ All people and organizations not matching assignment rule criteria are filtered 
out.

■ For each person that matches, assign that person to the object.

■ For each organization that matches, assign it to the object.

■ The European and Asian Sales Representatives independently are assigned to 
the same opportunity as well as the Europe and North America organizations.

Person Match Organization Match Assigned Person
Assigned 
Organization

European Sales 
Representative

Y Europe Y European Sales 
Representative

Europe

North American 
Sales 
Representative

N North America Y North 
America

Asian Sales 
Representative

Y Asia N Asian Sales 
Representative
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Person-Oriented Assignment. If multitiered assignment is set to person-oriented mode 
the following situation occurs:

■ All organizations and people not matching assignment rule criteria are filtered 
out.

■ For each person that matches, assign that person to the object.

■ Evaluate organization candidates for the assigned people’s organizations. If the 
organization matches, assign that organization to the object.

■ The European and Asian Sales Representatives are assigned; only the Europe 
organization is assigned.

Person Match Organization Match Assigned Person
Assigned 
Organization

European Sales 
Representative

Y Europe Y European Sales 
Representative

Europe

North 
American Sales 
Representative

N North America Y

Asian Sales 
Representative

Y Asia N Asian Sales 
Representative
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Organization-Oriented Assignment. If multitiered assignment is set to organization-
oriented mode the following situation occurs:

■ All organizations and people not matching the assignment rule criteria are 
filtered out.

■ For each organization that matches, assign it to the object. 

■ Evaluate each person candidate for the assigned organization’s people. If a 
person matches, assign that person to the object.

■ The Europe and North America organization are assigned; only the European 
Sales Representative is assigned.

Person Match Organization Match Assigned Person
Assigned 
Organization

European Sales 
Representative

Y Europe Y European Sales 
Representative

Europe

North 
American Sales 
Representative

N North America Y North America

Asian Sales 
Representative

Y Asia N
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Organization and Person-Oriented Assignment. If multitiered assignment is set to 
organization and person-oriented mode, the following situation occurs:

■ All organizations and people not matching the assignment rule criteria are 
filtered out.

■ For people and organizations that satisfy the assignment rule criteria, assign 
only those that have both a corresponding organization and person that meet the 
criteria (similar to a logical AND statement).

■ Only the European Sales Representative and the Europe organization are 
assigned.

Person Match Organization Match Assigned Person
Assigned 
Organization

European Sales 
Representative

Y Europe Y European Sales 
Representative

Europe

North 
American Sales 
Representative

N North America Y

Asian Sales 
Representative

Y Asia N
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Assignment in Service Organizations
In a service organization, service requests can often be resolved by the first 
customer service representative (CSR) who services the customer. However, when 
the request cannot be resolved, or when the service request is logged through the 
Internet, ownership must be transferred to a service representative who possesses 
the expertise to handle the request.

In this environment, it becomes critical to assign employees with the proper 
expertise and skills to service requests. Therefore, you should assign employees to 
objects because some employees possess specific skills that are different from those 
of other CSRs or field service engineers. When service representatives are on 
vacation, are promoted, or assume different responsibilities, work assigned to these 
employees must be reassigned based on the attributes of other employees in the 
service organization.

NOTE: A quick-start method is available if you plan to assign service requests using 
the same assignment rule. To use this method, skip to Step 4 on page 40 in the 
following procedure.

To develop effective assignment rules for your customer service organization

1 Determine the different assignment objects that need to be assigned.

Service organizations need to assign ownership of a wide variety of tasks. These 
tasks may include service requests, activities, and accounts. In addition, a 
product development organization may need to assign ownership of product 
defects to engineers. For instance, you may decide to assign only service 
requests and product defects, because the associated activities are manually 
assigned by owners of those objects.

2 Determine if multiple assignment objects are assigned using the same 
assignment rules.

Multiple assignment objects can be assigned using the same assignment rules. 
For example, if you are assigning accounts and service requests in the same 
manner, you can use the same assignment rules by associating those rules with 
multiple assignment objects.
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3 For each assignment object, determine which of the objects is assigned using the 
same assignment rules.

Typically, complex service environments assign different groups of service 
requests using different rules, such as segmenting the service requests based on 
service request priority.

4 Determine the strategy for each group of objects to be assigned using the same 
assignment rules.

One assignment rule can match different candidates to various objects based on 
the object characteristics. To determine optimal assignment, determine the 
criteria that you wish to evaluate for each candidate. This is the primary type of 
criteria you use most frequently for implementing assignments in a customer 
service environment.

5 Define assignment rules, assignment criteria, and assignment criteria values.

Using the strategy, rules, and criteria discussed above, define the assignment 
rules and the corresponding details using the Territory Assignment 
Administration views. In defining rules, criteria, and values, you can specify a 
candidate or candidates for an assignment rule.

6 Define candidates.

Using the Assignment Rule Employees view, define the eligible employees for 
assignment.

7 Release assignment rules.

In the Territory List view, click the Release button. You can then run Batch 
Assignment to assign objects affected by the assignment rules. For more 
information about Batch Assignment, see “Running Territory Assignment 
Manager in Batch Mode” on page 146.
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Figure 4 shows a sample assignment rule for assigning support representatives to a 
service request.

Figure 4. Assignment Rule for a Service Organization
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This chapter explains how to configure Territory Assignment Manager components. 
Configuration tasks outlined in this chapter are performed using Siebel Tools. 
Perform the procedures described in this chapter if you need to:

■ Modify the predefined assignment objects

For more information, see “Configuring Assignment Objects” on page 53.

■ Create new assignment objects

For more information, see “Creating Assignment Objects” on page 52.

■ Define additional assignment criteria types and attributes

For more information, see “Configuring Assignment Criteria” on page 74 and 
“Configuring Assignment Criteria Attributes” on page 77.

■ Remove existing assignment criteria and attributes

For more information, see “To remove seed assignment criteria” on page 64.

■ Disable existing assignment attributes

For more information, see “Disabling an Assignment Attribute” on page 82

■ Create new workflow policy components

For more information, see “Creating Workflow Policy Components” on page 84.
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If you plan to use the predefined Territory Assignment Manager components, skip 
this chapter and proceed to Chapter 4, “Territory Assignment Rules.”

NOTE: If you add or change assignment objects, assignment attributes, or 
assignment criteria, you must migrate the repository to the server production 
database. For information on migrating the repository, see Siebel Tools Reference, 
MidMarket Edition.

CAUTION: The criteria values are highly specialized. Do not configure these 
components.

Before you can successfully configure Territory Assignment Manager, you need to 
possess a solid understanding of how to use Siebel Tools. For more information, see 
Siebel Tools Reference, MidMarket Edition. You should also familiarize yourself with 
the basics of the underlying Siebel application architecture. Territory Assignment 
Manager object types are also related to Workflow Manager object types. For more 
information, see Siebel Business Process Designer Administration Guide, MidMarket 
Edition.

CAUTION: The Siebel application does not support any change to original assignment 
objects, attributes, criteria, criteria attributes, or attribute columns. If your business 
need requires you to expand the functionality of these components, please copy 
these predefined objects and then make changes.
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Territory Assignment Manager Configuration Concepts
Using Siebel Tools, you can create new assignment object definitions in the 
repository. After you compile the changes, these new assignment objects appear in 
the picklists in your Siebel application for assignment object selection.

Territory Assignment Manager features that you can custom configure using Siebel 
Tools include:

■ List of assignment objects that can be assigned to assignment rules

■ List of attributes that can be incorporated in assignment criteria

■ Behavior of each available assignment object, including whether certain features 
are activated for the assignment object

■ Table and column mappings of assignment objects and attributes

■ Workflow policy component and workflow policy component column mappings 
of attributes used in assignment criteria.
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Territory Assignment Manager Object Types
The following object types are specific to Territory Assignment Manager and can be 
configured using Siebel Tools:

■ Assignment Object. Assignment object definitions are assigned to assignment 
rules in the Object field of assignment rule records. An assignment object 
specifies a business entity to which a candidate can be assigned, what is 
updated to accomplish that assignment, and other assignment behavior 
parameters. For more information, see “Assignment Object Configuration” on 
page 50.

■ Assignment Attribute. An assignment attribute object definition defines an 
attribute that can be referenced in assignment criteria records. It specifies a 
logical attribute that can be chosen from a picklist for defining comparisons. For 
more information, see “Configuring Assignment Attributes” on page 65.

■ Assignment Attribute Column. An assignment attribute column object definition 
assigns an assignment attribute to an assignment object and a workflow policy 
component column. These mappings set up value matching within the 
assignment object and workflow policy object. For more information, see 
“Configuring Assignment Attribute Columns” on page 71.

■ Assignment Criteria. An assignment criteria object definition defines an attribute, 
called an assignment criteria, that can be used in assignment criteria records. 
Assignment criteria appear in the picklist in the Criteria list column when you 
are editing an assignment rule record. For more information, see “Configuring 
Assignment Criteria” on page 74.

■ Assignment Criteria Attribute. An assignment criteria attribute object definition 
assigns an assignment attribute to the parent assignment criteria. Assignment 
criteria attributes make it possible for an assignment criteria to consist of 
multiple attributes. For more information, see “Configuring Assignment Criteria 
Attributes” on page 77.
46 Siebel Territory Assignment Manager Administration Guide MidMarket Edition Version 7.5



Territory Assignment Manager Configuration

Territory Assignment Manager Configuration Concepts
Territory Assignment Manager Object Hierarchy and Relationship
Use the Object Explorer in Siebel Tools to view the hierarchical (parent-child) 
relationships of Territory Assignment Manager object types. Figure 5 illustrates the 
hierarchical relationships of these object types (and two related object types in 
Workflow Manager configuration).

Figure 5 shows the following relationships:

■ Assignment object is a child of workflow policy object.

■ Assignment attribute column is a child of assignment attribute.

■ Assignment criteria attribute is a child of assignment criteria.

Figure 5. Parent-Child Relationships Between Territory Assignment Manager Object Types
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In addition to the parent-child relationships between Territory Assignment Manager 
object types, there are one-to-one and one-to-many relationships specified in 
property settings within the object definitions, as illustrated in Figure 6.

Figure 6. Field Value and Property Relationships Among Territory Assignment Manager Object Types
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Figure 6 on page 48 shows the following relationships:

■ Assignment rules (the box with a dashed border at the upper left) have 
assignment criteria children. Assignment rules are actually records of the 
Assignment Group business component, and their child assignment criteria are 
records of the Assignment Rule business component.

■ Each assignment rule points to one or more assignment object definitions, stored 
in a multi-value (MLOV) group attached to the Assignment Objects field in the 
assignment rule (Assignment Group business component) record.

NOTE: If an assignment rule does not specify an assignment object, this means 
that it applies to all assignment objects.

■ Each assignment criteria record points to an assignment criteria object 
definition, by means of the value in the Criteria field.

■ Assignment attributes are attached to an assignment object through a property 
setting in each assignment attribute column object definition.

■ An assignment attribute column object definition is mapped to a workflow 
policy component column object definition by means of a pair of property 
settings.
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Siebel Territory Assignment Manager uses definitions in the Siebel repository to 
assign objects to assignment rules and candidates.

An assignment object specifies a business entity to which a candidate can be 
assigned and the entities that are updated to accomplish that assignment. For 
example, an employee or position can be assigned ownership of an opportunity or 
account, or made a member of the opportunity’s or account’s sales team. Similarly, 
an employee can be assigned ownership of a service request or product defect. Each 
of the corresponding business components has one or more fields that specify the 
owner or team. An assignment rule includes one or more assignment objects. When 
the rule is satisfied, specific columns underlying these fields are updated with 
replaced or added employee IDs in accordance with the settings in the assignment 
object. 

An assignment object is a child object type of workflow policy object. The parent 
workflow policy object provides a set of available column mappings through its 
child workflow policy component and grandchild workflow policy component 
column object types. These can be specified in assignment attribute column object 
definitions as columns to test for value matches and to monitor in dynamic 
assignment for value changes.

NOTE: Workflow policy objects have a one-to-one or a one-to-zero relationship with 
assignment objects (the Order and Quote workflow policy objects do not have 
predefined child assignment objects). You cannot add more assignment objects to 
workflow policy objects that already have a child assignment object.

Siebel applications provide predefined definitions in the Siebel repository for the 
following objects:

■ Account

■ Activity

■ Campaign

■ Contact

■ Opportunity
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■ Product Defect

■ Project

■ Project Team

■ Service Request

NOTE: The Sample database includes predefined assignment rules for several of 
these predefined objects. For more information about predefined assignment rules, 
see “Activating Assignment Rules” on page 98.

The predefined definitions include mappings for the most commonly used 
attributes for each object. For example, the Opportunity object has the following 
predefined object definitions: Account Name, Account City, Account State, Account 
Zip Code, Account Country, Lead Quality, Revenue, Industry SIC Code, and so on. 
For more information about these assignment attributes and how to configure them, 
see “Configuring Assignment Attributes” on page 65.

NOTE: Siebel Tools allows the creation or configuration of an assignment object with 
both Position- and Employee-based assignment, but Territory Assignment Manager 
does not correctly assign objects with this type of configuration. Only create or 
configure assignment objects for either Position-based or Employee-based 
assignment, not both. 

Assignment objects have a Lock Assignment feature that, when activated by 
checking the column on the object’s list applet, prevents Territory Assignment 
Manager from assigning, or reassigning, a position or candidate to the object. For 
example, use this feature to exclude an object (such as Account or Opportunity) 
from being reassigned by Territory Assignment Manager. By setting the column 
defined in the Exclude Column for the assignment object, Territory Assignment 
Manager excludes (ignores) the Object for assignment.
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Creating Assignment Objects
You can create new assignment objects by using Siebel Tools. However, adding 
assignment objects can require the addition of skills or other tables and columns. 
Given the complexity of this requirement, contact Technical Support if you need to 
create new assignment objects.

CAUTION: It is recommended that you contact Siebel Technical Support for 
assignment object creation. If you create your own assignment objects, you run the 
risk of Territory Assignment Manager assigning incorrect assignments.

To add an assignment object to a workflow policy object

1 Start Siebel Tools.

2 In the Object Explorer, expand Workflow Policy Object, and select Assignment 
Object.

3 In the Workflow Policy Objects window, select the workflow policy object type 
to which you wish to add the new assignment object.

4 Select the Assignment Objects window and choose Edit > New Record.

5 Configure the assignment object by setting values in the appropriate fields for 
each run-time parameter. 

For a list of assignment object parameters and their default values, see 
Appendix A, “Assignment Object Parameters.”

6 Compile the changes.

For more information, see Step 1 in “To update your deployment with new 
configurations” on page 94.

7 If you are running dynamic assignment, activate an assignment policy for the 
assignment object.

For more information, see “Activating Assignment Policies” on page 139.

8 Update your deployment with the new configurations. 

For instructions, see “Server Administration After Configuration” on page 93.
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Configuring Assignment Objects
Each assignment object uses its own set of run-time parameters that control the 
behavior of Territory Assignment Manager for that assignment object. These run-
time parameters are stored in the Siebel repository in the assignment object 
definitions. You can use Siebel Tools to modify the default values for these run-time 
parameters. For a list of assignment object parameters and their default values, see 
Appendix A, “Assignment Object Parameters.”

NOTE: If modifying the parameters default employee, default position, or default 
organization, make sure that the values specified exist in the appropriate base table. 
For example, if you change the default organization to My Organization, there must 
be an entry in the Group Administration > Organizations screen called My 
Organization.

To configure assignment objects

1 Start Siebel Tools.

2 Lock the project to which the assignment object belongs.

a In the Object Explorer, click the Types tab, and select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, expand Workflow Policy Object, and select Assignment 
Object.

4 In the Workflow Policy Objects window, select the assignment object that you 
want to configure.
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5 In the Assignment Objects window, configure the assignment object by setting 
values in the appropriate fields for each run-time parameter.

For a list of assignment object parameters and their default values, see 
Appendix A, “Assignment Object Parameters.”

6 Update your deployment with the new configurations. 

For instructions, see Step 2 on page 94 and Step 3 on page 95 in the “To update 
your deployment with new configurations” procedure.

NOTE: It is not necessary to recompile the siebel.srf file when configuring an 
assignment object. For more information on when to recompile, see Table 8 on 
page 93 and Siebel Business Process Designer Administration Guide, MidMarket 
Edition.
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Figure 7 shows an example of configuring the Account assignment object.

Figure 7. Example of Configuring an Assignment Object
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Configuring Assignment Objects for Interactive Assignment
Interactive assignment allows users to invoke Territory Assignment Manager 
immediately, view the list of assignees generated by Territory Assignment Manager, 
and then override or confirm the assignees in the list. Users can invoke Interactive 
Assignment by clicking the appropriate object’s form Menu button and choosing 
Assign. Figure 8 shows the Assign option from the Menu button from the All Service 
Requests view.

When the user clicks the menu button in the More Info form and chooses Assign 
for the current service request, the Siebel client contacts the assignment server and 
creates a list of qualified employees sorted by descending scores. The list of 
qualified employees appears to the user in the Employees window. The user then 
selects an employee from the list to be the service request owner.

Alternatively, you can allow SmartScript to have Territory Assignment Manager 
select the most qualified candidate from the list. In this case, a list of qualified 
employees does not appear in the Employees window, and the most qualified 
candidate is assigned.

The Service Request assignment object is configured for Interactive Assignment by 
default. You can use Siebel Tools to configure Interactive Assignment for other 
assignment objects. For more information on Interactive Assignment, see 
“Interactive Assignment” on page 21.

Figure 8. Example of Interactive Assignment
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To configure interactive assignment for an assignment object

1 Verify that Territory Assignment Manager is configured to perform assignment 
of values in the desired field, including the presence of the necessary assignment 
object and assignment rules and values.

2 Verify that the displayed business component is of the CSSBCBase class or one 
of its subclasses and add the Assignment Object business component user 
property to the business component.

a In the Object Explorer, select Business Component.

b In the Business Components window, select the business component.

c In the Class property for that business component, verify the value is 
CSSBCBase (such as in the Account business component).

NOTE: Business components based on other classes cannot be configured for 
interactive assignment. If the class is not CSSBCBase, note the class name and 
locate it in the Object Explorer for the Class object type. Note the value in the 
Super Class property for this class. If the Super Class is CSSBCBase, interactive 
assignment is permitted. If the Super Class is not CSSBCBase, check the Super 
Class property for that class.

d Set the Name property to Assignment Object.

e Set the Value property to the name of the assignment object that is to be used 
in the assignment process.

3 Verify that the appropriate applet is of the CSSFrameBase class or one of its 
subclasses.

a In the Object Explorer, select Applet.

b In the Applets window, select the applet.

c In the Class property for that applet, verify the value is CSSFrameBase (such 
as Account Entry Applet).

NOTE: Applets based on other classes (including CSSFrameListBase) cannot be 
configured for Interactive Assignment. 
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4 Add the Assignment Type business component user property to the business 
component.

a In the Object Explorer, select Business Component.

b In the Business Components window, select the business component, and 
then click Business Component User Prop.

c Set the Name property to Assignment Type.

d Set the Value property to:

❏ People if you are setting up an employee- or position-based assignment

❏ Organizations if you are setting up an organization-based assignment

❏ Both if you are setting up employee-, position-, and organization-based 
assignments

5 Optionally, if you want to enable SmartScript, add the Assignment Interactive 
business component user property to the business component.

a Set the Name property to Assignment Interactive.

b Set the Value property to TRUE.

6 Add the Assign selection to the applet menu button.

a In the Object Explorer, select Applet.

b In the Applets window, select the applet to which you want to add the Assign 
functionality.

c In the Object Explorer, select Applet Method Menu Item.

d Select the Applet Method Menu Items window, choose Edit > New Record 
and set the following values:

❏ Command=Assign(SWE)

❏ Menu Text=Assign

❏ Position number = 1 (or to the number corresponding to the preferred 
placement in the menu)
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7 Add the business component that holds assignment results records to the 
business object of the view in which the reconfigured applet is used.

NOTE: This business component already exists, and is either: 1) Assignment 
Results (Position) or Assignment Results (Employee) if Assignment Type is set 
to People (depending on whether you are setting up an employee- or position-
based assignment), or 2) Assignment Results (Organizations) if Assignment 
Type is set to Organizations.

a In the Object Explorer, select Business Object.

b In the Business Objects window, select the Business Object for which you 
want to add a child business object component.

c In the Object Explorer, click Business Objects Components, and in the 
Business Objects Components window, choose Edit > New Record.

d In the new record, enter values in the appropriate fields with the BusComp 
name set to: Assignment Results (Position), Assignment Results (Employee), 
or Assignment Results (Organization).

8 Optionally, the business component user property called Assignment Results 
BusComp and the applet user property called Assignment Results Applet can be 
defined.

NOTE: These user properties are desirable when you need to show additional 
information about the results. For example, the service request assignment 
results can be joined with the CTI tables, and query only qualified service people 
who are not currently using their telephone. The name of the business 
component used to hold data for the additional fields would be specified in an 
Assignment Results BusComp user property in the business component being 
assigned. The name of the applet used to display the assignment results would 
be specified in an Assignment Results Applet user property in the applet from 
which assignment is invoked.
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9 Add one of the following Business Components (depending on what is being 
assigned) to the relevant Business Object: Assignment Group Position, 
Assignment Group Employee, or Assignment Group Organization. 

10 Update your deployment with the new configurations. 

For instructions, see Step 1 on page 94 in the “To update your deployment with 
new configurations” procedure.

NOTE: Other than recompiling the siebel.srf file, there are no additional 
administrative tasks required for this procedure. For more information on when 
to recompile, see Table 8 on page 93 and Siebel Business Process Designer 
Administration Guide, MidMarket Edition.
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Configuring Assignment Objects for Multitiered Assignment
Configuring assignment objects for multitiered assignment allows Territory 
Assignment Manager to consider the relationship between people and organizations 
when determining the proper assignment. By default, Territory Assignment 
Manager assigns people and organizations independently. Multitiered assignment 
runs in a variety of modes. For more information on multitiered assignment and the 
assignment modes, see “Multitiered Assignment” on page 20 and “Using 
Multitiered Assignment with Sales Assignment Rules” on page 35.

To configure an object for multitiered assignment

1 Start Siebel Tools.

2 Lock the assignment object’s project.

a In the Object Explorer, click the Types tab, and select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, expand Workflow Policy Object and select the assignment 
object.

4 For the assignment object, change the Assignment Mode field to the multitiered 
assignment mode operation of interest (choices are Independent, Org & Person-
oriented, Organization-oriented, and Person-oriented) as shown in Figure 9 on 
page 62.
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Figure 9. Selecting the Multitiered Mode

Select the multitiered
assignment mode from

the drop-down menu.
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Assignment Criteria Configuration
You can add new assignment attributes and assignment criteria using Siebel Tools.

Assignment attributes allow you to associate a single criteria value to multiple fields 
in the application. For example, you can define an assignment rule that matches 
candidates based on State. However, State is stored in a different field in the 
application for different objects. Assignment attributes map the places that State is 
defined into a single criteria value.

Assignment attributes are column-based. Column-based attributes are stored as 
columns in the object (such as Opportunity). 

An assignment criteria can consist of one or more assignment attributes, such as 
the criteria Account City, Account State, and Account Country. These assignment 
attributes are grouped as assignment criteria. In this case, a single assignment 
criteria includes three assignment attributes. Assignment criteria correspond to the 
Criteria column in the Assignment Administration views. To add or change drop-
down fields that define assignment criteria in an assignment rule, you should define 
or modify assignment criteria. Assignment criteria attributes enumerate assignment 
attributes for the assignment criteria.

When you create new assignment criteria, you typically perform the following 
procedures (in the order listed):

■ Create new assignment attributes

■ Create new assignment attribute columns to map new assignment attributes to 
existing assignment objects
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■ Create new assignment criteria to group new assignment attributes

■ Create assignment criteria attributes to enumerate assignment attributes for the 
assignment criteria

NOTE: Assignment criteria configured to include multiple assignment attributes 
cannot have these attributes based on columns in different tables. 

To eliminate default assignment criteria appearing in the Territory Detail Criteria 
view, use the following procedure.

To remove seed assignment criteria

1 Delete from any assignment rules the use of the criteria you want removed from 
the assignment criteria (Territories > Territory Detail > Criteria).

2 In Siebel Tools, inactivate the assignment attribute column, the assignment 
attribute, the assignment criteria attribute, and the assignment criteria.

For more information, see “Disabling an Assignment Attribute” on page 82.

3 Recompile all projects (not just the locked projects) in the .srf file.

For instructions, see Step 1 on page 94 of the “To update your deployment with 
new configurations” procedure.
64 Siebel Territory Assignment Manager Administration Guide MidMarket Edition Version 7.5



Territory Assignment Manager Configuration

Assignment Criteria Configuration
Configuring Assignment Attributes
An assignment attribute object definition defines an attribute that can be referenced 
in assignment criteria records. It specifies a logical attribute that can be chosen from 
a picklist for defining comparisons; it does not directly specify a particular database 
column or combination of columns. Column mapping is accomplished through the 
child assignment attribute column object definitions, one for each assignment 
object that uses the parent assignment attribute.

An assignment attribute also specifies the picklist that appears in the Values list of 
an assignment criterion when you are entering an attribute in a value record, as 
shown in Figure 10.

An assignment criteria attribute object definition implements each list column in 
the Values applet, as described in “Configuring Assignment Criteria Attributes” on 
page 77. The assignment criteria attribute is based on an assignment attribute, as 
specified in its assignment attribute property. The referenced assignment attribute 
identifies a picklist. This is the picklist that appears when you click the drop-down 
arrow to the right of the list column cell.

The Assignment Attribute object type functions as an intermediary between the 
assignment criteria on the one hand and the assignment objects on the other, as 
shown in Figure 6 on page 48.

Figure 10. Picklist for Populating an Attribute in a Value Record

This list column is based on
an assignment attribute...

...in whose definition this 
picklist is specified.
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An assignment criteria attribute references an assignment attribute through its 
assignment attribute property. In turn, each of the assignment attribute’s child 
assignment attribute columns specifies an assignment object and a workflow policy 
component/column combination. 

An assignment attribute is a logical grouping of similar mappings to different 
assignment objects that can use the same picklist for value selection. For example, 
the Account State assignment attribute has ten child assignment attribute column 
object definitions. Each of these assignment attributes is used for selection of the 
state in which an account is located, but five of them are used for different 
assignment objects (Activity, Account, Campaign Contact, and Order), and the 
other five are used for different account state attributes in the Opportunity 
assignment object (such as Primary Account State and Indirect Account Primary 
State).

NOTE: To generate a trigger based on an assignment attribute, a corresponding 
assignment attribute column must be configured. See “Configuring Assignment 
Attribute Columns” on page 71. 
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To create new assignment attributes

1 Start Siebel Tools.

2 Lock the assignment object’s project.

a In the Object Explorer, click the Types tab, and select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, select the Assignment Attribute object, and then choose 
Edit > New Record.

4 In the Assignment Attributes window, configure the assignment attribute object 
by setting values in the appropriate fields.

a In the Name field, type the name of the new assignment attribute.

b In the Project field, select a project.

c Optionally, if the attribute supports a range of values (such as revenue), 
check the Use Range field.

d In the Data Type field, select a data type for the attribute.

e Optionally, if you want a picklist for the attribute to allow users to select 
values for the assignment attribute, enter a value in the Picklist field.

f Optionally, you can use a pick field for the attribute to allow users to select 
values for the assignment attribute, enter a value in the Pick Field field.

For a description of these properties, see Table 4 on page 69.

5 Update the siebel.srf file and run various server administration tasks.

For instructions on updating your deployment with the new configurations, see 
“Server Administration After Configuration” on page 93.
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Figure 11 shows an example of creating an assignment attribute called Example of 
data type Varchar. This attribute also has the optional Assignment Attribute Picklist 
selected.

Figure 11. Example of Creating an Assignment Attribute
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Table 4 shows some of the properties of the Assignment Attribute object type.

Table 4. Properties of Assignment Attributes

Property Required Description

Bounded Optional When checked, the picklist is bounded (you can select 
a value from the picklist). When unchecked, you can 
enter a value that does not appear in the list.

Data Type Required Data type for the assignment attribute. Number, 
UtcDateTime, and Varchar are supported.

Name Required Name of the assignment attribute. Must be unique 
within the repository.

Order By LOV Type Optional Not used.

Pick Field Optional Name of the field to select from the picklist.

Pick List Optional Name of the picklist that supplies the selection values 
for populating any list column in the Values list (in the 
Territory Detail view) that is based on this assignment 
attribute.

Use Range Optional Specifies whether a single list column or a pair of list 
columns, indicating a range, appears for assignment 
criteria attributes based on this assignment attribute. 
For example, the Revenue assignment attribute, which 
has a TRUE value for Use Range, appears as two list 
columns, Revenue Low and Revenue High. You can 
enter $50000 in the former and $100000 in the latter in 
a value record to indicate the range $50,000–100,000.
Version 7.5 Siebel Territory Assignment Manager Administration Guide MidMarket Edition 69



Territory Assignment Manager Configuration

Assignment Criteria Configuration
Configuring MLOV for Assignment Attributes
Multilingual List of Values (MLOV) capability allows assignment attributes to be 
stored in a form that can be retrieved and displayed in a variety of supported client 
languages. For detailed information on MLOV, see Siebel Tools Reference, MidMarket 
Edition. To enable assignment attributes for MLOV, use the following procedure.

To enable assignment attributes for MLOV

1 Start Siebel Tools.

2 Lock the assignment object’s project.

a In the Object Explorer, click the Types tab, and then select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, select the Assignment Attribute object.

4 Select the Assignment Attribute in the list of attributes that requires translation.

5 Locate the Translate column for this attribute, and select the check box to assign 
this property with a TRUE value.

6 Locate the Translate Pick Field for the assignment attribute, and select from the 
Translate Pick Field dialog box the field in the Pick List Business Component that 
stores the Language Independent Code (in most cases this is the Name field).

You can also configure the application to enable MLOV for criteria values. For more 
information, see Siebel Tools Reference, MidMarket Edition.
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Configuring Assignment Attribute Columns
An assignment attribute column object definition maps an assignment attribute to 
an assignment object and a workflow policy component column, as shown in 
Figure 6 on page 48. These mappings set up value matching within the assignment 
object and workflow policy object for criteria that use the parent assignment 
attribute.

The parent assignment attribute is an abstract logical attribute to test for a value 
match, which you can specify in an assignment criteria. The child assignment 
attribute columns specify the actual mappings to assignment objects and workflow 
policy component columns. Each assignment attribute column can specify a 
different assignment object to search, or a different attribute within the same 
assignment object.

To map assignment attributes to an existing assignment object 

1 Start Siebel Tools.

2 Lock the assignment object’s project.

a In the Object Explorer, click the Types tab, and select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, expand the Assignment Attribute object, and select the 
Assignment Attribute Column object.

4 In the Assignment Attributes window, select the assignment attribute for which 
you want to map the logical location in the database schema.

5 In the Assignment Attribute Columns window, choose Edit > New Record.
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6 Configure the assignment attribute object by setting values in the appropriate 
fields.

a In the Name field, type the name of the new assignment attribute column.

b In the Assignment Object field, select an assignment object to which the 
assignment attribute is applied.

c In the Workflow Policy Component field, select a workflow policy component 
to which the workflow policy object is applied.

d In the Workflow Policy Component field, select a workflow policy component 
column to which the workflow policy component is applied.

e In the Sequence field, type in a sequence value.

For descriptions of these properties, see Table 5 on page 73.

7 Update the siebel.srf file and run various server administration tasks.

For instructions on updating your deployment with the new configurations, see 
“Server Administration After Configuration” on page 93.

Figure 12 shows an example of mapping an assignment attribute called Example to 
the Service Request assignment object. This attribute is also mapped to the Service 
Request workflow policy object, the Product workflow policy component, the 
Product ID workflow policy component column, and a sequence value of 1.

Figure 12. Mapping an Assignment Attribute to an Assignment Object
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Table 5 shows some of the properties of the Assignment Attribute Column object 
type.

Table 5. Properties of Assignment Attribute Columns

Property Required Description

Assignment Object Required Assignment object that is checked for a value match 
with the parent assignment attribute.

Name Required Name of the assignment attribute column. The typical 
format for the name is:

assignment_object: workflow_component_column

For example: 

Service Request: Account Area Code 

Sequence Required A unique sequence number for the assignment 
attribute column within the assignment attribute. If an 
assignment attribute has multiple assignment attribute 
columns, Territory Assignment Manager searches for 
attribute values in the order of the values in this 
property.

Workflow Policy 
Component

Required Name of the workflow policy component, within the 
specified workflow policy object, with which this 
assignment attribute column is associated.

Workflow Policy 
Component Column

Required Name of the workflow policy component column, 
within the specified workflow policy component, with 
which this assignment attribute column is associated.

Workflow Policy 
Object

Required Name of the workflow policy object with which the 
assignment attribute column is associated. When an 
assignment object is selected, the workflow policy 
object defaults to this selection.
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Configuring Assignment Criteria
An assignment criteria object definition defines an attribute, called an assignment 
criteria, that can be used in assignment criteria records. Assignment criteria appear 
in the picklist in the Criteria list column when editing an assignment criteria record 
in Siebel applications.

The Criteria list column in an assignment criteria record specifies the assignment 
criteria that is tested for a match against one or more attributes of the assignment 
object or candidate. For example, in an assignment criteria that determines whether 
the state is California, the assignment item would be State, Home State, or Account 
State, and the value California (CA) would be specified in a child value record.

When you click the drop-down arrow button in the Criteria list column, a picklist 
appears for selection of an assignment criteria. The picklist lists the available 
assignment criteria (assignment criteria object definitions in the repository). When 
you select an assignment criteria, its name is stored in the Criteria Name field in the 
current Assignment Rule business component record.

NOTE: The business component that holds assignment criteria is called Assignment 
Rule. The business component that holds assignment rules is called Assignment 
Group.

An assignment criteria includes one or more assignment criteria attributes, stored 
as child assignment criteria attribute object definitions. For information on 
assignment criteria attributes, see “Configuring Assignment Criteria Attributes” on 
page 77.

After you create and recompile an assignment criteria object definition, it becomes 
available for selection from the Criteria list column picklist in assignment criteria 
records.
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To create assignment criteria

1 Start Siebel Tools.

2 Lock the assignment object’s project.

a In the Object Explorer, click the Types tab, and select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, select the Assignment Criteria object, then choose 
Edit > New Record.

4 Configure the assignment criteria by setting values in the appropriate fields.

a In the Name field, type the name of the new assignment criteria.

b In the Project field, select the Assignment project.

c In the Display Name field, type the name that appears for the assignment 
criteria.

d Optionally, if you do not want the assignment criteria to appear in the Criteria 
picklist, uncheck the Display Flag field.

For descriptions of these properties, see Table 6 on page 76.

5 Update the siebel.srf file and run various server administration tasks.

For instructions on updating your deployment with the new configurations, see 
“Server Administration After Configuration” on page 93.
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Figure 13 shows an example of creating an assignment criteria called Example 
Criteria. 

NOTE: The Use Expertise and Employee Skill properties are not used in the Siebel 
MidMarket product.

The assignment criteria object definition has two properties to specify its name 
(internally and as displayed). Most of the behavior of an assignment criteria is 
configured in the assignment criteria attribute children. Table 6 shows some of the 
properties of the assignment criteria object type.

Figure 13. Creating an Assignment Criteria

Table 6. Properties of Assignment Criteria

Property Required Description

Display Flag Optional When checked, the assignment criteria appears in the Criteria 
picklist.

Display Name Optional Name that appears for this assignment criteria in the picklist 
and the Criteria list column in the Criteria list (Territory 
Detail> Criteria). If not specified, the value in the Name 
property is used instead.

Employee Skill Optional Not used in the Siebel MidMarket product.

Name Required Name of the assignment criteria.

Use Expertise Optional Not used in the Siebel MidMarket product.
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Configuring Assignment Criteria Attributes
An assignment criteria includes one or more assignment criteria attributes. 
Assignment criteria attributes are implemented as object definitions of the 
assignment criteria attribute object type. This is a child object type of assignment 
criteria. Assignment criteria attributes make it possible for an assignment criteria to 
consist of multiple attributes.

For example, the Account Wildcard assignment criteria includes an Account and 
Site, both of which correspond to a specific column. This setup is accomplished by 
creating two assignment criteria attribute children, Account and Site, of the Account 
Wildcard assignment criteria.

NOTE: Many assignment criteria have only a single assignment criteria attribute.

The set of assignment criteria attributes in an assignment criteria determines the set 
of list columns to appear in the Values list, as shown in Figure 14. 

Figure 14. List Columns in the Values List

The Account Wildcard 
assignment criteria...

...has the Account and Site 
columns in its value records.
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One list column appears in the Values list for each assignment criteria attribute in 
the assignment criteria. In Figure 14 on page 77, the Account Wildcard assignment 
criteria (the Account Name assignment criteria with a display name of Account 
Wildcard) has an Account and a Site list column in the display of its child Value 
records. Both the Account and Site list columns correspond to the Account Name 
assignment criteria attribute (with a display name of Account and Site, 
respectively). Figure 15 shows how this is accomplished in Siebel Tools.

If there were more assignment criteria attributes for this assignment criteria, each 
would have a list column in the Values list.

Assignment criteria attributes make it possible for an assignment criteria to consist 
of multiple attributes, each mapping to a specific assignment attribute object 
definition. For information on assignment attributes, see “Configuring Assignment 
Attributes” on page 65.

Figure 15. Assignment Criteria and Child Assignment Criteria Attribute

Account Name
assignment criteria

Account Name assignment 
criteria attribute
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To create assignment criteria attributes

1 Start Siebel Tools.

2 Lock the assignment object’s project.

a In the Object Explorer, click the Types tab, and select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 In the Object Explorer, expand the Assignment Criteria object, and select the 
Assignment Criteria Attribute object.

4 In the Assignment Criteria window, select the assignment criteria for which you 
want to enumerate assignment attributes.

5 Select the Assignment Criteria Attributes window, then choose Edit > New 
Record.

6 Configure the assignment criteria attribute by setting values in the appropriate 
fields.

a In the Name field, type the name of the new assignment criteria attribute.

b In the Assignment Attribute field, select the assignment attribute for this 
assignment criteria.

c In the Display Name field, type the name for the assignment criteria attribute.

d In the Store Column field, specify the column in the assignment factor items 
table where the value for the assignment criteria attribute is stored.

e In the Display Sequence field, specify the sequence in which the assignment 
criteria attribute appears.

f Optionally, in the Pick Applet field, choose a pick applet for the assignment 
criteria attribute to allow users to view or select values for the assignment 
criteria attribute.

For more information on these properties, see Table 7 on page 81.
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7 Update the siebel.srf file.

For instructions on updating the siebel.srf file, see Step 1 on page 94 of the “To 
update your deployment with new configurations” procedure.

8 Check in the Assignment project before using the assignment criteria attributes.

a In the Object Explorer, click the Types tab, and select Project.

b In the Projects window, select Assignment, and choose Tools > Check In.

9 Run various server administration tasks.

For instructions, see Step 2 and Step 3 of the “To update your deployment with 
new configurations” on page 94 procedure.

Figure 16 shows an example of creating an assignment criteria attribute called 
Example Criteria Attribute. This criteria attribute applies to the Example assignment 
attribute, has a display name of Example, and uses the Assignment Results 
(Employee) list applet.

Figure 16. Creating an Assignment Criteria Attribute
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Table 7 shows some of the properties of the assignment criteria attribute object type.

Table 7. Properties of Assignment Criteria Attributes

Property Required Description

Assignment Attribute Required Name of the assignment attribute that this 
assignment criteria attribute is based on. Selected 
from a drop-down list.

Display Name Required List column label that appears for this assignment 
criteria attribute in the Values list. If omitted, the 
Name is used in the list column label.

Display Sequence Required Order in which the list column for this assignment 
criteria attribute appears in the list applet, relative to 
those of other assignment criteria attributes in the 
assignment item. A lower number places the list 
column further to the left.

Name Required Name of the assignment criteria attribute, for 
identification. This name must be unique within the 
parent assignment criteria.

Pick Applet Optional If a picklist is defined for the associated assignment 
attribute, you specify the name of a pick applet to 
display the picklist for selection of a value in the 
attribute’s list column.

Store Column Required Specifies the column in the assignment factor items 
table (S_ASGN_RULE_ITEM) in which to store the 
value for the assignment criteria attribute. There are 
four columns of each data type (Number, 
UtcDateTime, and Varchar) provided for storage of 
assignment criteria attribute values in each 
assignment criteria. You must specify a unique value, 
between 1 and 4 inclusive, for each assignment 
criteria attribute of the same data type. The data type 
can be determined from the Data Type property in 
the referenced assignment attribute object definition.
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Disabling an Assignment Attribute
In some cases, you may need to disable an existing assignment attribute. To do so, 
you must also disable the assignment attribute column, assignment criteria, and 
assignment criteria attribute definitions.

To disable an existing assignment attribute

1 Start Siebel Tools.

2 Lock the assignment object’s project.

a In the Object Explorer, click the Types tab, and select Project.

b In the Projects window, select the appropriate project.

c Check the Locked field.

3 Disable the assignment attribute definition.

a In the Object Explorer, select the Assignment Attribute object.

b In the Assignment Attributes window, select the assignment attribute you 
want to disable.

c Check the Inactive field.

4 Disable the assignment attribute column definition.

a In the Object Explorer, expand the Assignment Attribute object, and then 
select the Assignment Attribute Column object.

b In the Assignment Attribute Columns window, select the assignment 
attribute column you want to disable.

c Check the Inactive field.

5 Disable the assignment criteria definition.

a In the Object Explorer, select the Assignment Criteria object.

b In the Assignment Criteria window, select the assignment criteria you want 
to disable.

c Check the Inactive field.
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6 Disable the assignment criteria attribute definition.

a In the Object Explorer, expand the Assignment Criteria object, and then 
select the Assignment Criteria Attribute object.

b In the Assignment Criteria Attributes window, select the assignment criteria 
attribute you want to disable.

c Check the Inactive field.

7 Update the siebel.srf file and run various server administration tasks.

For instructions on updating your deployment with the new configurations, see 
“Server Administration After Configuration” on page 93.
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In some cases, you can create an assignment rule that assigns candidates to two 
objects while using only one of the object’s criteria. For example, you may want the 
ability to assign both Accounts and Opportunities based on the criteria Opportunity 
Lead Quality. To configure Territory Assignment Manager to assign Accounts based 
on this criteria, you must configure and expose the Opportunity Lead Quality 
column to the Account Assignment object. 

The following procedure explains how to create assignment rules that assign two 
objects using only one object criteria. 

To create an assignment rule that assigns two objects using only one object criteria

1 Create a workflow policy component for both objects.

For procedures using a specific example, see “Phase 1: Creating a Workflow 
Policy Component for Both Objects” on page 85.

2 Map the workflow policy component to the assignment criteria.

For procedures using a specific example, see “Phase 2: Mapping a Column to the 
Workflow Policy Component” on page 88.

3 Map the workflow policy component to the assignment attribute.

For procedures using a specific example, see “Phase 3: Mapping the Workflow 
Policy Component to the Assignment Attribute” on page 90.

4 Define an assignment rule for two objects using one assignment (object) criteria.

For procedures, see “Creating Assignment Rules to Assign Two Objects” on 
page 158.

For more information about workflows in general, see Siebel Business Process 
Designer Administration Guide, MidMarket Edition.
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Example of Creating a Workflow Policy Component
This section explains how to create a workflow policy component based on a 
specific scenario of creating an assignment rule that assigns candidates to two 
objects (Account and Opportunity) using only one of the object’s criteria 
(Opportunity Lead Quality). The example for accomplishing this is divided into four 
phases; perform each phase and the steps within each phase in the order provided.

■ “Phase 1: Creating a Workflow Policy Component for Both Objects” on page 85

■ “Phase 2: Mapping a Column to the Workflow Policy Component” on page 88

■ “Phase 3: Mapping the Workflow Policy Component to the Assignment 
Attribute” on page 90

■ “Phase 4: Administration Tasks After Configuration” on page 92

Phase 1: Creating a Workflow Policy Component for Both Objects
In this first phase, you create a workflow policy component for both objects.

To create a workflow policy component

1 Start Siebel Tools.

2 Lock the project.

a In the Object Explorer, click the Types tab, and then select Project.

b In the Projects window, select the appropriate project.

For this example, select Assignment (SSE).

c Check the Locked field.

3 Select the workflow policy object for which you want to create a workflow policy 
component.

a In the Object Explorer, select Workflow Policy Object.

b In the Workflow Policy Objects window, select the object.

For this example, select Account.
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4 Add a new workflow policy component record.

a In the Object Explorer, expand Workflow Policy Component.

b In the Workflow Policy Component window, choose Edit > New Record.

5 Enter information in the fields for the new record using the following steps:

a In the Name field, type the name of the workflow policy component.

For this example, type Account/Opportunity.

b In the Source Table Name field, select the source table for the workflow 
policy component.

For this example, select S_OPTY.

c In the Source Column Name field, select the source column for the workflow 
policy component.

For this example, select PR_DEPT_OU_ID.

d In the Target Component Name field, select the target component for the 
workflow policy component.

For this example, select Account.

e In the Target Column Name field, select the target column for the workflow 
policy component.

For this example, select ROW_ID. 
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Figure 17 shows an example of creating the Opportunity workflow policy 
component that maps to the Opportunity source table and the Account target table.

Figure 17. A Workflow Policy Component That Maps to Two Objects
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Phase 2: Mapping a Column to the Workflow Policy Component
After you create the workflow policy components for both objects, you need to map 
the workflow policy component to the assignment criteria. You do this by mapping 
a column to one of the workflow policy components. In this example, you map the 
Opportunity workflow policy component to the Opportunity Lead Contact 
assignment criteria.

To map a column to the workflow policy component

1 With the Account/Opportunity record still selected, expand the Workflow Policy 
Component object in the Object Explorer, and then select the Workflow Policy 
Component Col object.

2 In the Workflow Policy Component Columns window, choose Edit > New 
Record.

3 In the Workflow Column Name field, select the workflow column for the 
workflow policy component.

For this example, select Opportunity Lead Quality.
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Figure 18 shows an example of mapping the Account/Opportunity workflow policy 
component to the Opportunity Lead Quality assignment criteria.

Figure 18. Mapping Workflow Policy Components to Assignment Criteria
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Phase 3: Mapping the Workflow Policy Component to the 
Assignment Attribute
After you map a column to the workflow policy component, you map the workflow 
policy component to the assignment attribute. In this example, you map the 
Account/Opportunity policy component to the Lead Quality Code assignment 
attribute.

To map the workflow policy component to the assignment attribute

1 In the Object Explorer, select the Assignment Attribute object.

2 In the Assignment Attributes window, select Lead Quality Code.

3 In the Object Explorer, expand the Assignment Attribute object and select the 
Assignment Attribute Column object.

4 In the Assignment Attribute Columns window, choose Edit > New Record.

5 Enter information in the fields for the new record using the following steps:

a In the Name field, type the name of the assignment attribute column.

For this example, type Account: Lead Quality.

b In the Assignment Object field, select the assignment object to which 
candidates are assigned for the assignment rule.

For this example, select Account.

c In the Workflow Policy Component field, select the workflow policy 
component to map to this assignment attribute.

For this example, select Account/Opportunity.

d In the Workflow Policy Component Column field, select the workflow policy 
component column to map to this assignment attribute.

For this example, select Opportunity Lead Quality.

e In the Sequence field, specify the sequence of this assignment attribute.

For this example, type 2.
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6 Update the siebel.srf file and run various server administration tasks.

For instructions on updating your deployment with the new configurations, see 
“Server Administration After Configuration” on page 93.

NOTE: You must recompile the siebel.srf file whenever you add, inactivate, or 
delete any assignment object types, assignment criteria, and assignment 
attributes. Make sure all projects are recompiled—not only the locked projects—
if you inactivate or delete a top-level object type or assignment criteria. For more 
information on when to recompile the siebel.srf file, see Table 8 on page 93.

Figure 19 shows an example of mapping the Account/Opportunity workflow policy 
component to the Opportunity: Lead Quality assignment attribute.

Figure 19. Mapping Workflow Policy Components to Assignment Attributes
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Phase 4: Administration Tasks After Configuration
After the workflow policy component is mapped to the assignment attribute, the 
siebel.srf file must be updated and various server administration tasks run. To make 
sure your configurations are recognized, complete all steps in “To update your 
deployment with new configurations” on page 94.

Workflow Policy Components Inactivated by Default
The Opportunity Workflow Policy Object has the following Workflow Policy 
Components inactivated by default for Territory Assignment Manager.

If these Workflow Policy Components are required for your deployment, activate the 
components by following the procedures in “Defining a Workflow Policy 
Component” section of Siebel Business Process Designer Administration Guide, 
MidMarket Edition.

Workflow Policy Object Workflow Policy Component

Opportunity Indirect Account

Opportunity Indirect Account Address

Opportunity Indirect Account Industry

Opportunity Indirect Account Primary Address

Opportunity Indirect Account Synonym

Opportunity Indirect Account/Industry

Opportunity Opportunity/Indirect Account

Opportunity Primary Account Address
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Server Administration After Configuration
After configuring Territory Assignment Manager objects and attributes, it is often 
necessary to recompile the .srf file and restart various server components and tasks. 
Table 8 summarizes the required administration tasks based on the type of 
configuration process. 

CAUTION: You must recompile the siebel.srf file whenever you add, inactivate, or 
delete any assignment object types, assignment criteria, and assignment attributes. 
Make sure all projects are recompiled—not only the locked projects—if you 
inactivate or delete a top-level object type or assignment criteria. 

Use the following procedure to update your deployment with new configurations.

NOTE: Some steps may not be required for your particular deployment. See Table 8 
and the particular procedure for the necessary steps.

Table 8. Summarization of Server Administration After Configuration

Configuration Process
Compile .srf 
File

Restart 
Assignment 
Manager

Regenerate 
Triggers

Restart Workflow 
Monitor Agent 
(for dynamic 
assignment)

Add, inactivate, or delete 
assignment objects

Yes Yes Yes Yes

Configure assignment objects No Yes Yes Yes

Add, configure, inactivate, or 
delete assignment attributes

Yes Yes Yes Yes

Configure assignment 
attribute columns

No Yes Yes Yes

Add, configure, inactivate, or 
delete assignment criteria

Yes Yes Yes Yes

Add, configure, inactivate, or 
delete assignment criteria 
attributes

Yes Yes Yes Yes
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To update your deployment with new configurations

1 Compile changes to the siebel.srf file, if necessary, and deploy it to the server.

a Choose Tools > Compile Projects.

b In the Object Compiler dialog box, select the project (or projects) you want 
to compile.

NOTE: For the procedures provided in this chapter, select either the Assignment, 
or the Assignment (SSE) project, or both.

c Select the Siebel client repository file (default is siebel.srf) located in the 
Objects subdirectory within the Siebel client root directory.

d Click Compile.

For more information on when to recompile the siebel.srf file, see Table 8 on 
page 93 and Siebel Tools Reference, MidMarket Edition. For information on 
distributing the siebel.srf file, see Siebel Anywhere Administration Guide, 
MidMarket Edition.

NOTE: It is not necessary to recompile the siebel.srf file whenever you configure 
an assignment object or an assignment attribute column, but you must 
recompile the siebel.srf file whenever you add, inactivate, or delete any 
assignment object types, assignment criteria, or assignment attributes.
Make sure all projects are recompiled—not only the locked projects—if you 
inactivate or delete a top-level object type or assignment criteria. 

2 If you are running dynamic assignment, perform the following steps:

a Stop the Workflow Monitor Agent server component.

b Regenerate triggers by running the Generate Triggers server component.
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c Release assignment rules (if rules have changed) by clicking Release in the 
Territory Assignment List view.

For more information on releasing assignment rules, see “Releasing 
Assignment Rules” on page 114.

d Restart the Workflow Monitor Agent server component. 

For more information on stopping and restarting server components, see Siebel 
Server Administration Guide, MidMarket Edition.

3 If your are running dynamic assignment, stop and restart the Assignment 
Manager server component for the changes to take effect.

a Stop the Workflow Monitor Agent server component.

b Stop the Assignment Manager server component.

c Start the Assignment Manager server component.

d Start the Workflow Monitor Agent server component.

For more information on stopping and restarting server components, see Siebel 
Server Administration Guide, MidMarket Edition.

NOTE: You must stop and restart the Assignment Manager server component 
whenever you add, inactivate, or delete any assignment object types, 
assignment criteria, or assignment attributes.
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This chapter provides a procedure for activating territory assignment rules and 
explains how to define and use territory assignment rules in the Siebel client.

NOTE: Even if you intend to use predefined assignment objects, you must define 
assignment rules by completing the tasks in this chapter.
Version 7.5 Siebel Territory Assignment Manager Administration Guide MidMarket Edition 97



Territory Assignment Rules

Activating Assignment Rules
Activating Assignment Rules
Territory Assignment Manager comes with predefined assignment rules. If you plan 
to use these predefined rules, you must activate them first. To activate these rules, 
use the following procedure.

To activate an assignment rule

1 From the application-level menu, choose View > Site Map > Assignment 
Administration > Assignment Rules.

2 In the Assignment Rule form, query for the assignment rule you want to activate, 
and click Go.

3 In the Expiration field, either null the existing value or set the value to a later 
date. 
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Defining Assignment Rules
To define and use territory assignment rules, you need to perform the following 
tasks in the Siebel client:

■ Create the territory assignment rule.

For more information, see “Creating Territory Assignment Rules” on page 100.

■ Create assignment criteria.

For more information, see “Creating Assignment Criteria” on page 104.

■ Create criteria values.

For more information, see “Creating Criteria Values” on page 106.

■ Assign employees, positions, or organizations to the assignment rule.

For more information, see “Assigning Employees, Positions, and Organizations” 
on page 108.

■ Release the assignment rule.

For more information, see “Releasing Assignment Rules” on page 114.

The following sections explain how to perform each of these tasks using the 
Assignment Administration views. The sections are organized to present 
information in a sequence roughly corresponding to the order in which you are 
likely to be concerned with the subjects described when defining new assignment 
rules.
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Creating Territory Assignment Rules
This section explains how to create territory assignment rules. For more information 
on assignment rules, see “Assignment Rules” on page 17.

First, you use the Territory Detail view to create a new assignment rule specifying 
criteria and positions. Then, if you want Territory Assignment Manager to evaluate 
employees or organizations as candidates or if you want to set primaries for that 
rule, you use the Assignment Rule view to specify those values. The procedures you 
need to accomplish this are divided into two phases as follows:

■ “Phase 1: To create territory assignment rules”

■ “Phase 2: To specify additional territory assignment rule values” on page 102

Phase 1: To create territory assignment rules

1 From the application-level menu, choose View > Site Map > Assignment 
Administration > Territories.

2 In the Territory list, click New. 

3 In the new record, click in the available fields to enter relevant information for 
the new rule.
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Table 9 shows the predefined fields.

Table 9. Territory Assignment Rule Fields

Field Description Example

Activation (Date/
Time)

Start date of the territory assignment rule.

Comments Type in your comments here.

Exclusive If selected, a territory assignment rule assigns a 
priority status to candidates from that rule. 
These candidates supersede other qualified 
candidates from nonexclusive territory 
assignment rules. The object is assigned to:

■ The default employee for employee-based 
assignments

■ The default position for position-based 
assignments

■ The default organization for organization-
based assignments

Expiration (Date/
Time)

End date of the territory assignment rule.

Last Updated By Person who last updated the record.

Name Name of the territory assignment rule. North West 
Region

(Assignment) Objects Objects applied to this rule. If no objects are 
specified, then all objects are applied to this 
rule.

Account

Primary Position Primary position for this territory assignment 
rule. Typically used for sales-related 
assignments. Applicable only if this position is 
included for the assignment rule.

Score Not used in the Siebel MidMarket product.

Updated Date Date of last record update. 6/12/2002 
04:42:18 PM
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Figure 20 shows an example of creating a Territory Assignment Rule.

Phase 2: To specify additional territory assignment rule values

1 With the new rule still selected in the Territories view, click the Show drop-down 
list arrow and select Assignment Rules.

2 In the Assignment Rule form, click in the available fields to enter or change 
relevant information for the rule.

Figure 20. Example of Creating a Territory Assignment Rule
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Table 10 shows some of the fields.

NOTE: The Score, Minimum Score, Rule Group, Sequence, and Check Calendar fields 
are not used in the Siebel MidMarket product. Also, only the All, Above Minimum 
value in the Assignees from Rule field is used in the Siebel MidMarket product. 

For more information about assigning employees, positions, and organizations, see 
“Assigning Employees, Positions, and Organizations” on page 108.

Table 10. Additional Territory Assignment Rule Fields

Field Description Example

All Organizations If selected, evaluates all organizations in the 
Siebel database as candidates for this 
assignment rule.

All People If selected, evaluates all employees or positions 
in the Siebel database as candidates for this 
assignment rule.

Primary Employee Primary employee for this assignment rule. 
Typically used for service-related assignments. 
Applicable only if this employee is included for 
the assignment rule.

Primary Organization Primary organization for this assignment rule. 
Applicable only if this organization is included 
for the assignment rule.
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Creating Assignment Criteria
This section explains how to create assignment criteria for territory assignment 
rules. For more information on assignment criteria, see “Assignment Criteria” on 
page 18.

NOTE: Assignment rules can be created with no criteria. A rule of this nature 
functions to make sure all data items of a particular type are assigned, that is, all 
objects of the defined type pass. Use these rules carefully as a rule defined with no 
criteria can make assignments that are not required. Although assignment criteria 
are not required for an assignment rule, assignment rules with no criteria and no 
assignment object specified are ignored by Territory Assignment Manager. 

To create assignment criteria

1 From the application-level menu, choose View > Site Map > Assignment 
Administration > Territories.

2 In the Territory list, select the assignment rule for which you want to create 
assignment criteria, and then click the Territory Detail view tab.

3 In the Criteria list, click New.

4 In the new criterion record, click in the available fields to enter the relevant 
information.

NOTE: If you want to query for an assignment criteria, you must use the name of 
the assignment criteria, not the display name. For example, if the name of the 
Account assignment criteria is ACCOUNT_ID, then you must use this name for 
your query, although the display name is Account. The queries for seed 
assignment criteria must also be made with their English names, that is, these 
queries do not accept non-English characters. 
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Table 11 shows some of the fields.

Figure 21 shows a criterion called Account State in the Criteria list.

Table 11. Assignment Criteria Fields

Field Description Example

Criteria Type of assignment criteria. Account State

Inclusion Methods used by Territory Assignment 
Manager to determine how criteria values 
and candidates are matched. For more 
information on inclusion methods, see 
Table 3 on page 18.

Include

Figure 21. Example of Creating Territory Assignment Criteria
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Creating Criteria Values
This section explains how to create criteria values. Each assignment criteria uses 
different predefined criteria values. You determine the number of criteria values and 
define each value by setting assignment attributes (shown as fields in the Values list 
applet). For more information on criteria values, see “Criteria Values” on page 19.

To create criteria values

1 With the appropriate assignment criterion selected in the Criteria list (View > 
Site Map > Assignment Administration > Territories > Territory Detail > 
Criteria), click the Values list.

2 In the Values list, click New. 

3 In the new record, click in the available fields to enter the relevant information. 

NOTE: The assignment attributes for criteria values that are available differ 
depending on the assignment criterion you select in Step 1.

NOTE: It is possible to create duplicate criteria values for an assignment criteria.

Wildcard characters can also be used when defining specific criteria values. This 
option allows for a greater range of assignment object matches. For example, if you 
create an assignment rule for Account objects with the Account City as assignment 
criteria, the corresponding criteria value City can be defined as A*. This setting 
matches Accounts in cities beginning with the letter A.

If a criteria value includes special characters “?”, “*”, and “\” that are used as 
literals, the escape identifier character (\) must be added before the special 
character in the value field. For example, the criteria value Tri*Laptop is entered 
into the Values field as Tri\*Laptop.

Criteria values that include alphanumeric entries are stored as string values. These 
values are sorted lexicographically, that is, in dictionary order, when determining 
specific ranges for assignment rules. For example, the value AB10 is sorted between 
AB1 and AB9 even though you may require AB10 placed greater than AB9. 
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Figure 22 shows an example of creating criteria values for an Account State 
criterion.

Figure 22. Example of Creating Criteria Values
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Assigning Employees, Positions, and Organizations
This section provides procedures for assigning employees, positions, and 
organizations to territory assignment rules as follows:

■ “Assigning Employees”

■ “Assigning Positions” on page 110

■ “Assigning Organizations” on page 112

For more information about employees, positions, and organizations, see 
“Candidates” on page 14.

Assigning Employees
This section explains how to assign employees for a territory assignment rule. 
Service organizations typically assign employees to objects. For more information 
on employees, see “Employees” on page 14.

NOTE: Territory Assignment Manager does not prevent you from adding employees 
to an assignment rule that requires position assignment. Before adding employees, 
make sure that the objects for the assignment rule allow employee assignment.

To assign employees

1 With the appropriate territory assignment rule selected in the Assignment Rule 
view (View > Site Map > Assignment Administration > Assignment Rule), 
click the Employees view tab.

2 In the Employees list, click New.
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3 In the Add Employees dialog box, select the employees to include for this 
assignment rule, and then click OK.

NOTE: To select multiple employees, hold down the CTRL key while selecting 
employees.

4 In the new record in the Employees list, click in the available fields to enter or 
edit the relevant information.

Table 12 shows select predefined fields available.

Employees assigned to assignment rules are stored in a file called rulecache.dat. If 
new employees are added to an assignment rule, it is important to refresh the 
rulecache.dat file; otherwise, new employees are not assigned. For more 
information about the rulecache.dat file, see “Releasing Assignment Rules” on 
page 114.

Figure 23 shows an example of assigning employees.

Table 12. Employees List Fields

Field Description Example

Activation Date/Time Start date of the territory assignment rule 
employee.

4/10/01 3:01:00 PM

Expiration Date/Time End date of the territory assignment rule 
employee.

4/10/01 3:01:00 PM

Score Not used in the Siebel MidMarket product.

Figure 23. Example of Assigning Employees
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Assigning Positions
This section explains how to assign positions for a territory assignment rule. Sales 
organizations typically assign positions to objects. For more information on 
positions, see “Positions” on page 14.

NOTE: Territory Assignment Manager does not prevent you from adding positions to 
an assignment rule that requires employee assignment. Before adding positions, 
make sure that the objects for the assignment rule allow position assignment.

To assign positions

1 With the appropriate territory assignment rule selected (View > Site Map > 
Assignment Administration > Assignment Rules), click the Positions view tab.

2 In the Positions list, click New. 

3 In the Add Positions dialog box, select the positions to include for this 
assignment rule, and then click OK.

NOTE: To select multiple positions, hold down the CTRL key while selecting 
positions. 

4 In the new record in the Positions list, click in the available fields to enter or edit 
the relevant information.

Table 13 shows select predefined fields available for editing.

Table 13. Positions List Fields

Field Description Example

Activation Date/Time Start date of the territory assignment rule 
position.

4/10/01 3:01:00 PM

Expiration Date/Time End date of the territory assignment rule 
position.

4/10/01 3:01:00 PM

Score Not used in the Siebel MidMarket product.
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Figure 24 shows a list of sales representative positions in the Positions list available 
for a territory assignment rule.

After you assign positions for an assignment rule, only the active employees for 
each position are available. If Territory Assignment Manager assigns the position, 
employees for the position have visibility to the assigned object.

To delete system-assigned positions from individual assignment objects, or to 
manually assign other positions, see the procedure in “Maintaining the Manually 
Assigned Primary Position” on page 167. 

Positions assigned to assignment rules are stored in a file called rulecache.dat. If 
new positions are added to an assignment rule, it is important to refresh the 
rulecache.dat file; otherwise, new positions are not assigned. For further 
information, see “Releasing Assignment Rules” on page 114.

NOTE: Do not delete positions. If you delete a position that was manually assigned 
as the primary position for an object, Territory Assignment Manager is not able to 
set the primary position for that object. Instead, deactivate a position by setting the 
expiration date for that position. For more information, see Applications 
Administration Guide, MidMarket Edition.

Figure 24. Example of Assigning Positions
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Territory Assignment Manager can also assign positions based on their association 
with their parent organization. For example, only positions associated with a 
specific organization can be assigned to an assignment object even if other positions 
not associated with the organization qualify. This functionality is called multitiered 
assignment and must be configured for the appropriate assignment object. For more 
information on this feature, see “Multitiered Assignment” on page 20.

Assigning Organizations
This section explains how to assign organizations for a territory assignment rule. 
For more information on organizations, see “Organizations” on page 15.

To assign organizations

1 With the appropriate territory assignment rule selected (View > Site Map > 
Assignment Administration > Assignment Rules), click the Organizations view 
tab.

2 In the Organizations list, click New.

3 In the Add Organization dialog box, select the organizations to include for this 
assignment rule, and then click OK.

NOTE: To select multiple organizations, hold down the CTRL key while selecting 
organizations, and click OK.

4 In the new record in the Organizations list, click in the available fields to enter 
or edit the relevant information.

Table 14 shows select predefined fields available for editing.

Table 14. Organizations List Fields

Field Description Example

Activation Date/Time Start date of the territory assignment rule 
organization.

4/10/01 3:01:00 PM

Expiration Date/Time End date of the territory assignment rule 
organization.

4/10/01 3:01:00 PM

Score Not used in the Siebel MidMarket product.
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Figure 25 shows an example of assigning an organization for an assignment rule.

Organizations assigned to assignment rules are stored in a file called rulecache.dat. 
If new organizations are added to an assignment rule, it is important to refresh the 
rulecache.dat file; otherwise, new organizations are not assigned. For further 
information, see “Releasing Assignment Rules” on page 114.

Territory Assignment Manager can also assign organizations based on the positions 
associated within the organization. For example, positions assigned to an 
assignment object can also have their associated organizations assigned. This 
functionality is called multitiered assignment and must be configured for the 
appropriate assignment object. For more information on this feature, see 
“Multitiered Assignment” on page 20.

Alternatively, you can set a default organization for assignment objects. For 
example, if you want all records for a given assignment object assigned to a certain 
organization, you can change the Default Org property on the assignment object 
using Siebel Tools. For more information about setting the Default Org property, see 
Siebel Tools Reference, MidMarket Edition.

Figure 25. Example of Assigning Organizations
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Releasing Assignment Rules
After you have created and defined assignment rules, you must release them to 
instruct Territory Assignment Manager to use these rules. Releasing assignment 
rules also updates the rulecache.dat file, which includes information on employees, 
positions, and organizations available for assignment.

CAUTION: The following procedure releases all assignment rules simultaneously. Do 
not release assignment rules while associated server tasks are running.

To release assignment rules 

1 From the application-level menu, choose View > Site Map > Assignment 
Administration > Territories.

2 In the Territory List list, click Release.

When a new Siebel Server is installed—for instance, as part of an upgrade—all 
pending assignment rules are released (the rule cache is recreated) on the first 
startup. It is recommended that you release assignment rules after installation so 
that all servers in the deployment recreate the same rule cache. 
114 Siebel Territory Assignment Manager Administration Guide MidMarket Edition Version 7.5



Running Territory Assignment Manager 5
This chapter explains how to run Territory Assignment Manager in the following 
modes:

■ Interactive (see “Running Territory Assignment Manager in Interactive Mode” 
on page 126)

■ Dynamic (see “Running Territory Assignment Manager in Dynamic Mode” on 
page 131)

■ Mobile (see “Running Territory Assignment Manager in Mobile Mode” on 
page 145)

■ Batch (see “Running Territory Assignment Manager in Batch Mode” on 
page 146)

NOTE: Territory Assignment Manager uses many Siebel Server resources. It is 
recommended you monitor the Siebel Servers whenever Territory Assignment 
Manager is invoked, especially if you run multiple instances at the same time. For 
more information about running multiple instances of Territory Assignment 
Manager, see “Running Multiple Instances of Territory Assignment Manager in 
Batch Mode” on page 156.

Before running Territory Assignment Manager, you must already have created your 
assignment rules. For information on creating assignment rules, see Chapter 4, 
“Territory Assignment Rules.” You also need to perform several preparation tasks. 
For more information, see the next section, “Preparing to Run Territory Assignment 
Manager” on page 116.
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Territory Assignment Manager obtains information required for operation from the 
following sources:

■ The assignment rules and criteria as well as employees, positions, and 
organizations that are read from the rulecache.dat file.

■ The run-time parameters of assignment objects and their properties and the list 
of values for the picklists from the database.

Make sure the rulecache.dat file is updated (see “Releasing Assignment Rules” on 
page 114 for this procedure) and the .srf file is compiled with the latest 
configurations (see “Server Administration After Configuration” on page 93 or 
Siebel Tools Reference, MidMarket Edition for information on this procedure) before 
running Territory Assignment Manager.

Preparing to Run Territory Assignment Manager
Before running Territory Assignment Manager, you must first perform preparation 
tasks. These tasks include:

■ “Checking the Assignment Manager and Server Request Broker Components” on 
page 117

■ “Configuring the Assignment Manager Component” on page 118

■ “Configuring Territory Assignment Manager Event Logs” on page 121

In addition to the preparatory tasks, there are server administration requirements 
that should be addressed before running Territory Assignment Manager. These 
include:

■ “Server Administration Requirements for Assignment Modes” on page 124

■ “Server Administration Requirements After Configuration” on page 125
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Checking the Assignment Manager and Server Request Broker 
Components

Before running Territory Assignment Manager, you must first make sure that the 
Siebel Server can start one or more multi-threaded assignment servers by checking 
the Assignment Manager and Server Request Broker components.

To check Assignment Manager and Server Request Broker components

1 From the application-level menu, choose View > Site Map > Server 
Administration > Servers.

2 In the Servers list, select the server on which the Assignment Manager and 
Server Request Broker components run, and then click the Server Components 
view tab.

3 In the Component State field in the Server Components list, verify the state of 
each of the following components:

■ Assignment Manager component is Online.

■ Server Request Broker component is Running.

NOTE: If these components are not in their required state, check the log file for 
errors, and then make the necessary corrections.
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Configuring the Assignment Manager Component
Before running Territory Assignment Manager, you should configure the 
Assignment Manager component to enhance its performance for your 
implementation by adjusting the appropriate parameters. Table 15 on page 119 
shows the parameters you can change.

To configure the Assignment Manager component

1 From the application-level menu, choose View > Site Map > Server 
Administration > Components.

2 In the Name field in the Components list, select the Assignment Manager 
component, and make sure it is running on the correct server.

3 Click the Component Parameters view tab.

4 In the Component Parameters list, select the component parameters of interest, 
and adjust the values as required by your implementation to achieve optimal 
performance.

5 After you have determined the optimal settings, make sure that the 
MinMTServers parameter is set to a current value greater than 0, and then restart 
the Siebel Server.

This starts the specified number of Assignment Manager components. For more 
information about starting and restarting the Siebel Server, see Siebel Server 
Administration Guide, MidMarket Edition.

Table 15 shows the parameters used by Territory Assignment Manager that you can 
change. For a list of predefined server components and generic parameters, see 
Siebel Server Administration Guide, MidMarket Edition.
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Table 15. Assignment Manager Component Parameters

Parameter Name Parameter Alias Data Type Description DefaultValue

Check version iterations CheckVerIter Integer The lag time before the component 
checks if there is a change to the 
rules version, that is, when the 
Release button was pressed. One 
integer value equals ten seconds 
(minimum value is 1).

6

Default Tasks DfltTasks Integer Default number of service tasks to 
start (server mode only).

0

Log txn only on change LogTxnChgOnly Boolean Log transaction only when there is a 
net change in assignment (for 
example, sales team updated).

TRUE

Maximum MT Servers MaxMTServers Integer Maximum number of active servers 
for a multi-threaded service.

1

Maximum Tasks MaxTasks Integer Maximum number of running tasks 
for a service.

2

Minimum MT Servers MinMTServers1 Integer Minimum number of active servers 
for a multi-threaded service.

1

1. Applies only to the assignment server and other multi-threaded request-based servers.
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The following bulleted points explain why you might want to configure some of the 
various Assignment Manager component parameters:

■ Check version iterations. Changing this parameter to a small value, such as 1, 
reduces the potential for invalid assignment. For example, running Interactive 
Assignment before Territory Assignment Manager detects that the Release 
button was recently pressed causes assignment based on the previous version of 
assignment rules. By having a small iteration value, Territory Assignment 
Manager checks for a newer version of assignment rules more frequently. Test 
your deployment with this lower parameter value to make sure it does not 
interfere with any other database activity.

■ Maximum MT Servers. This parameter controls the maximum number of Territory 
Assignment Manager server processes that are running at any time (when 
MaxMTServers >MinMTServers). Generally, the default value is sufficient for 
most deployments as server processes and Territory Assignment Manager have 
large resource requirements.

■ Maximum Tasks. This parameter controls the maximum number of server threads 
that can run at any time. For Territory Assignment Manager, this controls the 
maximum number of assignments that can be processed concurrently. The value 
of this parameter should be set to the maximum anticipated concurrent requests 
(dependent on your server’s capabilities).

■ Minimum MT Servers. This parameter controls the number of Assignment 
Manager server processes that are started when the Siebel servers starts up. If 
this value is set to zero, Territory Assignment Manager is disabled. It is 
recommend to use the default value of one, as server processes and Territory 
Assignment Manager have large resource requirements.
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Configuring Territory Assignment Manager Event Logs
Before running Territory Assignment Manager, you can configure event logs to view 
results. The Assignment Manager, Batch Assignment, and Workflow Monitor Agent 
server components are configured to use events. For information on the event log 
system and viewing log files, see Siebel Server Administration Guide, MidMarket 
Edition.

NOTE: The Trace Flags and Error Flags parameters are no longer used with Territory 
Assignment Manager. 

In addition to the events used for other server components, the Assignment 
Manager, Batch Assignment, and Workflow Monitor Agent server components use 
two specific events to log information related to assignments: Object Assignment 
and Rules Evaluation.

The Object Assignment event is used to trace assignment information. Setting the 
log level for this event type to 3 prints a list of assignment rules and candidates that 
pass. 

The Rules Evaluation event is used to trace matching information. If you set the log 
level for this event type to 3, Territory Assignment Manager prints a list of evaluated 
assignment rules and whether or not they passed. If you set the log level for this 
event type to 4, Territory Assignment Manager prints a list of evaluated assignment 
rules and related criteria values, and whether or not they passed.

NOTE: You can set the log level of both event types to print a list with combined 
results. However, when assigning too many objects, these settings may create 
extremely large log files. 
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To set the log level of Territory Assignment Manager events

1 From the application-level menu, choose View > Site Map > Server 
Administration > Components.

2 In the Components list, select the Assignment Manager, Batch Assignment, or 
Workflow Monitor Agent component, depending on which component you want 
to set a log level; make sure the selected component is running on the correct 
server.

3 Select the Component Event Configuration view tab.

4 In the Log Level field in the Component Event Configuration list, adjust the 
values as required by your implementation as follows:

a Select Rules Evaluation; type in 3 if you want to print a list of assignment 
rules and candidates that passed

b Select Object Assignment; type in:

❏ 3 if you want to print a list of evaluated assignment rules and whether or 
not they passed

❏ 4 if you want to print a list of evaluated assignment rules and related 
criteria values, and whether or not they passed
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Figure 26 shows an example of setting the log level of event types for the 
Assignment Manager server component.

For more information on configuring event logs, see Siebel Server Administration 
Guide, MidMarket Edition.

Figure 26. Configuring Event Logs for Territory Assignment Manager
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Server Administration Requirements for Assignment Modes
Territory Assignment Manager requires various functioning server components and 
tasks based on the selected assignment mode. Table 16 summarizes the required 
server components and tasks that must be online or started when selecting a 
particular mode of assignment. When Mobile Assignment is selected, use the 
information provided for either Interactive or Dynamic Assignment based on your 
deployment requirements. Detailed information on starting these components and 
tasks is covered in the remainder of this chapter.

Table 16. Summarization of Server Requirements for Assignment Modes

Assignment Mode
Set Assignment 
Manager Online

Start Workflow 
Monitor Agent

Start Server Request 
Broker 

Interactive Mode Yes No Yes

Dynamic Assignment Mode No1 Yes No1

1. This information is based on the default “Assignment Request (In Process)” seeded 
action.

Batch Assignment Mode No No No
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Server Administration Requirements After Configuration
After configuring Territory Assignment Manager objects and attributes or altering 
assignment policies, it is often necessary to stop and restart various server tasks and 
components. Table 17 summarizes the required server tasks and components that 
must be restarted based on the type of configuration process. For further 
information on Territory Assignment Manager configuration, see Chapter 3, 
“Territory Assignment Manager Configuration.” Detailed information on how and 
when to run these server tasks and components is provided in the remainder of this 
chapter. 

Table 17. Summary of Server Administration After Configuration

Configuration Process

Restart 
Assignment 
Manager

Regenerate 
Triggers

Restart 
Workflow 
Monitor Agent

Adding or configuring an assignment object, 
assignment attribute, or assignment criteria

Yes Yes Yes

Changing assignment policies No Yes Yes

Activating or deactivating assignment policies No Yes Yes
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Running Territory Assignment Manager in Interactive 
Mode

This section explains how to run Territory Assignment Manager in interactive mode. 
Use Interactive Assignment to assign people in real time. The Activity and Service 
Request objects are predefined to use Interactive Assignment. This feature allows 
you to assign employees to activities and service requests in real time by simply 
clicking the Menu button and choosing Assign. For more information on Interactive 
Assignment, see “Interactive Assignment” on page 21. You can also configure other 
assignment objects to use Interactive Assignment. For more information on 
configuring assignment objects, see “Configuring Assignment Objects” on page 53.

Before you use Interactive Assignment, you must first make sure that specific 
parameters exist in your Siebel client configuration (.cfg) file. These parameters 
specify the location of the Siebel Server where the Siebel Territory Assignment 
Manager is running, and are automatically created during installation of the Siebel 
client.
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Table 18 shows the configuration file parameters used to configure the Siebel client 
for Interactive Assignment.

The following example shows how to use these parameters:

GatewayAddress = <name of siebel gateway machine>
EnterpriseServer = <name of enterprise>
RequestComponent = SRMSynch
RequestServer = <name of siebel server machine>

NOTE: If Resonate is in use with your deployment, you do not need the 
RequestServer parameter as Resonate determines which Siebel Server to contact 
based on load balancing metrics. 

For more information about the Siebel client installation process and configuration 
file, see Siebel Web Client Administration Guide, MidMarket Edition and the Siebel 
server installation guide for the operating system you are using.

Table 18. Parameters for Interactive Assignment Configuration 

Parameter Name Description

GatewayAddress Address of the Siebel Name Server for the Siebel Server1

1. GatewayAddress and GatewayConnString are the same parameters and can be used 
interchangeably in the configuration file. The default configuration file uses the 
GatewayAddress parameter.

EnterpriseServer Enterprise name of the Siebel Server

RequestComponent Name of the server component that services interactive assignment 
requests

RequestServer Name of the Siebel Server
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After the configuration parameters are set, Interactive Assignment requires the 
following server components to be:

■ Online

■ Assignment Manager

■ Running

■ Server Request Broker

To run Interactive Assignment for service requests

1 From the application-level menu, choose View > Site Map > Service 
Requests > All Service Requests.

2 In the Service Requests list, select an open Service Request for assignment.

3 In the More Info form, click the Menu button and select Assign to start 
Interactive Assignment.

4 Choose an assignee from the list of best candidates provided by Territory 
Assignment Manager.

The Siebel client:

■ Communicates with the Siebel Territory Assignment Manager on the Siebel 
Server and creates a list of qualified employees for the service request.

■ Sets the service request owner to the employee that you choose.
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Running Interactive Assignment Using the Command-Line 
SRVRMGR Utility

Alternatively, Interactive Assignment can be run from the command-line interface 
using the AsgnSrvr command and the parameters in Table 19. The command-line 
interface of the Server Manager is the srvrmgr program. For full information on 
using the command-line interface, see Siebel Server Administration Guide, 
MidMarket Edition. 

Table 19. Interactive Assignment Command-Line Interface Parameters

Parameter Name Display Name Description Default Value

AllowDupPostn Allow Duplicate 
Position

Allows assignment of duplicate 
positions to the team

For more information, see 
“AllowDupPostn” on page 152.

FALSE

AsgnKey Assignment Key Rule set used for key-based 
routing

Note: Not used in the Siebel 
MidMarket product.

AsgnMode Assignment Mode Mode of assignment MatchAssign

AsgnObjName Assignment Object 
Name

Name of the assignment object

BatchSize Batch Size Number of objects to assign 
before committing for interactive 
assignment

100

EventDate Event Date Date of the event that caused this 
assignment request

IgnoreCache Ignore assignment 
rule cache

Ignore assignment rule cache 
and read from the database

FALSE

LogTxnChgOnly Log txn only on 
change

Log transaction only when the 
assignment has changed

TRUE
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ObjWhereClause Object Where 
Clause

WHERE clause of the object for 
Interactive Assignment

For more information, see 
“ObjWhereClause” on page 152.

UseForUpdate Use FOR UPDATE Use FOR UPDATE to lock 
primary table row

TRUE

Table 19. Interactive Assignment Command-Line Interface Parameters

Parameter Name Display Name Description Default Value
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Use Dynamic Assignment to reassign people when changes are made to the 
assignment objects (such as Account and Service Request). As other users and 
server programs make changes to the assignment object records, Dynamic 
Assignment automatically assigns the objects to the appropriate people and 
organizations.

This section explains how to run Territory Assignment Manager in dynamic mode. 
The processes described are:

■ “Generating Triggers” on page 133

■ “Running Workflow Monitor Agents” on page 136

■ “Activating Assignment Policies” on page 139

■ “Territory Assignment Manager Performance in Dynamic Mode” on page 144

To run Dynamic Assignment, the following server components need to be:

■ Enabled:

■ Generate Triggers

■ Running:

■ Workflow Monitor Agent

■ Set and activated:

■ Assignment Policies

NOTE: For performance reasons, do not run Dynamic Assignment when running 
Batch Assignment. 
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You must run Generate Triggers to create triggers that monitor changes in the 
database.

NOTE: To regenerate triggers, you need to run Generate Triggers once to remove 
existing triggers, and a second time to recreate new triggers.

The triggers created by the Generate Triggers server component detect changes in 
the Siebel database and trigger the Workflow Monitor Agent to alert the Assignment 
Server. However, triggers generated for Territory Assignment Manager can reference 
other database columns not associated with assignment rules. It is important to 
make sure that triggers are generated only for an assignment policy’s criteria. Large 
data loads can experience performance issues otherwise.

To check and edit triggers

1 Use Siebel Tools, or view the trigger.sql file (/Siebel Root/Siebsrvr/trigger.sql), 
to examine the appropriate table columns.

For more information, see Siebel Tools Reference, MidMarket Edition.

2 Disable the inappropriate columns by inactivating the assignment attribute 
column.

For detailed information, see “Disabling an Assignment Attribute” on page 82.

3 Drop and regenerate new triggers (see the following section, “Generating 
Triggers”).

4 Recheck the trigger.sql file, to confirm that the trigger is no longer active. 

NOTE: When Dynamic Assignment is running, some users may receive the following 
error when attempting to modify a record: “The selected record has been 
modified by another user since it was received. Please continue.” 
This may occur because Territory Assignment Manager updated the record by 
assigning it while the user was trying to edit it. In this situation, the user’s changes 
may be lost. The solution is to refresh the query and reenter the user’s changes. 
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Generating Triggers
To run Dynamic Assignment, you need to run the Generate Triggers server 
component after:

■ Creating or changing an Assignment Object, Assignment Attribute, or 
Assignment Criteria object type in Siebel Tools

■ Changing assignment policies

■ Installing or upgrading the Siebel Server

NOTE: When amending an assignment rule, criteria, or value, or when making 
changes to assignment positions in dynamic mode, you do not have to drop and 
then regenerate database triggers.

Use the Generate Triggers server component to generate the database triggers used 
by Workflow Manager to detect changes in the database. For more information 
about starting and using Generate Triggers, see Siebel Business Process Designer 
Administration Guide, MidMarket Edition.

NOTE: You cannot create custom triggers on the Siebel database. The only supported 
triggers allowed on the Siebel database are those generated during installation or 
from running the Generate Triggers server component. 

To run Generate Triggers

1 From the application-level menu, choose View > Site Map > Server 
Components Requests > My Component Requests.

2 In the Component Requests list, click New.

A new record appears with a system-defined ID automatically generated with a 
status of Creating.
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3 In the My Components Requests form, enter the relevant information for the 
new component request record.

a In the Components/Job field, click the select button.

b In the Components/Job dialog box, query for Generate Triggers, and then 
click OK.

c In the Server field, type the name of the Siebel Server for which you want to 
run Generate Triggers.

d In the Request Key field, type in the name of the request key.

e Complete the rest of the fields, if needed.

4 In the Component Request Parameters list, click New to create a new record for 
the Table Owner Password, and enter the relevant parameter information.

a In the Name field, click the select button.

b In the Job Parameters dialog box, query for TableOwnPass, and then click 
OK.

c In the Value field, type in the password for your tableowner.

NOTE: If you are using a Microsoft SQL Server database, you need to set the Table 
Owner Password value to the user password with tableowner privileges. Also 
make sure that the Table Owner value is set to dbo.
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5 For the Microsoft SQL Server database, run the generated trigger.sql file against 
the database independently.

a Select EXEC.

b Click in the Value field.

c Type FALSE.

NOTE: If the EXEC parameter is set to TRUE, the Generate Trigger component 
automatically creates the SQL script and applies it to the server database.

Also, if you are creating a large number of triggers because there are too 
many workflow policies, the triggers should be applied by the user and not 
by the Generate Triggers server process. The EXEC parameter should be set 
to FALSE in this case.

For more information on the EXEC parameter, see Siebel Business Process 
Designer Administration Guide, MidMarket Edition.

6 In the My Component Requests form, click the Menu button, and then click 
Submit request.

Alternatively, this task can be run using the GenTrig command-line interface 
command. See Siebel Server Administration Guide, MidMarket Edition for detailed 
information on this procedure. Table 20 shows the available parameters used with 
GenTrig at the command-line interface.

Table 20. GenTrig Command-Line Interface Parameters

Parameter Name Display Name Description Default Value

EXEC EXEC Install Triggers to DB directly FALSE

Mode Mode Assignment Server and/or Workflow 
mode (ASGN, WORK, or ALL)

ALL

Remove Remove Remove all Triggers Mode FALSE

TAMode TAMode All Territory or Contact Only mode ALL

TrigFile Trigger File Name Output trigger script file name trigger.sql
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Running Workflow Monitor Agents
To run Dynamic Assignment, the Workflow Monitor Agent needs to be running. 
This server component monitors the S_ESCL_REQ table. Database triggers, when 
fired because of object changes, create records in the S_ESCL_REQ table. The 
Workflow Monitor Agent reads these new records and processes requests for 
Territory Assignment Manager policies. Affected objects are then dynamically 
assigned. For more information about Workflow Monitor Agent, see Siebel Business 
Process Designer Administration Guide, MidMarket Edition. 

To start Workflow Monitor Agent from the command-line interface

1 Determine the workflow group that you want Workflow Monitor Agent to 
monitor. 

a From the application-level menu, choose View > Site Map > Assignment 
Administration > Assignment Policies. 

b In the Group field in the Assignment Policy list, choose the workflow group 
(the default group is Assignment Group).

2 Start the srvmgr program. 

For detailed information on this process, see Siebel Server Administration Guide, 
MidMarket Edition. After the program starts, the prompt changes to:

srvmgr: server_name>

3 At the prompt, enter the following information to start the Workflow Monitor 
Agent server component task; use the Group information gathered from Step 1 
(Assignment Group used in this example):

start task for component workmon with GroupName=”Assignment 
Group”
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4 Configure other component parameters, if needed.

For more information about other configurable parameters, see Table 21 on 
page 138.

NOTE: Separate the parameters and their values in the command-line statement 
with commas.

5 Alternatively, you can configure a Workflow Monitor Agent to start 
automatically to process assignment requests whenever the Siebel Server starts. 

For detailed information, see Siebel Server Administration Guide, MidMarket 
Edition.

This command starts a new task running in the background and returns to the 
Server Manager immediately. For detailed information on starting, stopping, and 
monitoring server tasks, see Siebel Server Administration Guide, MidMarket Edition. 
For further information about the Workflow Monitor Agent, see Siebel Business 
Process Designer Administration Guide, MidMarket Edition.

NOTE: It is possible to set up multiple Workflow Monitor Agents for Dynamic 
Assignment. For more information, see the “Monitoring and Performance Tuning” 
section of Siebel Business Process Designer Administration Guide, MidMarket 
Edition.
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Table 21 shows the Workflow Monitor Agent command-line interface parameters.

Table 21. WorkMon Command-Line Interface Parameters

Parameter Name Display Name Description Default Value

ActionAgent Use Action Agent Use Action Agent FALSE

ActionInterval Action Interval Do not re-execute actions 
within specified interval in 
minutes

3600

BatchMode Processes the batch 
policies

Process the batch Policies FALSE

CheckLogCacheSz Cache size of Policy 
violations

Number of policy violations 
to store in cache

100

DeleteSize Request delete size Request delete size 500

GenReqRetry Number of seconds 
to retry

Number of seconds to retry 
sending a Generic Request 
message

120

GroupName Group Name Group Name

IgnoreError Ignore errors Ignore errors while 
processing requests

FALSE

KeepLogDays Number of days to 
keep violation 
information

Number of days worth of 
violation information that 
should be retained

30

LastUsrCacheSz Cache size of last 
user information

Number of last user 
information items to cache

100

MailServer Mail Server Name of email server to send 
notification of abnormal 
termination

MailTo Mailing Address Mail address to review 
notification of abnormal 
termination

ReloadPolicy Reload Policy Reload Policy Interval in 
seconds

86400

Requests Requests per 
iteration

Requests per iteration 5000
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Activating Assignment Policies
Siebel applications include predefined assignment policies for each of the 
predefined assignment objects. You should use these predefined assignment 
policies. However, you can create new assignment policies for Dynamic 
Assignments.

Each Workflow Monitor Agent can monitor one or more assignment policies. You 
can use a single Workflow Monitor Agent to monitor all assignment policies by 
placing all assignment policies in the same workflow group (the predefined 
assignment policies are defined this way). You can also place the assignment 
policies in separate workflow groups and dedicate Workflow Monitor Agents for 
each workflow group.

Assignment Policies should be associated only with the Assignment Request (In 
Process) assignment action. 

CAUTION: Assign a workflow policy group to only one Workflow Monitor Agent. 
Multiple Workflow Monitor Agents running the same workflow policy group cause 
unpredictable completion times and possible multiple actions created for one 
trigger. For more information, see Siebel Business Process Designer Administration 
Guide, MidMarket Edition.

Also, you should not associate customized workflow actions with assignment 
policies. For more information about workflow actions, see Siebel Business Process 
Designer Administration Guide, MidMarket Edition. 

To enable Dynamic Assignment for an assignment object, activate the assignment 
policy for that object. To disable Dynamic Assignment for an assignment object, 
deactivate the assignment policy for that object.

The rest of this section explains how to activate, deactivate, set the workflow group 
for, and create actions for assignment policies. The procedures are:

■ “To set the workflow group for assignment policies” on page 140

■ “To activate an assignment policy” on page 140

■ “To deactivate an assignment policy” on page 141

■ “To create an action for an assignment policy” on page 141
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To set the workflow group for assignment policies

1 From the application-level menu, choose View > Site Map > Assignment 
Administration > Assignment Policies.

2 In the Assignment Policies list, select the assignment policy for which you want 
to set the workflow group.

3 In the Group field, click the select button.

4 In the Workflow Groups dialog box, select a workflow group (the default is 
Assignment Group), and then click OK. 

Figure 27 shows an example of successfully setting Assignment Group to the 
Account object assignment policy.

To activate an assignment policy

1 From the application-level menu, choose View > Site Map > Assignment 
Administration > Assignment Policies.

2 In the Assignment Policies list, select the assignment policy you want to activate.

3 In the Expiration Date/Time field, click to either null the existing value or set the 
value to a later date.

Workflow components process only active assignment policies that have not 
expired. Figure 28 on page 142 shows an example of activating the Account object 
assignment policy.

Figure 27. Example of Setting a Workflow Group for an Assignment Policy
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To deactivate an assignment policy

1 From the application-level menu, choose View > Site Map > Assignment 
Administration > Assignment Policies.

2 In the Assignment Policies list, select the assignment policy you want to 
deactivate.

3 In the Expiration Date/Time field, set the value to a date that has already passed.

Workflow components process only active assignment policies that have not 
expired; therefore, you can deactivate an assignment policy by expiring it. 

To create an action for an assignment policy

1 From the application-level menu, choose View > Site Map > Assignment 
Administration > Assignment Policies.

2 In the Assignment Policies list, select the assignment policy for which you want 
to create an action.

3 In the Actions list, click New.

4 In the new record, enter values for the relevant information.

a In the Assignment Action field, click the drop-down arrow and select 
Assignment Request (In Process).

b In the Assignment Mode field, click the down-arrow button and select 
MatchAssign.

NOTE: By default, every assignment policy has an action. You need to follow the 
preceding steps only if you accidentally remove an action or create a new 
assignment policy. 
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Figure 28 shows an example of successfully creating an action for the Account 
object assignment policy.

Activating Contact Denormalization
Perform the following procedure to activate contact denormalization. The policy is 
inactivated by default.

NOTE: When Territory Assignment Manager runs in Contact Denormalization mode, 
it does not evaluate assignment rules. Therefore, you do not need to select the 
Contact Denormalization object for the assignment rule to run Territory Assignment 
Manager in Contact Denormalization mode. 

To activate contact denormalization

1 From the application-level menu, choose View > Site Map > Assignment 
Administration > Assignment Policies.

2 In the Assignment Policies list, select Contact Denormalization, and then 
perform the following:

a In the Group field, click the select button.

b In the Workflow Groups dialog box, select a workflow group (the default is 
Assignment Group), and then click OK.

c In the Expiration Date/Time field, either clear the existing value or set the 
value to a later date.

Figure 28. Example of Creating an Action for an Assignment Policy
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3 In the Actions list, click New to create a new record and enter the relevant 
information.

a In the Assignment Action field, click the drop-down arrow and select 
Assignment Request (In Process).

b In the Assignment Mode field, click the down-arrow button and select 
Denorm.

Figure 29 shows an example of successfully enabling Contact Denormalization for 
Dynamic Assignment.

Figure 29. Enabling Contact Denormalization for Dynamic Assignment
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Territory Assignment Manager Performance in Dynamic Mode
If users experience slow response time while running Territory Assignment Manager 
in dynamic mode, you can implement one or more of the following to improve 
Dynamic Assignment performance:

■ Increase the Requests (Requests per iteration) workflow monitor parameter (the 
default is set to 5,000).

■ Decrease the DeleteSize workflow monitor parameter (the default is set to 500).

■ Decrease the SleepTime workflow monitor parameter (the default is 60 
seconds).

■ Increase the ReloadPolicy workflow monitor parameter to a much larger 
number, for example, 86,400 seconds (the default is 600 seconds).

■ Distribute each assignment policy into its individual group and then invoke 
several Workflow Monitor Agents concurrently (one on each Siebel Server, if 
available).
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Running Territory Assignment Manager in Mobile Mode
This section includes procedures to run Territory Assignment Manager in mobile 
mode. Use Mobile Assignment to reassign people based on changes uploaded by 
mobile clients. Territory Assignment Manager assigns objects after a mobile client 
synchronizes with the Siebel Server and uploads assignment requests or any 
changes to objects and assignment rules. Depending on the configuration of 
Generate Triggers, the Workflow Monitor detects these changes and activates 
Territory Assignment Manager to dynamically reassign affected objects. For more 
information, see “Mobile Assignment” on page 23.

NOTE: If a disconnected client sends an assignment request to the Siebel Server 
while running Mobile Assignment, the request is sent as an asynchronous request. 
Because of this, the request does not override the Keep Manual Assign flag.

To run Mobile Assignment

1 Be sure that you have run the Generate Triggers server component. 

For instructions, see “Generating Triggers” on page 133.

2 Start the Workflow Monitor Agent. 

For instructions, see “Running Workflow Monitor Agents” on page 136.

3 Start the Server Request Broker server component (if running Interactive 
Assignment). 

For instructions, see Siebel Server Administration Guide, MidMarket Edition.
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Running Territory Assignment Manager in Batch Mode
This section explains how to run Territory Assignment Manager in batch mode. Use 
Batch Assignment to assign an assignment object in a single batch. You must run 
Territory Assignment Manager in batch mode if you change non-object data that can 
affect assignments. This happens whenever you:

■ Modify assignment rules and want these changes to affect existing objects. You 
modify assignment rules when you:

■ Add or remove employees, positions, or organizations

■ Add, remove, or update assignment criteria or criteria values

■ Change activation and expiration dates

■ Change exclusive mode

■ Modify the list of employees, positions, or organizations (or all) and you want 
these changes to affect existing objects. You modify the list of employees, 
positions, or organizations when you add new employees, positions, or 
organizations (if you use assignment rules with the All People setting).

■ Change the Territory Assignment Manager configuration in Siebel Tools and you 
want your changes to affect existing objects. You change the Territory 
Assignment Manager configuration when you:

■ Change Assignment Attribute definitions

■ Change Assignment Criteria definitions

■ Change Assignment Object definitions

■ Change Workflow Policy Object definitions
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■ Use EIM (Enterprise Integration Manager) to perform initial loads (if you do not 
run Generate Triggers to create the appropriate triggers).

NOTE: When using EIM to load assignment rules, make sure the column 
ASGN_TYPE_CD includes a value. If it is left NULL, which is permissible in EIM, 
the rules are loaded but Territory Assignment Manager fails. 

■ Feel that existing assignments may not be accurate. Territory Assignment 
Manager does not change assignments if the existing assignments are correct.

NOTE: When batch mode is run on correct assignments, although there are no 
changes to the team or primary, an update of the record occurs. This situation 
can disturb other workflow policies relying on various record fields. For 
example, a workflow policy relying on PR_POSTN_ID field to trigger an action 
does not work properly if this field is updated from a new batch assignment. If 
your deployment uses SQL Server, this note does not apply. 

If you run both Batch Assignment and Dynamic Assignment in your environment, 
the Batch Assignment can activate Dynamic Assignment due to triggers created in 
the database required to run Dynamic Assignment. Before running Batch 
Assignment, you should deactivate all assignment policies and drop related triggers 
to prevent Dynamic Assignment from processing modified rules, objects, and 
candidates. For more information, see “To deactivate an assignment policy” on 
page 141 and “To run Generate Triggers” on page 133. After completing Batch 
Assignment, you can activate the assignment policies and re-enable Dynamic 
Assignment. For more information on batch assignment, see “Batch Assignment” 
on page 23. For more information, see “To activate an assignment policy” on 
page 140.

NOTE: For performance reasons, do not run Batch Assignment while running 
Dynamic Assignment.
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To run Batch Assignment 

1 From the application-level menu, choose View > Site Map > Server Component 
Requests > My Component Requests.

2 In the My Component Requests form, click New.

A new record appears with a system-defined ID automatically populated with a 
status of Creating.

3 In the new record, enter the relevant information for the new component 
request.

a In the Components/Job field, click the select button.

b In the Components/Jobs dialog box, query for Batch Assignment, and then 
click GO.

c In the Server field, type the name of the server on which you want to run this 
batch request.

d Complete the rest of the fields for the new record, if needed.

4 In the Component Request Parameters list, click New to create a new record, and 
enter relevant information for the assignment object that you want to assign as 
part of this batch request.

a In Name field, click the select button.

b In the Job Parameters dialog box, select Assignment Object Name, and then 
click OK.

c In the Value field, enter the name of the assignment object for the parameter.

Use the exact name found in Siebel Tools, such as Service Request or 
Order (Sales Credit Assignment).

NOTE: Because Batch Assignment cannot run more than one assignment object 
per batch, you should run Batch Assignment on only one assignment object for 
each batch.
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5 While still in the Component Request Parameters list, click New to create a new 
record so that Territory Assignment Manager uses the Object WHERE clause to 
limit the number of rows processed at one time.

a In Name field, click the select button.

b In the Job Parameters dialog box, query for ObjWhereClause, click Go, and 
then click OK.

c In the Value field, enter a WHERE clause to select the object instance that 
you want to process; the WHERE clause can include up to 100 characters.

For example, to select object instances beginning with ibm, type:

WHERE name like ‘ibm%’ 

NOTE: If you leave the value field blank, all object instances are selected. 
However, it is strongly recommended that you limit the number of rows that 
Territory Assignment Manager processes to make sure that sufficient rollback 
space is available.

For more information about using the Object WHERE clause, see Table 22 on 
page 151 and further description following table.

6 Optionally, if you want to enable Contact Denormalization for Batch 
Assignment, add two more component request parameter records with the 
following values:

Parameter Name Value

Assignment Object Name Contact Denormalization

Assignment Mode Denorm
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7 Optionally, if you want to save changes to the database during batch processing, 
add another component request parameter as follows:

a In Name field, click the select button.

b In the Job Parameters dialog box, query for Batch Size, and then click Go.

c In the Value field, enter the number of objects to assign before committing 
each batch.

8 In the My Component Requests form, click the menu button and choose Submit 
request.

CAUTION: Batch Assignment updates the ASGN_DT and timestamp fields for all rows 
in the batch, but not just those reassigned or those rows that had a net change in 
their assignment. Conflicts can occur with other workflow policies that access these 
fields. 
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Running Batch Assignment Using the Command-Line SRVRMGR Utility
Alternatively, Batch Assignment can be run from the command-line interface using 
the AsgnBatch command and the parameters in Table 22. The command-line 
interface of the Server Manager is the srvrmgr program. For full information on 
using the command-line interface, see Siebel Server Administration Guide, 
MidMarket Edition.

Table 22. Batch Assignment Command-Line Interface Parameters

Parameter Name Display Name Description Default Value

AllowDupPostn Allow Duplicate 
Position

Allows duplicate positions.

For more information, see 
“AllowDupPostn” on page 152.

FALSE

AsgnKey Assignment Key Used to specify a particular rule 
group for a batch assignment 
task.

Note: Not used in the Siebel 
MidMarket product.

AsgnMode Assignment Mode Mode of assignment MatchAssign

AsgnObjName Assignment Object 
Name

Name of the assignment object

BatchSize Batch Size Number of objects to assign 
before committing for Batch 
Assignment

100

EventDate Event Date Date of the event that caused 
this assignment request

IgnoreCache Ignore Assignment 
Rule Cache

Ignore assignment rule cache 
and read from the database

FALSE

LogTxnChgOnly Log txn only on 
change

Log transaction only when the 
assignment has changed

TRUE

ObjWhereClause Object Where 
Clause

WHERE clause of the object for 
Batch Assignment

For more information, see 
“ObjWhereClause” on page 152.

UseForUpdate Use FOR UPDATE Use FOR UPDATE to lock 
primary table row

TRUE
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Additional Parameter Characteristics
The following bulleted points provide additional information about some of the 
parameters shown in Table 22 on page 151.

AllowDupPostn
When this parameter is set to TRUE (set to FALSE by default), Territory Assignment 
Manager attempts to insert duplicate positions (positions with the same id) in the 
team table, given these positions do not violate the user key constraints of the table. 
The third field of the PositionTeamDenorm (Y, N value) user property specifies 
which destination columns are part of the user key. Territory Assignment Manager 
checks whether or not positions with the same Id that pass violate the uniqueness 
of these key columns. If Territory Assignment Manager detects a violation, only the 
first position encountered is inserted and the other position is ignored. Otherwise, 
Territory Assignment Manager inserts both positions in the team table.

If Territory Assignment Manager detects a violation, only the first position 
encountered is inserted and the other is ignored.

ObjWhereClause
Standard SQL WHERE statements are used for the Object WHERE Clause and can 
include up to 2048 characters when a batch assignment server task is started using 
the command-line interface. However, when you start a batch assignment server 
task from the Component Requests screen, you can only specify up to 100 
characters. Also, when using wildcards in the object WHERE clause, make sure you 
use the correct wildcard specific to your database.

The Object WHERE Clause can be used to restrict which records are retrieved and 
processed in Batch Assignment. The following conditions apply:

■ Joins are allowed in the Object WHERE Clause. 

An example of a join is as follows:

Assignment Object = Account

Object Where Clause = where pr_postn_id in (select row_id from 
s_postn where name = 'Sales Rep') 
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■ The Object WHERE Clause assumes the base table is coming from the 
assignment object specified. 

For example, if you start Batch Assignment specifying the assignment object as 
Account and the Object Where Clause is where row_id = '1-232', then Batch 
Assignment attempts to assign only the row_id = '1-232' from the 
S_ORG_EXT table.

The following is an example of a batch assignment using the command-line 
interface:

start task for component AsgnBatch with AsgnObjName= “Account”, 
AsgnMode=“MatchAssign”, ObjWhereClause=“where name like 'B%'”

This command batch assigns accounts starting with B. Optionally, you can use 
the command-line interface and the Object WHERE Clause to run only a select 
number of assignment rule groups. The following is an example of this:

start task for comp asgnbatch with asgnobjname="Account", 
objwhereclause="where name like 'B%'", asgnkey="12-4DR56"

In this example, 12-4DR56 is the Row Id of an assignment rule group, and only 
those rules belonging to this group are evaluated when this parameter is passed 
in the request.

NOTE: When using the command-line interface, use double quotation marks for 
the ObjWhereClause parameter; otherwise, it is treated as a SRVRMGR 
command option that changes the case.
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Territory Assignment Manager Performance in Batch Mode
If users experience slow response time while running Territory Assignment Manager 
in batch mode, review the settings on virus software installed on the applicable 
server. Implement one or more of the following settings to improve batch 
assignment performance.

■ Virus scan only program files.

■ Exclude all outbound files from virus scanning.

■ Exclude the RDBMS directory where all msb files are located from virus 
scanning.

Make sure to run a full virus scan on all files during the weekend or off-peak time 
if the preceding settings were used.

You can also implement one or more of the following to boost batch performance 
in batch mode:

■ Increase the BatchSize parameter, for example, set the batch size to 500 (the 
default is set to 100).

This increases the number of records that are processed within a transaction 
before a commit occurs, resulting in less resources used and faster assignment.

NOTE: Only set large batch sizes when there are no or very few users on the 
system.

■ Create multiple instances of Batch Assignment (using WHERE clause 
statements). See “Running Multiple Instances of Territory Assignment Manager 
in Batch Mode” on page 156.

■ Select a good filter.

This reduces the time it takes to retrieve Object records.

NOTE: Use indexed field or fields for comparison in the object WHERE clause, 
such as Name for Account and Opportunity, or Last Name for Contacts.
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■ Use better logic.

For example, if you want to run Account Assignment based on account name, 
you can create multiple batches so that the first batch starts with names 
beginning with the letter C through K, the second batch starts with the letter L 
through R, and so on. 

Consider the following logic:

Object Where Clause: WHERE NAME > ‘B’ AND NAME < ‘L’

Although this causes the database to retrieve account records with names 
starting with the letter C through K, the WHERE clause is specified in such a 
manner that if accounts starting with the letter M through Z are encountered, 
they are passed on the first round because the values are > B. They are then 
eliminated in the second round (< ‘L’) by the database. These records are not 
needed in the batch because there is a cap of account names less than L.

It is better logic to use:

Object Where Clause: WHERE NAME < ‘L’ AND NAME >‘B’

By switching the order of the conditions, the extra parsing required by the 
database in the second round is eliminated because most of the names start with 
a letter greater than B.
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Running Multiple Instances of Territory Assignment Manager in Batch 
Mode

When there are many objects that need to be assigned, you can run multiple 
instances of Territory Assignment Manager in Batch Mode to improve performance. 
First, develop a strategy for specifying multiple batches using the Object Where 
Clause parameter in the Batch Assignment component. Then, start multiple 
instances of Batch Assignment specifying the appropriate Object Where Clause for 
each instance.

For example, you can run one instance of Batch Assignment for accounts that 
changed today and a different instance of Batch Assignment for accounts that 
changed yesterday. Use the Object Where Clause parameter to specify the following:

■ For the batch that processes accounts changed today: 

Object Where Clause: WHERE LAST_UPD = SYSDATE

■ For the batch that processes accounts changed yesterday:

Object Where Clause: WHERE LAST_UPD = SYSDATE - 1

NOTE: The ASGN_PROC_ID column in the S_ORG_EXT table is no longer used. If 
you have updated this column to run multiple batches of Batch Assignment in 
previous versions, note that as of version 6.0 you can no longer do so.
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Territory Assignment Manager allows the creation of very advanced assignment 
configurations. This chapter is intended for users familiar with the preceding 
chapters and who require further information on refining their Territory Assignment 
Manager deployment.

Before beginning any of the following procedures, review background knowledge in 
the Siebel software architecture, Siebel Tools, and Siebel Workflow Manager. 
Consult the following documentation for this information: Siebel Tools Reference, 
MidMarket Edition and Siebel Business Process Designer Administration Guide, 
MidMarket Edition.

For further information or assistance on any of these procedures, contact Siebel 
Technical Support.
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Creating Assignment Rules to Assign Two Objects
In some cases, you may want to create an assignment rule that assigns candidates 
to two objects while using only one object’s criteria. This section uses a specific 
scenario as an example in which you create an assignment rule to use only an 
Opportunity criteria to assign candidates to both the Opportunity and Account 
objects. This rule can be used to assign candidates to opportunities and their 
associated accounts.

To create assignment rules that assign two objects using only one object criteria, 
you need to create and map workflow policy components using Siebel Tools.

To define an assignment rule for two objects using one assignment criteria

1 Create an assignment rule and specify the assignment objects that are assigned 
using this rule.

For this example, create an assignment rule (that is, a “territory”) called 
Account/Opportunity and add the Account and Opportunity objects to this rule. 
For more information about creating assignment rules, see “Creating Territory 
Assignment Rules” on page 100. 

2 Create an assignment criteria that applies to only one of the assignment objects 
in this assignment rule.

For this example, configure the Lead Quality Code assignment criteria (an 
Opportunity object criteria). For more information on creating assignment 
criteria, see “Creating Assignment Criteria” on page 104.

3 After the assignment rule is defined, create a workflow policy component that 
maps to both objects.

For information on creating a workflow policy component, see “Phase 1: 
Creating a Workflow Policy Component for Both Objects” on page 85.
158 Siebel Territory Assignment Manager Administration Guide MidMarket Edition Version 7.5



Advanced Configuration

Creating Assignment Rules to Assign Two Objects
4 Map the workflow policy component you created with the column.

For information on mapping a workflow policy column, see “Phase 2: Mapping 
a Column to the Workflow Policy Component” on page 88.

5 Map the workflow policy component you created to the assignment attribute.

For information on mapping a workflow policy component to assignment 
attributes, see “Phase 3: Mapping the Workflow Policy Component to the 
Assignment Attribute” on page 90.

Figure 30 shows an example of defining an assignment rule for the Account and 
Opportunity objects using only the Lead Quality Code assignment criteria.

Figure 30. Example of Defining an Assignment Rule for Two Objects Using One 
Assignment Criteria
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Assigning Objects Based on the Primary Address
An assignment rule with address criteria, by default, passes objects (Account, 
Contact, and Opportunities, for example) based on any one of the multiple 
addresses associated with the objects. However, Territory Assignment Manager is 
configurable to assign based on only the primary address. This configuration is 
completed through Siebel Tools in the following procedure. The Account 
assignment object is used in this example.

To assign objects based on the primary address

1 Start Siebel Tools.

2 Select the assignment object.

a In the Object Explorer, expand Workflow Policy Object.

b In the Workflow Policy Objects list, select Account.

3 Select the workflow policy component to change the Source Column and Target 
Column fields.

a In the Object Explorer, select Workflow Policy Component.

b In the Workflow Policy Component window, select Account Address.

c Change Source Column Name to ROW_ID (from OU_ID).

d Change Target Column Name to PR_ADDR_ID (from ROW_ID).

4 Repeat Step 2 and Step 3 for the Contact and Opportunity assignment objects.

5 Check in the projects to the server.

For more information about checking in projects, see Siebel Tools Reference, 
MidMarket Edition.

6 Drop and regenerate triggers by running the Generate Triggers server component 
(if using dynamic assignment or workflow policies).

See “Generating Triggers” on page 133 for more information on stopping and 
restarting this server component. Alternatively, see Siebel Server Administration 
Guide, MidMarket Edition.
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Assigning Children Accounts Based on Parent’s 
Primary Address

A common business requirement involves the configuration of Territory Assignment 
Manager to assign children accounts based on the primary account’s address. This 
configuration is completed through Siebel Tools using the following procedure.

To assign child Account objects based on the parent’s primary address

1 In the Object Explorer, select the Workflow Policy object and click the Account 
record; expand the Workflow Policy object in the Object Explorer and select the 
Workflow Policy Components object.

2 Create two new workflow policy components, Parent Account and Parent 
Account Address, with the following properties:

3 While the new Parent Account Address record is selected, expand the Workflow 
Policy Component object and click the Workflow Policy Component Column 
object; create a new record with the following properties:

Name: Parent Account Parent Account Address

Source Table Name: S_ORG_EXT S_ADDR_ORG

Source Column Name: ROW_ID ROW_ID

Target Component Name: Account Parent Account

Target Column Name: PAR_OU_ID PR_ADDR_ID

Name: State

Alias Parent Account State
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4 In the Object Explorer, select the Assignment Attributes object and create a new 
record with the following properties:

5 While the new assignment attribute Parent Account State is selected, expand the 
Assignment Attributes object and click the Assignment Attributes Column 
object; create a new record with the following properties:

6 In the Object Explorer, select the Assignment Criteria object and create a new 
record with the following properties:

Name: Parent Account State

Data Type: Varchar

Pick List: PickList State

Pick Field: Value

Name Account: Parent Account State

Assignment Object Account

Workflow Object: Account

Workflow Component: Parent Account Address

Workflow Component Column: Parent Account State

Sequence: 1

Name: Parent Account State

Display Name Parent Account State

Use Expertise FALSE
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7 While the new assignment criteria Parent Account State is selected, expand the 
Assignment Criteria object and click the Assignment Criteria Attribute object; 
create a new record with the following properties:

After the configurations are complete, the project must be checked into the server, 
and various server administration procedures must be run. To update your 
deployment with these new configurations, see “Server Administration After 
Configuration” on page 93.

For more information on compiling projects, see Siebel Tools Reference, MidMarket 
Edition. For information on distributing the siebel.srf file, see Siebel Anywhere 
Administration Guide, MidMarket Edition.

An assignment rule can now be created that assigns child accounts based on the 
parent’s primary address.

NOTE: Make sure the child account has a value in the PAR_OU_ID column pointing 
to a parent account that has the primary address.

Name: Parent Account State

Assignment Attribute: Parent Account State

Store Column: 1

Display Sequence: 1

Display Name: State
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Reassigning Accounts to a Different Primary Position
To reassign Account assignment objects to another position, use the following 
procedure. This procedure provides an example of mapping the PR_POSTN_ID 
column of the Account’s base table (S_ORG_EXT) to a new assignment attribute 
named Account Primary Position. Configuration in Siebel Tools is required for this 
process.

NOTE: The following procedure can be employed anytime you want to use a base 
table column as an assignment attribute.

To reassign accounts to a different position

1 Start Siebel Tools (see Siebel Tools Reference, MidMarket Edition for more 
information on proper Siebel Tools configuration procedures).

2 In the Object Explorer, select the Workflow Column object and create a new 
record with the following properties:

■ Name: Account Primary Position Id

■ Table: S_ORG_EXT

■ Column: PR_POSTN_ID

3 Select Workflow Policy Object > Account > Workflow Policy Component > 
Account record; drill down to the Workflow Policy Component Column and add 
a new record called Account Primary Position Id.

4 In the Object Explorer, select Assignment Attribute and create a new record 
called Account Primary Position; drill down to Assignment Attribute Column 
and add a new record with the following properties:

■ Name: Account: Account Primary Position Id

■ Assignment Object: Account

■ Workflow Policy Object: Account

■ Workflow Component: Account

■ Workflow Policy Component Column: Account Primary Position Id
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5 In the Object Explorer, select Assignment Criteria and create a new record called 
Account Primary Position; drill down to the Assignment Criteria Attribute and 
create a new record called Account Primary Position Id with the following 
properties:

■ Name: Account Primary Position Id

■ Assignment Attribute: Account Primary Position Id

■ Store Column: 1

■ Display Sequence: 1

■ Display Name: Id

6 Check in the project to the server, compile changes to the siebel.srf file, and 
distribute it to your users.

a Choose Tools > Compile.

b In the Object Compiler dialog box, select the Assignment project.

c Select the Siebel client repository file (default is siebel.srf file) located in the 
Objects subdirectory within the Siebel client root directory.

d Click Compile.

7 In the updated Client, create a new assignment rule based on the assignment 
object Account; add a new criterion for this rule, and select the Account Primary 
Position; under the values applet, select the ROW_ID of the position you want 
to reassign.

8 Navigate to the Positions view of this new Assignment Rule; select the new 
position that is to replace the previous position.

9 Release assignment rules by clicking Release in the Territory List view.
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Routing of Assignments to Mobile Users
The component parameter LogTxnChgOnly controls whether transactions with no 
change to Assignment primary or team members are routed to mobile or remote 
users. This parameter has a default setting of TRUE for Batch Assignment, 
Interactive Assignment (Territory Assignment Manager), and implicitly Dynamic 
Assignment (Workflow Monitor Agent). As a result, transactions with no change to 
Assignment primary or teams are not routed to mobile users. To change the 
LogTxnChgOnly parameter for dynamic assignment, use the following steps. This 
procedure requires configuration in Siebel Tools.

To change the LogTxnChgOnly parameter

1 Stop the Workflow Monitor Agent processing the assignment policies.

2 Start Siebel Tools (see Siebel Tools Reference, MidMarket Edition for more 
information on proper Siebel Tools configuration procedures).

3 In the Object Explorer, select the Workflow Policy Program and select 
Assignment Request (In Process).

4 Drill down to Workflow Policy Program Arguments in the Object Explorer and 
select the LogTxnChgOnly parameter.

5 Change the value to TRUE or FALSE.

6 Check in the project to the server.

7 Restart the Workflow Monitor Agent. 

NOTE: You do not need to recompile the .srf file.
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Maintaining the Manually Assigned Primary Position
Territory Assignment Manager maintains an assignment object’s manually assigned 
primary position only when PR_REP_MANL_FLG=Y. By default, this value is set to 
N.

For example, when an assignment opportunity object is created in the Siebel UI, the 
creator is added to the opportunity object’s team as the primary. For this position 
to be recognized as the manually assigned primary by Territory Assignment 
Manager, an employee with Data Administration rights must set this property in the 
appropriate administrative screen. This action changes PR_REP_MANL_FLG to Y so 
Territory Assignment Manager does not reset the primary when run.

To maintain the object’s primary position

1 Start your Siebel application. 

2 Access the Data Administration screen (check your responsibility if this screen 
is not visible).

3 Navigate to the Opportunity (or other assignment object) screen.

4 Locate and select the assignment object of interest.

5 Click the Sales Team select button to launch the Sales Team window.

6 Click the Primary check box of another position in the list; then reselect the 
Primary check box of the original position.

This process changes the system PR_REP_MANL_FLG value to Y and updates 
PR_REP_SYS_FLG to N. 

This procedure can also be used to add positions to the object or delete system-
assigned positions from the object. 
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Stopping Assignment of the Default Organization
If you want to override the assignment of all organizations to an assignment object, 
you must remove the assignment property Org Primary Column from a selected 
assignment object. The default value is set to BU_ID. After this value is set to null, 
Territory Assignment Manager does not assign any organization to the assignment 
object. The following procedure details this configuration. The account assignment 
object is used as an example.

To stop assignment of the default organization to Account object

1 Start Siebel Tools and select the appropriate project.

2 In the Object Explorer, expand Workflow Policy Object.

3 Select Assignment Object.

4 Select the Account Record.

5 In the Properties Window, find the property called Org Primary Column.

6 Delete the value for this property. (The default value is BU_ID.)

After the assignment object is modified, various server administration procedures 
must be run to make sure your configurations are recognized by Territory 
Assignment Manager.

■ If you are using Batch Assignment, start a new task.

■ If you are using Dynamic Assignment, stop and restart the Workflow Monitor 
Agent. 

■ If you are using Interactive Assignment, stop and restart the Assignment 
Manager Server Component.

NOTE: It is not necessary to recompile the .srf file when configuring an assignment 
object to stop assignment of the default organization. 
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Stopping Assignment of Organizations for Accounts
If you do not want Territory Assignment Manager to reassign the organizations that 
you have setup for an account, you must change the default values for the Account 
assignment object properties in Siebel Tools. 

To stop reassignment of organizations for accounts

1 Start Siebel Tools.

2 In the Object Explorer, expand Workflow Policy Object.

3 In the Workflow Policy Object list, select Account.

4 In the Object Explorer, click Assignment Object.

5 In the Assignment Objects list, set the following values:

■ Default Organization = <blank> 

■ Org Primary Column = <blank>

■ Org Table = <blank>

■ Set Primary Org = FALSE

NOTE: Where <blank> is a null value.

After these values are set, Territory Assignment Manager does not reassign any 
organizations for accounts.

6 Run various server administration tasks.

For instructions, see Step 2 and Step 3 of the “To update your deployment with 
new configurations” on page 94 procedure.

NOTE: It is not necessary to recompile the .srf file. However, you should check-in 
the changes to the server database.
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Siebel Territory Assignment Manager uses definitions in the Siebel repository to 
assign objects to assignment rules and candidates. The predefined definitions 
include mappings for the most commonly used attributes for each object. Each 
assignment object uses its own set of run-time parameters that control the behavior 
of Territory Assignment Manager for that assignment object. These run-time 
parameters are stored in the Siebel repository in the assignment object definitions. 
This appendix includes usage comments and tables for the assignment object 
run-time parameters and their default values.

To configure assignment objects, you need to modify their run-time parameters 
using Siebel Tools. For procedures on how to configure assignment objects, see 
“Configuring Assignment Objects” on page 53.
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Assignment Object Parameter Usage
Table 23 shows the usage comments for the assignment object run-time parameters.

NOTE: The run-time parameter name is shown as it appears in the Siebel Tools 
Assignment Objects list applet. The property name is shown as it is appears in the 
Siebel Tools Properties window. In this table, the property name for a parameter is 
shown only if the property name differs from the run-time parameter name.

Table 23. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments

Assignment Mode Determines whether or not Territory 
Assignment Manager performs filtering 
based on organizations or people. Valid 
values are: Independent, Org & Person-
oriented, Organization-oriented, and Person-
oriented.

Assignment Scoring 
Mode

If this parameter is set to Person-based (the 
default), the assignment rule score is set to 
the score of the highest-scoring employee or 
position for the rule. If this parameter is set 
to Organization-based, the assignment rule 
score is set to the score of the highest-
scoring organization for the rule.

Note: Not used in the Siebel MidMarket 
product.

Auto Reassign When this parameter is checked—parameter 
equals TRUE—Territory Assignment 
Manager automatically reassigns objects if 
assignment attribute values change. The 
Generate Triggers server task looks for this 
flag when it generates triggers for the active 
assignment policy. If the parameter is 
unchecked—parameter equals FALSE—no 
trigger is created for the update; the 
assignment occurs once when the record is 
inserted. The default value is TRUE.
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Calendar Activity 
Additional Fields

A string that provides extra information for 
use when creating an activity through 
availability-based assignment. This string 
follows a format of “parent field”, “field 1", 
“value1”, “field 2", “value2”.

Note: Not used in the Siebel MidMarket 
product.

Calendar Create 
Activity

When this parameter is checked—parameter 
equals TRUE—Assignment Manager creates 
an activity in the employee calendar of every 
final assignee, blocking off the time needed 
to finish the task. When this parameter is 
not checked—parameter equals FALSE—no 
activity is created in the employee calendar.

Note: Not used in the Siebel MidMarket 
product.

Calendar Duration 
Column

The table column that references the 
duration of the object. This column is 
required for availability-based assignment.

Note: Not used in the Siebel MidMarket 
product.

Calendar Early Start 
Time Column

The table column that references the early 
start time of the object. This column can be 
used for availability-based assignment but is 
optional.

Note: Not used in the Siebel MidMarket 
product.

Calendar Start Time 
Column

The table column of the assignment object 
that references the start time of the object. 
This column is required for availability 
based assignment

Note: Not used in the Siebel MidMarket 
product.

Default Employee Territory Assignment Manager assigns this 
employee when a conflict or a tie occurs and 
the appropriate employees cannot be 
assigned.

Table 23. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments
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Default 
Organization

Default Org Territory Assignment Manager assigns this 
organization when a conflict or a tie occurs 
and the appropriate organizations cannot be 
assigned.

Default Position Territory Assignment Manager assigns this 
position when a conflict or a tie occurs and 
the appropriate positions cannot be 
assigned.

When the Default Position property of an 
assignment object is set to null and that 
object does not qualify for any defined 
assignment rules, then Territory Assignment 
Manager does not set Primary position on 
the object.

Employee Column Name of the column in the employee 
intersection table that points to rows in the 
employee table (S_EMPLOYEE).

Employee Primary 
Column

Name of the column in the primary table 
that stores the primary employee (on a 
team) or single-owner employee.

Employee Primary 
Denorm Column

Name of the column in the primary table 
that specifies whether the primary employee 
is assigned by the denorm program.

Employee Primary 
Manual Column

Name of the column in the primary table 
that specifies whether the primary employee 
is manually assigned.

Employee Primary 
System Column

Name of the column in the primary table 
that specifies whether the primary employee 
is system assigned.

Employee Table Name of the employee intersection table. If 
the assignment object can be assigned to 
multiple employees, this intersection table 
stores the set of employee IDs that are 
assigned to assignment object IDs.

Table 23. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments
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Employee Team 
Copy Columns 

Employee Primary 
Column List

Comma-separated list of column names in 
the employee intersection table that should 
be copied when the primary employee 
changes. Territory Assignment Manager 
copies values from these columns from the 
old primary employee to the new primary 
employee.

Employee Team 
Denorm Column 

Employee Denorm 
Column

Name of the column in the employee 
intersection table that specifies whether the 
employee is assigned by the denorm 
program.

Employee Team 
Manual Column 

Employee Manual 
Column

Name of the column in the employee 
intersection table that specifies whether the 
employee is manually assigned.

Employee Team 
Score Column

Numeric column in assignment object team 
table that stores the score of the assigned 
employee.

Note: Not used in the Siebel MidMarket 
product.

Employee Team 
System Column 

Employee System 
Column

Name of the column in the employee 
intersection table that specifies whether the 
employee is system assigned.

Ignore Extra 
Attributes

Ignore Assignment 
Attributes

When this parameter is checked, Territory 
Assignment Manager ignores the 
assignment criteria that are not relevant to 
the assignment object being assigned. For 
example, if you have an assignment rule that 
uses Service Request Priority as an 
assignment criteria, Territory Assignment 
Manager ignores this assignment criteria 
when assigning opportunities and accounts 
because Service Request Priority is relevant 
only to service requests. When this 
parameter is unchecked, the assignment rule 
fails.

Table 23. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments
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Inactive When this parameter is checked—parameter 
equals TRUE—the object is no longer 
enabled (active). By default, this parameter 
is set to FALSE.

Keep Creator When this parameter is checked, Territory 
Assignment Manager never deletes the 
object creator from the team.

Keep Man Asgn 
Primary Org

For teams only. When this parameter is 
checked, Territory Assignment Manager 
does not set the primary organization if the 
user explicitly sets the primary organization; 
Territory Assignment Manager actually 
checks the Primary Organization manual 
flag in the object’s primary table. 

By default, this manual flag is unchecked 
when the object is first created.

Keep Manual 
Assigned

Keep User Assigned For teams only. When this parameter is 
checked, Territory Assignment Manager 
keeps manually assigned assignees and 
assignment rules.

Keep Manual 
Primary Employee

Keep Man Asgn 
Primary Employee

When this parameter is checked, Territory 
Assignment Manager does not set the 
primary employee if the user explicitly sets 
the primary employee; Territory Assignment 
Manager actually checks the Primary 
Employee manual flag in the object’s 
primary table.

By default, this manual flag is unchecked 
when the object is first created.

Table 23. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments
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Keep Manual 
Primary Position

Keep Man Asgn 
Primary Position

When this parameter is checked, Territory 
Assignment Manager does not set the 
primary position if the user explicitly sets 
the primary position; Territory Assignment 
Manager actually checks the Primary 
Position manual flag in the object’s primary 
table. 

By default, this manual flag is unchecked 
when the object is first created.

For more information about setting the 
primary position, see the run-time 
parameter “Set Primary Position” on 
page 182.

Keep Manual 
Primary Rule

Keep Man Asgn 
Primary Group

For teams only. When this parameter is 
checked, Territory Assignment Manager 
does not set the primary rule if the user 
explicitly sets the primary rule; Territory 
Assignment Manager actually checks the 
Primary Assignment Rule manual flag in the 
object’s primary table. 

By default, this manual flag is unchecked 
when the object is first created.

Lock Assignment 
Column

Exclude Column When this parameter is set to a column 
name, the object is not assigned or 
reassigned if the column value is TRUE. If 
you want Territory Assignment Manager to 
assign or reassign the object, set this 
parameter to null, or set the column value to 
FALSE. This column is not a property of the 
assignment object itself, but a property of 
the business component associated with the 
assignment object.

Organization Table Org Table Name of the organization intersection table. 
If the assignment object can be assigned to 
multiple organizations, this intersection 
table stores the set of organization IDs that 
are assigned to assignment object IDs.

Table 23. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments
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Org Column Name of the column in the organization 
intersection table that points to rows in the 
organization table (S_ORG_INT).

Org Denorm 
Column

Name of the column in the organization 
intersection table that specifies whether the 
organization is assigned by the denorm 
program.

Org Manual Column Name of the column in the organization 
intersection table that specifies whether the 
organization is manually assigned.

Org Primary Column Name of the column in the primary table 
that stores the primary organization (on a 
team) or single-owner organization. To 
prevent organization assignment for an 
object, set this property to null.

Org Primary Column 
List

Comma-separated list of column names in 
the organization intersection table that 
should be copied when the primary 
organization changes. Territory Assignment 
Manager copies values from these columns 
from the old primary organization to the 
new primary organization.

Org Primary 
Denorm Column

Name of the column in the primary table 
that specifies whether the primary 
organization is assigned by the denorm 
program.

Org Primary Manual 
Column

Name of the column in the primary table 
that specifies whether the primary 
organization is manually assigned.

Org Primary System 
Column

Name of the column in the primary table 
that specifies whether the primary 
organization is system assigned.

Org System Column Name of the column in the organization 
intersection table that specifies whether the 
organization is system assigned.

Table 23. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments
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Org Team Score 
Column

Numeric column in assignment object team 
table that stores the score of the assigned 
organization.

Note: Not used in the Siebel MidMarket 
product. 

Position Column Name of the column in the position 
intersection table that points to rows in the 
position table (S_POSTN). 

Position Primary 
Column

Name of the column in the primary table 
that stores the primary position (for teams) 
or single-owner position.

Position Primary 
Denorm Column

Name of the column in the primary table 
that specifies whether the primary position 
is assigned by the denorm program.

Position Primary 
Manual Column

Name of the column in the primary table 
that specifies whether the primary position 
is manually assigned.

Position Primary 
System Column

Name of the column in the primary table 
that specifies whether the primary position 
is system assigned.

Position Table Name of the position intersection table. If 
the assignment object can be assigned to 
multiple positions, this intersection table 
stores the set of position IDs that are 
assigned to assignment object IDs.

Position Team Copy 
Columns 

Position Primary 
Column List

Comma-separated list of column names in 
the position intersection table that should be 
copied when the primary position changes. 
Territory Assignment Manager copies values 
from these columns from the old primary 
position to the new primary position.

Position Team 
Denorm Column 

Position Denorm 
Column

Name of the column in the position 
intersection table that specifies whether the 
position is assigned by the denorm program.

Table 23. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments
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Position Team 
Manual Column 

Position Manual 
Column 

Name of the column in the position 
intersection table that specifies whether the 
position is manually assigned.

Position Team Score 
Column

Numeric column in assignment object team 
table that stores the score of the assigned 
position.

Note: Not used in the Siebel MidMarket 
product. 

Position Team 
System Column 

Position System 
Column

Name of the column in the position 
intersection table that specifies whether the 
position is system assigned.

Primary Table Base table of the assignment object.

Replace Team 
Members

Add Team Members When this parameter is checked, Territory 
Assignment Manager deletes existing 
candidates from the teams and deletes 
existing assignment rules in the assignment 
rule intersection table that do not qualify.

When this parameter is unchecked, Territory 
Assignment Manager never deletes existing 
candidates or assignment rules from the 
object, even if they do not qualify.

Rule Column Group Column Name of a row ID column in the rule 
intersection table that points to the 
Assignment Rule table (S_ASGN_RULE). 
This column serves as a foreign key to the 
Assignment Rule table, uniquely identifying 
a rule for each assignment entity-rule 
association.

Rule Primary 
Column 

Group Primary 
Column

Name of the column in the primary table 
that stores the primary or single-owner rule.

Rule Primary 
Denorm Column 

Group Primary 
Denorm Column

Name of the column in the primary table 
that specifies whether the primary rule is 
assigned by the denorm program.

Table 23. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments
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Rule Primary 
Manual Column 

Group Primary 
Manual Column

Name of the column in the primary table 
that specifies whether the primary rule is 
manually assigned.

Rule Primary System 
Column 

Group Primary 
System Column

Name of the column in the primary table 
that specifies whether the primary rule is 
system assigned.

Rule Table Group Table Name of the rule intersection table.

Rule Team Copy 
Columns 

Group Primary 
Column List

Comma-separated list of column names in 
the rule intersection table that should be 
copied when the primary rule changes. 
Territory Assignment Manager copies values 
from these columns from the old primary 
rule to the new primary rule.

Rule Team Denorm 
Column 

Group Denorm 
Column

Name of the column in the rule intersection 
table that specifies whether the rule is 
assigned by the denorm program.

Rule Team Manual 
Column 

Group Manual 
Column

Name of the column in the rule intersection 
table that specifies whether the rule is 
manually assigned. 

Rule Team System 
Column 

Group System 
Column

Name of the column in the rule intersection 
table that specifies whether the rule is 
system assigned.

Set Primary 
Employee

For teams only. When this parameter is set 
to TRUE, Territory Assignment Manager is 
enabled for setting a primary employee. You 
select the primary employee for an 
assignment rule in the Assignment Rules 
view.

Set Primary Org For teams only. When this parameter is set 
to TRUE, Territory Assignment Manager is 
enabled for setting a primary organization. 
You select the primary organization for an 
assignment rule in the Assignment Rules 
view.

Table 23. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments
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Assignment Object Parameter Usage
Set Primary Position For teams only. When this parameter is set 
to TRUE, Territory Assignment Manager is 
enabled for setting a primary position. You 
select the primary position for an 
assignment rule in the Assignment Rules 
view.

NOTE: If the property for the assignment 
object is Set Primary Position = False, then 
the existing primary is not modified by 
Territory Assignment Manager; the primary 
remains the same. If the property for the 
assignment object is Set Primary Position = 
True, then the existing primary is modified 
by Territory Assignment Manager. This is 
irrespective of the value present in the Keep 
Man Asgn Primary Position property.

Set Primary Rule Set Primary Group When this parameter is set to TRUE, 
Territory Assignment Manager is enabled for 
setting a primary rule. You select the primary 
rule for an assignment rule in the 
Assignment Rules view.

Skill Item Table Name of the skill item table.

Note: Not used in the Siebel MidMarket 
product.

Skill Table Name of the skill table.

Note: Not used in the Siebel MidMarket 
product.

Table 23. Usage Comments of Run-Time Parameters

Run-Time Parameter Properties Name Usage Comments
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Run-Time Parameter Default Values
Run-Time Parameter Default Values
This section includes tables that list the run-time parameters and their default 
values for the following predefined assignment objects. For a procedure that 
explains how to view these objects and values, see “To view values for an 
assignment object” on page 184.

■ Account (see Table 24 on page 185)

■ Activity (see Table 25 on page 190)

■ Campaign (see Table 26 on page 194)

■ Campaign Contact (see Table 27 on page 199)

■ Contact (see Table 28 on page 203)

■ Contact Denormalization (see Table 29 on page 208)

■ Employee (see Table 30 on page 212)

■ Opportunity (see Table 31 on page 216)

■ Order (Sales Credit Assignment) (see Table 32 on page 220)

■ Organization (see Table 33 on page 225)

■ Position (see Table 34 on page 229)

■ Product Defect (see Table 35 on page 234)

■ Product Denormalization (see Table 36 on page 238)

■ Project (see Table 37 on page 242)

■ Project Team (see Table 38 on page 246)

■ Service Request (see Table 39 on page 251)
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Run-Time Parameter Default Values
To view values for an assignment object

1 Start Siebel Tools.

2 In the Workflow Policy Objects window, select the assignment object.

NOTE: Objects are listed alphabetically by parent name of the assignment object.

3 In the Object Explorer, expand Workflow Policy Object, and then select 
Assignment Object.

The values for the assignment object appear in the Assignment Objects list 
applet as well as the Properties window.
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Run-Time Parameter Default Values
Account Object Parameters
Table 24 shows the run-time parameters and their default values for the Account 
assignment object. For descriptions and usage comments of some of these run-time 
parameters, see Table 23 on page 172.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 24. Account Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

TRUE

Assignment Mode

Assignment Scoring Mode Person-based

Note: Not used in the Siebel MidMarket 
product.

Auto Reassign TRUE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee SADMIN

Default Org 
(Default Organization)

Default Organization 
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Run-Time Parameter Default Values
Default Position Siebel Administrator

Employee Column

Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column

Employee Primary Column List 
(Employee Team Copy Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column Not used in the Siebel MidMarket product 

Exclude Column 
(Lock Assignment Column)

ASGN_USR_EXCLD_FLG

Group Column 
(Rule Column)

TERR_ID

Group Denorm Column 
(Rule Team Denorm Column)

ASGN_DNRM_FLG

Group Manual Column 
(Rule Team Manual Column)

ASGN_MANL_FLG

Group Primary Column 
(Rule Primary Column)

PR_TERR_ID

Group Primary Column List 
(Rule Team Copy Columns)

Table 24. Account Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Group Primary Denorm Column 
(Rule Primary Denorm Column)

Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

ASGN_SYS_FLG

Group Table 
(Rule Table)

S_ORG_TERR

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator TRUE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

TRUE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column BU_ID

Org Denorm Column

Org Manual Column

Org Primary Column BU_ID

Org Primary Column List

Table 24. Account Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Org Primary Denorm Column

Org Primary Manual Column

Org Primary System Column

Org System Column

Org Table 
(Organization Table)

S_ORG_BU

Org Team Score Column Not used in the Siebel MidMarket product 

Parent Name Account

Position Column POSITION_ID

Position Denorm Column 
(Position Team Denorm Column)

ASGN_DNRM_FLG

Position Manual Column 
(Position Team Manual Column)

ASGN_MANL_FLG

Position Primary Column PR_POSTN_ID

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column PR_REP_DNRM_FLG

Position Primary Manual Column PR_REP_MANL_FLG

Position Primary System Column PR_REP_SYS_FLG

Position System Column 
(Position Team System Column)

ASGN_SYS_FLG

Position Table S_ACCNT_POSTN

Position Team Score Column Not used in the Siebel MidMarket product 

Primary Table S_ORG_EXT

Set Primary Employee FALSE

Table 24. Account Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Set Primary Group 
(Set Primary Rule)

TRUE

Set Primary Org TRUE

Set Primary Position TRUE

Skill Item Table S_ORG_SKILL_IT

Note: Not used in the Siebel MidMarket 
product.

Skill Table S_ORG_SKILL

Note: Not used in the Siebel MidMarket 
product.

Table 24. Account Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Activity Object Parameters
Table 25 shows the run-time parameters and their default values for the Activity 
assignment object. For descriptions and usage comments on some of these run-time 
parameters, see Table 23 on page 172.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

The Lock Assignment parameter for Activity objects is, by default, set to TRUE. This 
setting does not allow Territory Assignment Manager to assign these objects. The 
Field Service Activity object is the one exception and is, by default, available for 
assignment (Lock Assignment parameter set to FALSE). Other activities must have 
the Lock Assignment parameter set to FALSE or null for assignment to occur. 

Table 25. Activity Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

FALSE

Assignment Mode

Assignment Scoring Mode Not used in the Siebel MidMarket product

Auto Reassign TRUE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column APPT_DURATION_MIN

Calendar Early Start Time Column

Calendar Start Time Column APPT_START_DT

Comments

Default Employee SADMIN
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Run-Time Parameter Default Values
Default Org 
(Default Organization)

Default Position Siebel Administrator

Employee Column EMP_ID

Employee Denorm Column 
(Employee Team Denorm Column)

ASGN_DNRM_FLG

Employee Manual Column 
(Employee Team Manual Column)

ASGN_MANL_FLG

Employee Primary Column OWNER_PER_ID

Employee Primary Column List 
(Employee Team Copy Columns)

Employee Primary Denorm Column ASGN_DNRM_FLG

Employee Primary Manual Column ASGN_MANL_FLG

Employee Primary System Column ASGN_SYS_FLG

Employee System Column 
(Employee Team System Column)

ASGN_SYS_FLG

Employee Table S_ACT_EMP

Employee Team Score Column Not used in the Siebel MidMarket product 

Exclude Column 
(Lock Assignment Column)

ASGN_USR_EXCLD_FLG

Group Column 
(Rule Column)

Group Denorm Column 
(Rule Team Denorm Column)

Group Manual Column 
(Rule Team Manual Column)

Group Primary Column 
(Rule Primary Column)

Table 25. Activity Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

ASGN_SYS_FLG

Group Table 
(Rule Table)

S_ORG_TERR

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive TRUE

Keep Creator FALSE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

FALSE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

FALSE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column

Table 25. Activity Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Org Primary System Column

Org System Column

Org Table 
(Organization Table)

Org Team Score Column Not used in the Siebel MidMarket product 

Parent Name Activity

Position Column

Position Denorm Column 
(Position Team Denorm Column)

Position Manual Column 
(Position Team Manual Column)

Position Primary Column

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column

Position Primary Manual Column

Position Primary System Column

Position System Column 
(Position Team System Column)

Position Table

Position Team Score Column Not used in the Siebel MidMarket product 

Primary Table S_EVT_ACT

Set Primary Employee TRUE

Table 25. Activity Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Campaign Object Parameters
Table 26 shows the run-time parameters and their default values for the Campaign 
assignment object. For descriptions and usage comments on some of these run-time 
parameters, see Table 23 on page 172.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Set Primary Group 
(Set Primary Rule)

FALSE

Set Primary Org FALSE

Set Primary Position FALSE

Skill Item Table S_ACT_SKILL_IT

Note: Not used in the Siebel MidMarket 
product.

Skill Table S_ACT_SKILL

Note: Not used in the Siebel MidMarket 
product.

Table 25. Activity Object Run-Time Parameters

Run-Time Parameter Default Value

Table 26. Campaign Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

TRUE

Assignment Mode

Assignment Scoring Mode Not used in the Siebel MidMarket product
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Run-Time Parameter Default Values
Auto Reassign TRUE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee SADMIN

Default Org 
(Default Organization)

Default Position Siebel Administrator

Employee Column

Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column

Employee Primary Column List 
(Employee Team Copy Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column Not used in the Siebel MidMarket product 

Table 26. Campaign Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Exclude Column 
(Lock Assignment Column)

ASGN_USR_EXCLD_FLG

Group Column 
(Rule Column)

TERR_ID

Group Denorm Column 
(Rule Team Denorm Column)

ASGN_DNRM_FLG

Group Manual Column 
(Rule Team Manual Column)

ASGN_MANL_FLG

Group Primary Column 
(Rule Primary Column)

PR_TERR_ID

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

ASGN_SYS_FLG

Group Table 
(Rule Table)

S_SRC_TERR

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator TRUE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Table 26. Campaign Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

TRUE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Org Primary System Column

Org System Column

Org Table 
(Organization Table)

Org Team Score Column Not used in the Siebel MidMarket product 

Parent Name Campaign

Position Column POSITION_ID

Position Denorm Column 
(Position Team Denorm Column)

ASGN_DNRM_FLG

Position Manual Column 
(Position Team Manual Column)

ASGN_MANL_FLG

Position Primary Column PR_POSTN_ID

Position Primary Column List 
(Position Team Copy Columns)

Table 26. Campaign Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Position Primary Denorm Column PR_REP_DNRM_FLG

Position Primary Manual Column PR_REP_MANL_FLG

Position Primary System Column PR_REP_SYS_FLG

Position System Column 
(Position Team System Column)

ASGN_SYS_FLG

Position Table S_SRC_POSTN

Position Team Score Column Not used in the Siebel MidMarket product 

Primary Table S_SRC

Set Primary Employee FALSE

Set Primary Group 
(Set Primary Rule)

TRUE

Set Primary Org FALSE

Set Primary Position TRUE

Skill Item Table S_CAMP_SKILL_IT

Note: Not used in the Siebel MidMarket 
product.

Skill Table S_CAMP_SKILL

Note: Not used in the Siebel MidMarket 
product.

Table 26. Campaign Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Campaign Contact Object Parameters
Table 27 shows the run-time parameters and their default values for the Contact 
assignment object. For descriptions and usage comments on some of these run-time 
parameters, see Table 23 on page 172.

NOTE: The parent name for the Campaign Contact assignment object is Campaign 
Contact Owner (not Campaign Contact). 

The run-time parameters are presented in the order they appear in the Siebel Tools 
Properties window. If the corresponding parameter name that appears in the Siebel 
Tools Assignment Objects list applet differs from the name shown in the Properties 
window, it is shown parenthetically. Parameters in the table that do not include a 
default value have a default value of null.

Table 27. Campaign Contact 

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

TRUE

Assignment Mode Organization-oriented

Assignment Scoring Mode Person-based

Note: Not used in the Siebel MidMarket 
product.

Auto Reassign FALSE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee
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Run-Time Parameter Default Values
Default Org 
(Default Organization)

Default Organization

Default Position Siebel Administrator

Employee Column

Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column

Employee Primary Column List 
(Employee Team Copy Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column Not used in the Siebel MidMarket product 

Exclude Column 
(Lock Assignment Column)

ASGN_USR_EXCLD_FLG

Group Column 
(Rule Column)

Group Denorm Column 
(Rule Team Denorm Column)

Group Manual Column 
(Rule Team Manual Column)

Group Primary Column 
(Rule Primary Column)

Table 27. Campaign Contact 

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

Group Table 
(Rule Table)

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator FALSE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

FALSE

Keep User Assigned 
(Keep Manual Assigned)

FALSE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column BU_ID

Table 27. Campaign Contact 

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Org Primary System Column

Org System Column

Org Table 
(Organization Table)

Org Team Score Column Not used in the Siebel MidMarket product 

Parent Name Campaign Contact Owner

Position Column

Position Denorm Column 
(Position Team Denorm Column)

Position Manual Column 
(Position Team Manual Column)

Position Primary Column POSTN_ID

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column PR_REP_DNRM_FLG

Position Primary Manual Column PR_REP_MANL_FLG

Position Primary System Column PR_REP_SYS_FLG

Position System Column 
(Position Team System Column)

ASGN_SYS_FLG

Position Table

Position Team Score Column Not used in the Siebel MidMarket product 

Primary Table S_CAMP_CON

Set Primary Employee FALSE

Table 27. Campaign Contact 

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Contact Object Parameters
Table 28 shows the run-time parameters and their default values for the Contact 
assignment object. For descriptions and usage comments on some of these run-time 
parameters, see Table 23 on page 172.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Set Primary Group 
(Set Primary Rule)

FALSE

Set Primary Org FALSE

Set Primary Position FALSE

Skill Item Table Not used in the Siebel MidMarket product

Skill Table Not used in the Siebel MidMarket product

Table 27. Campaign Contact 

Run-Time Parameter Default Value

Table 28. Contact Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

TRUE

Assignment Mode

Assignment Scoring Mode Person-based

Note: Not used in the Siebel MidMarket 
product.

Auto Reassign TRUE
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Run-Time Parameter Default Values
Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee SADMIN

Default Org 
(Default Organization)

Default Organization

Default Position Siebel Administrator

Employee Column

Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column

Employee Primary Column List 
(Employee Team Copy Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column Not used in the Siebel MidMarket product 

Table 28. Contact Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Exclude Column 
(Lock Assignment Column)

ASGN_USR_EXCLD_FLG

Group Column 
(Rule Column)

TERR_ID

Group Denorm Column 
(Rule Team Denorm Column)

ASGN_DNRM_FLG

Group Manual Column 
(Rule Team Manual Column)

ASGN_MANL_FLG

Group Primary Column 
(Rule Primary Column)

PR_TERR_ID

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

ASGN_SYS_FLG

Group Table 
(Rule Table)

S_CON_TERR

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator TRUE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Table 28. Contact Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

TRUE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column BU_ID

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Org Primary System Column

Org System Column

Org Table 
(Organization Table)

Org Team Score Column Not used in the Siebel MidMarket product 

Parent Name Contact

Position Column POSTN_ID

Position Denorm Column 
(Position Team Denorm Column)

ASGN_DNRM_FLG

Position Manual Column 
(Position Team Manual Column)

ASGN_MANL_FLG

Position Primary Column PR_POSTN_ID

Position Primary Column List 
(Position Team Copy Columns)

Table 28. Contact Object Run-Time Parameters

Run-Time Parameter Default Value
206 Siebel Territory Assignment Manager Administration Guide MidMarket Edition Version 7.5



Assignment Object Parameters

Run-Time Parameter Default Values
Position Primary Denorm Column PR_REP_DNRM_FLG

Position Primary Manual Column PR_REP_MANL_FLG

Position Primary System Column PR_REP_SYS_FLG

Position System Column 
(Position Team System Column)

ASGN_SYS_FLG

Position Table S_POSTN_CON

Position Team Score Column Not used in the Siebel MidMarket product 

Primary Table S_CONTACT

Set Primary Employee FALSE

Set Primary Group 
(Set Primary Rule)

TRUE

Set Primary Org TRUE

Set Primary Position TRUE

Skill Item Table S_CON_SKILL_IT

Note: Not used in the Siebel MidMarket 
product.

Skill Table S_CON_SKILL

Note: Not used in the Siebel MidMarket 
product.

Table 28. Contact Object Run-Time Parameters

Run-Time Parameter Default Value
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Run-Time Parameter Default Values
Contact Denormalization Object Parameters
Table 29 shows the run-time parameters and their default values for the Contact 
Denormalization assignment object. For descriptions and usage comments on some 
of these run-time parameters, see Table 23 on page 172.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 29. Contact Denormalization Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

TRUE

Assignment Mode

Assignment Scoring Mode Not used in the Siebel MidMarket product

Auto Reassign TRUE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee

Default Org 
(Default Organization)

Default Position

Employee Column
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Run-Time Parameter Default Values
Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column

Employee Primary Column List 
(Employee Team Copy Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column Not used in the Siebel MidMarket product 

Exclude Column 
(Lock Assignment Column)

ASGN_USR_EXCLD_FLG

Group Column 
(Rule Column)

Group Denorm Column 
(Rule Team Denorm Column)

Group Manual Column 
(Rule Team Manual Column)

Group Primary Column 
(Rule Primary Column)

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Group Primary Manual Column 
(Rule Primary Manual Column)

Table 29. Contact Denormalization Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

Group Table 
(Rule Table)

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator TRUE

Keep Man Asgn Primary Employee 
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

TRUE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Org Primary System Column

Org System Column

Table 29. Contact Denormalization Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Org Table 
(Organization Table)

Org Team Score Column Not used in the Siebel MidMarket product 

Parent Name Contact Denormalization

Position Column POSTN_ID

Position Denorm Column 
(Position Team Denorm Column)

ASGN_DNRM_FLG

Position Manual Column 
(Position Team Manual Column)

ASGN_MANL_FLG

Position Primary Column PR_POSTN_ID

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column PR_REP_DNRM_FLG

Position Primary Manual Column PR_REP_MANL_FLG

Position Primary System Column PR_REP_SYS_FLG

Position System Column 
(Position Team System Column)

ASGN_SYS_FLG

Position Table S_POSTN_CON

Position Team Score Column Not used in the Siebel MidMarket product 

Primary Table S_CONTACT

Set Primary Employee FALSE

Set Primary Group 
(Set Primary Rule)

FALSE

Set Primary Org FALSE

Set Primary Position FALSE

Skill Item Table Not used in the Siebel MidMarket product

Skill Table Not used in the Siebel MidMarket product

Table 29. Contact Denormalization Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Employee Object Parameters
Table 30 shows the run-time parameters and their default values for the Employee 
assignment object. For descriptions and usage comments on some of these run-time 
parameters, see Table 23 on page 172.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 30. Employee Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

FALSE

Assignment Mode

Assignment Scoring Mode Not used in the Siebel MidMarket product

Auto Reassign FALSE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee SADMIN

Default Org 
(Default Organization)

Default Position SADMIN

Employee Column

Employee Denorm Column 
(Employee Team Denorm Column)
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Assignment Object Parameters

Run-Time Parameter Default Values
Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column

Employee Primary Column List 
(Employee Team Copy Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column Not used in the Siebel MidMarket product 

Exclude Column 
(Lock Assignment Column)

Group Column 
(Rule Column)

Group Denorm Column 
(Rule Team Denorm Column)

Group Manual Column 
(Rule Team Manual Column)

Group Primary Column 
(Rule Primary Column)

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Table 30. Employee Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Group System Column 
(Rule Team System Column)

Group Table 
(Rule Table)

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator FALSE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

TRUE

Keep User Assigned 
(Keep Manual Assigned)

FALSE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Org Primary System Column

Org System Column

Org Table 
(Organization Table)

Table 30. Employee Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Org Team Score Column Not used in the Siebel MidMarket product 

Parent Name Employee

Position Column

Position Denorm Column 
(Position Team Denorm Column)

Position Manual Column 
(Position Team Manual Column)

Position Primary Column

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column

Position Primary Manual Column

Position Primary System Column

Position System Column 
(Position Team System Column)

Position Table

Position Team Score Column Not used in the Siebel MidMarket product 

Primary Table S_USER

Set Primary Employee FALSE

Set Primary Group 
(Set Primary Rule)

FALSE

Set Primary Org FALSE

Set Primary Position FALSE

Skill Item Table S_EMP_SKILL_IT

Note: Not used in the Siebel MidMarket 
product

Skill Table S_EMP_SKILL

Note: Not used in the Siebel MidMarket 
product

Table 30. Employee Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Opportunity Object Parameters
Table 31 shows the run-time parameters and their default values for the Opportunity 
assignment object. For descriptions and usage comments on some of these run-time 
parameters, see Table 23 on page 172.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 31. Opportunity Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

TRUE

Assignment Mode

Assignment Scoring Mode Person-based

Note: Not used in the Siebel MidMarket 
product.

Auto Reassign TRUE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee SADMIN

Default Org 
(Default Organization)

Default Organization
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Assignment Object Parameters

Run-Time Parameter Default Values
Default Position Siebel Administrator

Employee Column

Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column

Employee Primary Column List 
(Employee Team Copy Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column Not used in the Siebel MidMarket product 

Exclude Column 
(Lock Assignment Column)

ASGN_USR_EXCLD_FLG

Group Column 
(Rule Column)

TERR_ID

Group Denorm Column 
(Rule Team Denorm Column)

ASGN_DNRM_FLG

Group Manual Column 
(Rule Team Manual Column)

ASGN_MANL_FLG

Group Primary Column 
(Rule Primary Column)

PR_TERR_ID

Group Primary Column List 
(Rule Team Copy Columns)

Table 31. Opportunity Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Group Primary Denorm Column 
(Rule Primary Denorm Column)

Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

ASGN_SYS_FLG

Group Table 
(Rule Table)

S_OPTY_TERR

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator TRUE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

FALSE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org TRUE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

TRUE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column BU_ID

Org Denorm Column

Org Manual Column

Org Primary Column BU_ID

Org Primary Column List

Table 31. Opportunity Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Org Primary Denorm Column PR_BU_DNRM_FLG

Org Primary Manual Column PR_BU_MANL_FLG

Org Primary System Column PR_BU_SYS_FLG

Org System Column

Org Table 
(Organization Table)

S_OPTY_BU

Org Team Score Column Not used in the Siebel MidMarket product 

Parent Name Opportunity

Position Column POSITION_ID

Position Denorm Column 
(Position Team Denorm Column)

ASGN_DNRM_FLG

Position Manual Column 
(Position Team Manual Column)

ASGN_MANL_FLG

Position Primary Column PR_POSTN_ID

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column PR_REP_DNRM_FLG

Position Primary Manual Column PR_REP_MANL_FLG

Position Primary System Column PR_REP_SYS_FLG

Position System Column 
(Position Team System Column)

ASGN_SYS_FLG

Position Table S_OPTY_POSTN

Position Team Score Column Not used in the Siebel MidMarket product 

Primary Table S_OPTY

Set Primary Employee FALSE

Table 31. Opportunity Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Order (Sales Credit Assignment) Object Parameters
Table 32 shows the run-time parameters and their default values for the Order 
assignment object. For descriptions and usage comments on some of these run-time 
parameters, see Table 23 on page 172. 

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Set Primary Group 
(Set Primary Rule)

TRUE

Set Primary Org TRUE

Set Primary Position TRUE

Skill Item Table S_OPTY_SKILL_IT

Note: Not used in the Siebel MidMarket 
product.

Skill Table S_OPTY_SKILL

Note: Not used in the Siebel MidMarket 
product.

Table 31. Opportunity Object Run-Time Parameters

Run-Time Parameter Default Value

Table 32. Order Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

FALSE

Assignment Mode

Assignment Scoring Mode Not used in the Siebel MidMarket product
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Assignment Object Parameters

Run-Time Parameter Default Values
Auto Reassign TRUE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee

Default Org 
(Default Organization)

Default Position

Employee Column

Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column

Employee Primary Column List 
(Employee Team Copy Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column Not used in the Siebel MidMarket product 

Table 32. Order Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Exclude Column 
(Lock Assignment Column)

Group Column 
(Rule Column)

ASGN_GRP_ID

Group Denorm Column 
(Rule Team Denorm Column)

ASGN_DNRM_FLG

Group Manual Column 
(Rule Team Manual Column)

ASGN_MANL_FLG

Group Primary Column 
(Rule Primary Column)

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

ASGN_SYS_FLG

Group Table 
(Rule Table)

S_ORDER_ASGNGRP

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator FALSE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

FALSE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

FALSE

Table 32. Order Object Run-Time Parameters

Run-Time Parameter Default Value
222 Siebel Territory Assignment Manager Administration Guide MidMarket Edition Version 7.5



Assignment Object Parameters

Run-Time Parameter Default Values
Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

FALSE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Org Primary System Column

Org System Column

Org Table 
(Organization Table)

Org Team Score Column Not used in the Siebel MidMarket product 

Parent Name Order

Position Column POSTN_ID

Position Denorm Column 
(Position Team Denorm Column)

ASGN_DNRM_FLG

Position Manual Column 
(Position Team Manual Column)

ASGN_MANL_FLG

Position Primary Column

Position Primary Column List 
(Position Team Copy Columns)

Table 32. Order Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Position Primary Denorm Column PR_REP_DNRM_FLG

Position Primary Manual Column PR_REP_MANL_FLG

Position Primary System Column PR_REP_SYS_FLG

Position System Column 
(Position Team System Column)

ASGN_SYS_FLG

Position Table S_ORD_CRDT_ASGN

Position Team Score Column Not used in the Siebel MidMarket product 

Primary Table S_ORDER

Set Primary Employee FALSE

Set Primary Group 
(Set Primary Rule)

FALSE

Set Primary Org FALSE

Set Primary Position FALSE

Skill Item Table Not used in the Siebel MidMarket product

Skill Table Not used in the Siebel MidMarket product

Table 32. Order Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Organization Object Parameters
Table 33 shows the run-time parameters and their default values for the 
Organization assignment object. For descriptions and usage comments on some of 
these run-time parameters, see Table 23 on page 172.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 33. Organization Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

TRUE

Assignment Mode

Assignment Scoring Mode Not used in the Siebel MidMarket product

Auto Reassign FALSE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee

Default Org 
(Default Organization)

Default Position

Employee Column
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Assignment Object Parameters

Run-Time Parameter Default Values
Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column

Employee Primary Column List 
(Employee Team Copy Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column Not used in the Siebel MidMarket product 

Exclude Column 
(Lock Assignment Column)

Group Column 
(Rule Column)

Group Denorm Column 
(Rule Team Denorm Column)

Group Manual Column 
(Rule Team Manual Column)

Group Primary Column 
(Rule Primary Column)

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Table 33. Organization Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

Group Table 
(Rule Table)

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator FALSE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

TRUE

Keep User Assigned 
(Keep Manual Assigned)

FALSE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Table 33. Organization Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Org Primary System Column

Org System Column

Org Table 
(Organization Table)

Org Team Score Column Not used in the Siebel MidMarket product 

Parent Name Organization

Position Column

Position Denorm Column 
(Position Team Denorm Column)

Position Manual Column 
(Position Team Manual Column)

Position Primary Column

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column

Position Primary Manual Column

Position Primary System Column

Position System Column 
(Position Team System Column)

Position Table

Position Team Score Column Not used in the Siebel MidMarket product 

Primary Table S_BU

Set Primary Employee FALSE

Set Primary Group 
(Set Primary Rule)

FALSE

Set Primary Org FALSE

Table 33. Organization Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Position Object Parameters
Table 34 shows the run-time parameters and their default values for the Position 
assignment object. For descriptions and usage comments on some of these run-time 
parameters, see Table 23 on page 172.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Set Primary Position FALSE

Skill Item Table S_BU_SKILL_IT

Note: Not used in the Siebel MidMarket 
product.

Skill Table S_BU_SKILL

Note: Not used in the Siebel MidMarket 
product.

Table 33. Organization Object Run-Time Parameters

Run-Time Parameter Default Value

Table 34. Position Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

TRUE

Assignment Mode

Assignment Scoring Mode Not used in the Siebel MidMarket product

Auto Reassign FALSE

Calendar Activity Additional Fields

Calendar Create Activity
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Assignment Object Parameters

Run-Time Parameter Default Values
Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee SADMIN

Default Org 
(Default Organization)

Default Position SADMIN

Employee Column

Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column

Employee Primary Column List 
(Employee Team Copy Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column Not used in the Siebel MidMarket product 

Exclude Column 
(Lock Assignment Column)

Group Column 
(Rule Column)

Table 34. Position Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Group Denorm Column 
(Rule Team Denorm Column)

Group Manual Column 
(Rule Team Manual Column)

Group Primary Column 
(Rule Primary Column)

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

Group Table 
(Rule Table)

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator TRUE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

TRUE

Table 34. Position Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Org Primary System Column

Org System Column

Org Table 
(Organization Table)

Org Team Score Column Not used in the Siebel MidMarket product 

Parent Name Position

Position Column

Position Denorm Column 
(Position Team Denorm Column)

Position Manual Column 
(Position Team Manual Column)

Position Primary Column

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column

Position Primary Manual Column

Position Primary System Column

Table 34. Position Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Position System Column 
(Position Team System Column)

Position Table

Position Team Score Column Not used in the Siebel MidMarket product 

Primary Table S_POSTN

Set Primary Employee TRUE

Set Primary Group 
(Set Primary Rule)

TRUE

Set Primary Org FALSE

Set Primary Position TRUE

Skill Item Table S_POS_SKILL_IT

Note: Not used in the Siebel MidMarket 
product.

Skill Table S_POS_SKILL

Note: Not used in the Siebel MidMarket 
product.

Table 34. Position Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Product Defect Object Parameters
Table 35 shows the run-time parameters and their default values for the Product 
Defect assignment object. For descriptions and usage comments on some of these 
run-time parameters, see Table 23 on page 172.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 35. Product Defect Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

FALSE

Assignment Mode

Assignment Scoring Mode Not used in the Siebel MidMarket product

Auto Reassign TRUE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee SADMIN

Default Org 
(Default Organization)

Default Position Siebel Administrator

Employee Column
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Assignment Object Parameters

Run-Time Parameter Default Values
Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column OWNER_EMP_ID

Employee Primary Column List 
(Employee Team Copy Columns)

Employee Primary Denorm Column ASGN_DNRM_FLG

Employee Primary Manual Column ASGN_MANL_FLG

Employee Primary System Column ASGN_SYS_FLG

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column Not used in the Siebel MidMarket product 

Exclude Column 
(Lock Assignment Column)

ASGN_USR_EXCLD_FLG

Group Column 
(Rule Column)

Group Denorm Column 
(Rule Team Denorm Column)

Group Manual Column 
(Rule Team Manual Column)

Group Primary Column 
(Rule Primary Column)

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Group Primary Manual Column 
(Rule Primary Manual Column)

Table 35. Product Defect Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

Group Table 
(Rule Table)

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator FALSE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

FALSE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Org Primary System Column

Org System Column

Table 35. Product Defect Object Run-Time Parameters

Run-Time Parameter Default Value
236 Siebel Territory Assignment Manager Administration Guide MidMarket Edition Version 7.5



Assignment Object Parameters

Run-Time Parameter Default Values
Org Table (Organization Table)

Org Team Score Column Not used in the Siebel MidMarket product 

Parent Name Product Defect

Position Column

Position Denorm Column 
(Position Team Denorm Column)

Position Manual Column 
(Position Team Manual Column)

Position Primary Column

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column

Position Primary Manual Column

Position Primary System Column

Position System Column 
(Position Team System Column)

Position Table

Position Team Score Column Not used in the Siebel MidMarket product 

Primary Table S_PROD_DEFECT

Set Primary Employee TRUE

Set Primary Group 
(Set Primary Rule)

FALSE

Set Primary Org FALSE

Set Primary Position FALSE

Skill Item Table Not used in the Siebel MidMarket product

Skill Table Not used in the Siebel MidMarket product

Table 35. Product Defect Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Product Denormalization Object Parameters
Table 36 shows the run-time parameters and their default values for the Product 
Denormalization assignment object. For descriptions and usage comments on some 
of these run-time parameters, see Table 23 on page 172.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 36. Product Denormalization Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

TRUE

Assignment Mode

Assignment Scoring Mode Not used in the Siebel MidMarket product

Auto Reassign FALSE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee

Default Org 
(Default Organization)

Default Position

Employee Column
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Assignment Object Parameters

Run-Time Parameter Default Values
Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column

Employee Primary Column List 
(Employee Team Copy Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column Not used in the Siebel MidMarket product 

Exclude Column 
(Lock Assignment Column)

Group Column 
(Rule Column)

Group Denorm Column 
(Rule Team Denorm Column)

Group Manual Column 
(Rule Team Manual Column)

Group Primary Column 
(Rule Primary Column)

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Group Primary Manual Column 
(Rule Primary Manual Column)

Table 36. Product Denormalization Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

Group Table 
(Rule Table)

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator FALSE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

TRUE

Keep User Assigned 
(Keep Manual Assigned)

FALSE

Org Column BU_ID

Org Denorm Column

Org Manual Column

Org Primary Column BU_ID

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Org Primary System Column

Org System Column

Table 36. Product Denormalization Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Org Table 
(Organization Table)

S_PROD_INT_BU

Org Team Score Column Not used in the Siebel MidMarket product 

Parent Name Product Denormalization

Position Column

Position Denorm Column 
(Position Team Denorm Column)

Position Manual Column 
(Position Team Manual Column)

Position Primary Column

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column

Position Primary Manual Column

Position Primary System Column

Position System Column 
(Position Team System Column)

Position Table

Position Team Score Column Not used in the Siebel MidMarket product 

Primary Table S_PROD_INT

Set Primary Employee FALSE

Set Primary Group 
(Set Primary Rule)

FALSE

Set Primary Org FALSE

Set Primary Position FALSE

Skill Item Table Not used in the Siebel MidMarket product

Skill Table Not used in the Siebel MidMarket product

Table 36. Product Denormalization Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Project Object Parameters
Table 37 shows the run-time parameters and their default values for the Project 
assignment object. For descriptions and usage comments on some of these run-time 
parameters, see Table 23 on page 172.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 37. Project Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

TRUE

Assignment Mode

Assignment Scoring Mode Not used in the Siebel MidMarket product

Auto Reassign FALSE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee SADMIN

Default Org 
(Default Organization)

Default Position

Employee Column EMP_ID
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Assignment Object Parameters

Run-Time Parameter Default Values
Employee Denorm Column 
(Employee Team Denorm Column)

ASGN_DNRM_FLG

Employee Manual Column 
(Employee Team Manual Column)

ASGN_MANL_FLG

Employee Primary Column

Employee Primary Column List 
(Employee Team Copy Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

ASGN_MANL_FLG

Employee Table S_PROJ_PTL_RSRC

Employee Team Score Column Not used in the Siebel MidMarket product 

Exclude Column 
(Lock Assignment Column)

ASGN_USR_EXCLD_FLG

Group Column 
(Rule Column)

Group Denorm Column 
(Rule Team Denorm Column)

Group Manual Column 
(Rule Team Manual Column)

Group Primary Column 
(Rule Primary Column)

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Table 37. Project Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

Group Table 
(Rule Table)

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator FALSE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

TRUE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Table 37. Project Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Org Primary System Column

Org System Column

Org Table 
(Organization Table)

Org Team Score Column Not used in the Siebel MidMarket product 

Parent Name Project

Position Column

Position Denorm Column 
(Position Team Denorm Column)

Position Manual Column 
(Position Team Manual Column)

Position Primary Column

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column

Position Primary Manual Column

Position Primary System Column

Position System Column 
(Position Team System Column)

Position Table

Position Team Score Column Not used in the Siebel MidMarket product 

Primary Table S_PROJ

Set Primary Employee FALSE

Set Primary Group 
(Set Primary Rule)

FALSE

Set Primary Org FALSE

Table 37. Project Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Project Team Object Parameters
Table 38 shows the run-time parameters and their default values for the Project 
Team assignment object. For descriptions and usage comments on some of these 
run-time parameters, see Table 23 on page 172.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Set Primary Position FALSE

Skill Item Table S_PROJ_SKILL_IT

Note: Not used in the Siebel MidMarket 
product.

Skill Table S_PROJ_SKILL

Note: Not used in the Siebel MidMarket 
product.

Table 37. Project Object Run-Time Parameters

Run-Time Parameter Default Value

Table 38. Project Team Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

TRUE

Assignment Mode

Assignment Scoring Mode Not used in the Siebel MidMarket product

Auto Reassign FALSE

Calendar Activity Additional Fields

Calendar Create Activity
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Assignment Object Parameters

Run-Time Parameter Default Values
Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee SADMIN

Default Org 
(Default Organization)

Default Position

Employee Column EMP_ID

Employee Denorm Column 
(Employee Team Denorm Column)

ASGN_DNRM_FLG

Employee Manual Column 
(Employee Team Manual Column)

ASGN_MANL_FLG

Employee Primary Column

Employee Primary Column List 
(Employee Team Copy Columns)

Employee Primary Denorm Column

Employee Primary Manual Column

Employee Primary System Column

Employee System Column 
(Employee Team System Column)

ASGN_SYS_FLG

Employee Table S_PROJ_PTL_RSRC

Employee Team Score Column SKILL_SCORE

Note: Not used in the Siebel MidMarket 
product. 

Exclude Column 
(Lock Assignment Column)

ASGN_USR_EXCLD_FLG

Table 38. Project Team Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Group Column 
(Rule Column)

Group Denorm Column 
(Rule Team Denorm Column)

Group Manual Column 
(Rule Team Manual Column)

Group Primary Column 
(Rule Primary Column)

Group Primary Column List 
(Rule Team Copy Columns)

Group Primary Denorm Column 
(Rule Primary Denorm Column)

Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

Group Table 
(Rule Table)

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator FALSE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

FALSE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org FALSE

Table 38. Project Team Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

TRUE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column

Org Primary Column List

Org Primary Denorm Column

Org Primary Manual Column

Org Primary System Column

Org System Column

Org Table 
(Organization Table)

Org Team Score Column Not used in the Siebel MidMarket product 

Parent Name Project Team

Position Column

Position Denorm Column 
(Position Team Denorm Column)

Position Manual Column 
(Position Team Manual Column)

Position Primary Column

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column

Table 38. Project Team Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Position Primary Manual Column

Position Primary System Column

Position System Column 
(Position Team System Column)

Position Table

Position Team Score Column Not used in the Siebel MidMarket product 

Primary Table S_PROJ_RSRC

Set Primary Employee FALSE

Set Primary Group 
(Set Primary Rule)

FALSE

Set Primary Org FALSE

Set Primary Position FALSE

Skill Item Table S_PROJRSRC_SKLI

Note: Not used in the Siebel MidMarket 
product.

Skill Table S_PROJRSRC_SKL

Note: Not used in the Siebel MidMarket 
product.

Table 38. Project Team Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Service Request Object Parameters
Table 39 shows the run-time parameters and their default values for the Service 
Request assignment object. For descriptions and usage comments on some of these 
run-time parameters, see Table 23 on page 172.

NOTE: The run-time parameters are presented in the order they appear in the Siebel 
Tools Properties window. If the corresponding parameter name that appears in the 
Siebel Tools Assignment Objects list applet differs from the name shown in the 
Properties window, it is shown parenthetically. Parameters in the table that do not 
include a default value have a default value of null.

Table 39. Service Request Object Run-Time Parameters

Run-Time Parameter Default Value

Add Team Members 
(Replace Team Members)

FALSE

Assignment Mode

Assignment Scoring Mode Person-based

Note: Not used in the Siebel MidMarket 
product.

Auto Reassign TRUE

Calendar Activity Additional Fields

Calendar Create Activity

Calendar Duration Column

Calendar Early Start Time Column

Calendar Start Time Column

Comments

Default Employee SADMIN

Default Org 
(Default Organization)

Default Organization
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Assignment Object Parameters

Run-Time Parameter Default Values
Default Position Siebel Administrator

Employee Column

Employee Denorm Column 
(Employee Team Denorm Column)

Employee Manual Column 
(Employee Team Manual Column)

Employee Primary Column OWNER_EMP_ID

Employee Primary Column List 
(Employee Team Copy Columns)

Employee Primary Denorm Column ASGN_DNRM_FLG

Employee Primary Manual Column ASGN_MANL_FLG

Employee Primary System Column ASGN_SYS_FLG

Employee System Column 
(Employee Team System Column)

Employee Table

Employee Team Score Column Not used in the Siebel MidMarket product 

Exclude Column 
(Lock Assignment Column)

ASGN_USR_EXCLD_FLG

Group Column 
(Rule Column)

Group Denorm Column 
(Rule Team Denorm Column)

Group Manual Column 
(Rule Team Manual Column)

Group Primary Column 
(Rule Primary Column)

Group Primary Column List 
(Rule Team Copy Columns)

Table 39. Service Request Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Group Primary Denorm Column 
(Rule Primary Denorm Column)

Group Primary Manual Column 
(Rule Primary Manual Column)

Group Primary System Column 
(Rule Primary System Column)

Group System Column 
(Rule Team System Column)

Group Table 
(Rule Table)

Ignore Assignment Attributes 
(Ignore Extra Attributes)

TRUE

Inactive FALSE

Keep Creator FALSE

Keep Man Asgn Primary Employee
(Keep Manual Primary Employee)

TRUE

Keep Man Asgn Primary Group 
(Keep Manual Primary Rule)

TRUE

Keep Man Asgn Primary Org TRUE

Keep Man Asgn Primary Position 
(Keep Manual Primary Position)

FALSE

Keep User Assigned 
(Keep Manual Assigned)

TRUE

Org Column

Org Denorm Column

Org Manual Column

Org Primary Column BU_ID

Org Primary Column List

Table 39. Service Request Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Org Primary Denorm Column

Org Primary Manual Column

Org Primary System Column

Org System Column

Org Table 
(Organization Table)

Org Team Score Column Not used in the Siebel MidMarket product 

Parent Name Service Request

Position Column

Position Denorm Column 
(Position Team Denorm Column)

Position Manual Column 
(Position Team Manual Column)

Position Primary Column

Position Primary Column List 
(Position Team Copy Columns)

Position Primary Denorm Column

Position Primary Manual Column

Position Primary System Column

Position System Column 
(Position Team System Column)

Position Table

Position Team Score Column Not used in the Siebel MidMarket product 

Primary Table S_SRV_REQ

Set Primary Employee TRUE

Table 39. Service Request Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
Set Primary Group 
(Set Primary Rule)

FALSE

Set Primary Org TRUE

Set Primary Position FALSE

Skill Item Tablet S_SR_SKILL_IT

Note: Not used in the Siebel MidMarket 
product.

Skill Table S_SR_SKILL

Note: Not used in the Siebel MidMarket 
product.

Table 39. Service Request Object Run-Time Parameters

Run-Time Parameter Default Value
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Assignment Object Parameters

Run-Time Parameter Default Values
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Index
A
Account assignment object, sample 

configuration 55
account object examples

assigning two objects 158
child accounts, primary parent 

address 161
primary address assignments 160
reassigning positions 164

accounts
territory definition list, modifying 31

ActionAgent parameter 138
ActionInterval parameter 138
activity-based assignment 19
applet classes in interactive assignment 57
AsgnBatch command 151
AsgnMode parameter 129, 151
AsgnObjName parameter 129, 151
Assign functionality, adding 58
Assign option, configuration example 56
Assignment Attribute Column object type, 

properties of 73
assignment attribute columns

configuring 71
properties 73

Assignment Attribute object type
overview 65
properties 69

assignment attributes
assignment criteria configuration 63
configuring assignment attributes 65
creating 67
definition 66
disabling 82
mapping workflow components 90

mapping, example 72
multilingual list of values (MLOV), 

configuring for 70
multiple attributes 64
new configurations, activating 93
properties, list 69
triggers, generating 66
Values picklist, specifying 65
warning about adding or changing 44

assignment criteria
See also assignment criteria values; 

workload criteria
assignment rules without criteria, role 

of 18
attribute object definition, about 65
combining rules 32
configuration warning 44
configuring 74
configuring, overview 63
creating 104
creation process overview 63
default criteria, removing 64
definition 46
described 18
example of creating 76
inclusion methods 18
mapping workflow components 88
multilingual list of values (MLOV) 

capabilities 19
multiple assignment attributes 64
multiple object assignments 158
new configurations, activating 93
object definition properties 76
predefined criteria 19
predefined fields 105
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primary address, assignments based 
on 160

properties 76
queries, creating 104
single value to multiple fields 63
values, creating 106
warning about adding or changing 44

assignment criteria attributes
configuring 77
creating 79
example of creating 80
list columns, relation to 77
object properties 81
properties 81

assignment criteria values
sorting and storage 106
wildcard characters as literals 106
wildcard characters, about 106

Assignment Group business 
component 74

assignment information, tracing 121
Assignment Interactive business 

component 58
Assignment Manager

server component, stopping and 
restarting 95

trace and error flags 121
Assignment Manager, modes

interactive assignment mode 126
assignment modes

dynamic assignment mode, 
overview 131

dynamic assignment, disabling and 
enabling 139

independent assignment 35
interactive assignment mode, 

overview 126
listed 115
mobile mode 145
organization and person-oriented 

assignment 38
organization-oriented assignment 37
person-oriented assignment 36
server requirements 124

assignment object modes
batch assignment mode, multiple record 

assignments 23
batch mode assignment, overview 146

assignment objects
assigning multiple records 23
assignment rules, about developing 27
candidates, role of 14
configuring 53
default organization assignment 113
default organization, suppressing 

assignment of 168
deleting system-assigned positions 111
dynamic assignment mode, role of 131
interactive assignment, configuring 57
interactive assignment, overview 56
locking 51
mapping assignment attributes to 71
multiple object assignments 158
multitiered assignment, 

configuration 61
new configurations, activating 93
no-criteria rule 104
original assignment objects, configuration 

warning 44
overview 50
position and employee-based 

assignments, creating 51
positional visibility 111
predefined assignment rules, definition 

requirement 97
predefined definitions 50
predefined object types, overview 13
primary address criteria 160
primary owner 17
primary position, maintaining 167
reassigning positions, example 164
repository migration 44
role in defining assignment criteria 74
sample configuration, Account 

assignment object 55
Siebel Tools, role of 45
warning about adding or changing 44
wildcard characters, use of 106
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Index
workflow policy object, adding to 52
workflow policy objects, relation to 50

assignment policies
activating 140
batch assignment mode deactivation 

requirements 147
contact denormalization 142
creating actions 141
deactivating 141
dynamic assignment mode and 

predefined assignment policies 139
predefined policies, overview 139
setting workflow group 140
workflow group, setting example 140
workflow groups, role of 139
Workflow Monitor Agent, role of 139

Assignment Results (Employee) 59
Assignment Results (Organizations) 59
Assignment Results (Position) 59
Assignment Results BusComp user 

property 59
assignment results business 

component 59
Assignment Rule business component 74
assignment rules

See also territories
about developing 27
activating 98
adding employees, example 109
assigning candidates to two objects 84
combining criteria 32
complex rule, example 159
definition requirement 97
developing for service requests 39
emails, as activities 19
employees, adding 108
loading with EIM 147
matching information, tracing 121
multiple criteria 32
multiple object assignments 158
multitiered assignment mode 35
multitiered assignment, about 20
no-criteria rule 104
object assignment 18

overview 17, 50
positions, adding 110
predefined 51
primary owner 17
process overview 11
releasing 114
rule cache, re-creating 114
rulecache.dat file 109, 111, 113, 114, 116
tasks, listed 99
without criteria, role of 18

Assignment Type business component, user 
property 58

attributes, change warning 44
audience for guide 8

B
batch assignment mode

about 23
assignment rules without criteria 18
date and timestamp fields, updating 

of 150
interaction with dynamic assignment 

mode 147
mobile users 166
multiple instances, running 156
Object WHERE Clause 152
overview 146
performance tuning 154
record updating, inadvertent 147
running 148
running from command line 151
srvrmgr utility 151
using wildcards in SQL statements 152

BatchMode parameter 138
BatchSize parameter

description 129, 151
performance considerations 154

business components
Assignment Interactive 58
assignment results 59
Assignment Rule compared to 

Assignment Group 74
interactive assignment 57
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C
candidates

assigning to two objects 84
in object assignment 18
qualifying 18
types, described 14

Check version iterations parameter 119
child accounts 163

primary parent address 161
column-based assignment attributes 63
command line interface

batch assignment mode 
parameters 129, 151

GenTrig parameters 135
configuration

Account assignment object example 55
Assign option 56
configurable features 45
event logs 121
interactive assignment 57
interactive assignment, overview 56
multitiered assignment objects 61
new configurations, activating 93
original assignment objects, 

changing 44
parameters for interactive assignment 

mode 127
process overview 43
Territory Assignment Manager post-

configuration tasks 125
contact denormalization 23

activating 142
enabling for Batch Assignment 149

Criteria list column 74
criteria values

configuration warning 44
CSSBCBase configuration 57

D
data visibility 15
database error message 132
database triggers 22
default organization, suppressing 

assignment of 168

default parameters, modifying 53
Default Tasks parameter 119
DeleteSize parameter 138
denormalization, contact 23
dynamic assignment mode

See also Workflow Monitor Agent
about 22
about generating triggers 132
enabling and disabling for assignment 

objects 139
error message 132
GenTrig parameters, command line 135
interaction with batch assignment 

mode 147
mobile users 166
overview 131
performance tuning 144
triggers, generating 133

dynamic assignment, activating 
configuration changes 94

E
eBusiness Integration Manager (EIM), 

loading assignment rules 147
email and assignment rules 19
employees

adding to assignment rules, 
example 109

assignment rules, adding to 108
described 14
position and employee-based 

assignments, creating 51
EnterpriseServer parameter 127
error flags 121
event log configuration 121
EventDate parameter 129, 151
Exclude method 18
EXEC parameter 135

G
GatewayAddress parameter 127
Generate Triggers, running 133
GenReqRetry parameter 138
GroupName parameter 138
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I
IgnoreCache parameter 129, 151
IgnoreError parameter 138
Include All Matching method 18
Include All method 18
Include method 18
inclusion-exclusion assignment criteria 

table 18
independent assignment mode 35
individuals, assigning to objects 16
interactive assignment

applet classes, allowable 57
business components, restrictions on 57
configuring 57
overview 56
SmartScript, enabling 58

interactive assignment mode
about 21
configuration parameters 127
overview 126
running for service requests 128
server component requirements 128
Siebel client 128

K
KeepLogDays parameter 138

L
LastUsrCacheSz parameter 138
list columns, relation to assignment criteria 

attributes 77
Lock Assignment 51
log level, setting 122
Log txn only on change parameter 119
LogTxnChgOnly parameter 129, 151, 166

M
MailTo parameter 138
matching information, tracing 121
Maximum MT Servers parameter 119
Maximum Tasks parameter 119
Minimum MT Servers parameter 119
MinMTServers parameter 118

mobile assignment mode
about 23
mobile users, routing transactions 

to 166
running 145

Mode parameter 135
multilingual list of values (MLOV)

assignment criteria 19
configuring assignment attributes for 70

multitiered assignment
organization assignment 113
position assignment 112

multitiered assignment mode
independent assignment 35
organization and person-oriented 

assignment 38
organization-oriented assignment 37
overview 35
person-oriented assignment 36

multitiered assignment objects
about 20
configuration 61

O
Object Assignment event 121
object types

configurable object types 46
field value and property relationships, 

diagram 48
Object WHERE Clause

creating 152
performance considerations 155
role of 152
rollback space 149
running multiple Territory Assignment 

Manager instances 156
objects. See assignment objects
ObjWhereClause parameter 130, 151
opportunities

territory definition list, modifying 31
opportunity object example 158
Opportunity workflow example 87
Opportunity Workflow Policy Object

deactivated components 92
Version 7.5 Siebel Territory Assignment Manager Administration Guide MidMarket Edition 261



Index
Org Primary column 168
organization

default organization, suppressing 
assignment 168

positions assigned based on 112
organization and person-oriented 

assignment mode 38
organization objects, role in visibility 15
organization-oriented assignment 

mode 37
organizations

about 15
assigning 112
assigning based on position 113
default assignment 113
denormalization of 25
multitiered assignment 113
multitiered assignment rules 35
overview 15

P
PAR_OU_ID column 163
parameters, command-line interface 135
parent accounts, pointer column 163
performance tuning

assignment rules without criteria 18
batch assignment mode 154
dynamic assignment mode 144

person-oriented assignment mode 36
picklists

Criteria list column 74
specifying in assignment attribute 65

position object examples 164
positions

assigning 110
assigning based on organization 113
based on parent organization 112
deleting system-assigned positions 111
described 14
indirect positions 24
multitiered assignment 112
position and employee-based 

assignments, creating 51
predefined objects, using 14

primary position, determining 24
visibility for assigned object 111

post-configuration tasks
server administration tasks 93
Territory Assignment Manager 125

predefined objects
overview 13
sales objects, use of 14
service objects, use of 14

Price List table, organization 
denormalization 25

primary address
assigning child accounts based on 161
assignment based on 160

primary owner of object 17
primary position

determining 24
maintaining 167

Product Denormalization mode 25
products, associating to organizations and 

price lists 25

Q
queries, assignment criteria 104

R
ReloadPolicy parameter 138
Remove parameter 135
repository file, compiling 94
repository migration, warning 44
RequestComponent parameter 127
Requests parameter 138
RequestServer parameter 127
Resonate 127
rollback space 149
rulecache.dat file

about 109, 111, 113, 114, 116
releasing assignment rules 114

Rules Evaluation event 121

S
sales organizations

position candidates, use of 14
team candidates 15
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sales team
See also teams

Sample database, predefined assignment 
rules 51

scoring
without criteria, role of 18

security 15
seed assignment criteria, removing 64
server administration

dynamic mode requirements 131
requirements by assignment mode 124
server component requirements for 

interactive assignment mode 128
Territory Assignment Manager post-

configuration tasks 125
server administration tasks, post-

configuration 93
Server Request Broker components

checking 117
service objects 14
service organizations

employee candidates, use of 14
individual candidates 16
primary owner of object 17

Service Request object 56
service requests

about assigning 39
assignment rules, developing for 39
interactive assignment mode 128

Siebel Server
Territory Assignment Manager 

components, number of 118
SmartScript, role in interactive 

assignment 56
.srf file, compiling instructions for 94
srvrmgr utility 151

T
TAMode parameter 135
teams

described 15
territories

See also assignment rules
combined criteria 32

location and revenue-based, example 32
Marketing Administration screen, use 

of 28
realignment, impact of 28
territory definition list, modifying 31
territory-based assignment rules, 

creating 30
territory-based assignment rules, 

example 29
territory assignment criteria, example of 

creating 105
Territory Assignment Manager

about customizing 12
Assignment Manager component, 

configuring 118
child accounts, parent primary address 

example 161
component configuration, overview 43
components 13
components, starting 118
configuration concepts 45
data sources 116
event log configuration 121
parameters, configurable 118
post-configuration tasks 125
running modes 115
running multiple instances 156
Server Request Broker components, 

checking 117
Territory Assignment Manager, modes

batch assignment mode 146
dynamic assignment mode 131
mobile assignment mode 145

territory assignment rules
creating 100
example of creating 102

trace flags 121
TrigFile parameter 135
triggers

assignment attributes 66
checking and editing 132
custom triggers 133
generating 132, 133
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U
UseForUpdate parameter 130, 151
user properties

assignment criteria attributes 81
Assignment Results BusComp 59

V
Values list

example 65
list column set, creation of 77

visibility, organizations, role of 15

W
wildcard characters

about 106
batch assignment mode SQL 

statements 152
literals, used as 106

workflow groups, assignment policies 140
Workflow Monitor Agent

assignment policies, role in 139
parameters 138
role of 22
running 136
workflow groups, role of 139

workflow policy components
assignment attribute, mapping to 90
assignment criteria, mapping to 88
creating 85
example, Opportunity workflow 87
mapping example 89, 91
Opportunity Workflow Policy Object, 

deactivated components 92
overview 84
record updating, inadvertent 147

workflow policy objects
assignment objects, adding 52
assignment objects, relation to 50
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